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Інформаційний блок 

Вступ 

В арсеналі сучасного еколога комп’ютерні засоби посідають не менш важливе 

місце, ніж лабораторне обладнання. А нерідко доводиться поєднувати їх використання 

при виконанні комплексних досліджень. Програмне забезпечення слугує не лише для 

збереження й аналізу результатів, формування звітів і моделювання різноманітних 

екологічних ситуацій, але й безпосередньо для виконання експерименту. Цифрові 

зображення у сучасній науці використовуються як матеріали дослідження, оскільки 

можуть містити багато цінної інформації про об’єкти живої та неживої природи. 

Наразі пропоноване видання не має аналогів ані українською, ані будь-якою іншою 

мовою. Авторка опрацювала чимало іноземних і українських наукових статей, 

ознайомилася з матеріалами до курсів Applied bioimage analysis викладача 

Дрезденського технічного університету Роберта Хааса, і Tutorial on ImageJ basic 

features викладача Люблянського університету Алеша Гладника, вебкурсу Eyes in the 

Sky II Карлтонського коледжу за підтримки NASA, дописами численних авторів на 

форумі користувачів ImageJ. З таких зернят розрізненої інформації у 2017 році вдалося 

скласти каркас майбутньої дисципліни, котра викладається магістрантам-екологам 

Чернівецького національного університету. П’ять років проб і помилок, нескінченних 

доопрацювань перших кострубатих протоколів практичних робіт, а також чесні 

критичні відгуки від студентів по завершенню курсу допомогли написати посібник у 

такому вигляді, як його бачите. 

Основна мета – ознайомлення майбутніх фахівців із різноманіттям способів 

використання цифрових зображень у професійній діяльності. Це стане лише першою 

сходинкою у пізнанні можливостей фотограмметрії та біоіміджингу, адже жодна 

книжка не в змозі навчити читача всіх тонкощів роботи з будь-якою програмою. Лише 

щира зацікавленість і самостійний пошук відповідей на численні питання, які 

виникатимуть під час роботи, сприятимуть магічному перетворенню «чайника» на 

«впевненого юзера». 

Багато чудових ідей і напрямків використання інструментів ImageJ в екологічних 

дослідженнях залишилося поза сторінками посібника. Можливо, у майбутніх 

редакціях деякі з них втіляться в нових протоколах практичних робіт, а аудиторія 

зацікавлених осіб вийде за межі ЧНУ. Сподіваюся, цього нам вдасться досягнути 

спільними зусиллями із залученням нинішніх і майбутніх студентів кафедри екології 

та біомоніторингу. 

Тож закликаю вас, моїх читачів і помічників, зануритися у безкраїй океан сучасних 

можливостей комп’ютерної обробки цифрових зображень. Набуті уміння обов’язково 

стануть у пригоді, якщо не на професійній ниві, то при виконанні магістерської 

дипломної роботи. ImageJ – не лише потужний інструмент для дослідження, але й 

зручний у користуванні графічний редактор, який допомагає краще візуалізувати 

отримані результати. Отже, ілюстрації до ваших тез доповідей, наукових статей, звітів, 

презентацій виглядатимуть сучасно, професійно та переконливо. 
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1. Структура дисципліни 

Навчальна дисципліна «Комп’ютерна оцінка зображень» спрямована на 

формування у магістрантів спеціальності 101 Екологія навичок роботи з цифровими 

зображеннями, отриманими під час виконання екологічних експериментів, їх аналізу, 

інтерпретування та візуалізації результатів. Ці навички допоможуть фахівцям у 

майбутній діяльності правильно планувати і виконувати наукові експерименти задля 

отримання якісного фактичного матеріалу для автоматичної чи напівавтоматичної 

обробки трудомістких операцій, обирати оптимальні інструменти для його 

опрацювання і отримання достовірних результатів та продукувати на виході якісні 

наукові або інженерні рішення для розв’язання практичних проблем. 

Мета навчальної дисципліни: ознайомити студентів із можливостями сучасних 

графічних редакторів, призначених для обробки цифрових зображень біологічних 

об’єктів та навчити їх оперувати інструментами спеціалізованого програмного пакета 

ImageJ із відкритим кодом при плануванні екологічних досліджень та обробці 

експериментально отриманих даних. 

Для підвищення ефективності засвоєння курсу здобувач освітнього рівня магістр 

екології має до вивчення цієї дисципліни оволодіти базовими навичками роботи з ПК, 

офісною технікою, а також здобути базові знання з основ екології. 

Після вивчення навчальної дисципліни магістрант здобуде такі 

компетентності: 
К01. Здатність вчитися і оволодівати сучасними знаннями; 

К02. Здатність приймати обґрунтовані рішення; 

К06. Здатність до пошуку, оброблення та аналізу інформації з різних джерел; 

К08. Здатність проведення досліджень на відповідному рівні; 

К09. Обізнаність на рівні новітніх досягнень, необхідних для дослідницької та/або 

інноваційної діяльності у сфері екології, охорони довкілля та збалансованого 

природокористування; 

К16. Здатність до самоосвіти та підвищення кваліфікації на основі інноваційних 

підходів у сфері екології, охорони довкілля та збалансованого природокористування; 

К17. Здатність самостійно розробляти екологічні проєкти шляхом творчого 

застосування існуючих та генерування нових ідей; 

К25. Опанування методами і напрямками обробки та аналізу супутникових цифрових 

зображень ландшафтів, середовищ існування та екосистем, отриманих із 

застосуванням ДЗЗ. 

Програмні результати:  
ПР06.Знати новітні методи та інструментальні засоби екологічних досліджень, у тому 

числі методи та засоби математичного і геоінформаційного моделювання; 

ПР14. Застосовувати нові підходи для вироблення стратегії прийняття рішень у 

складних непередбачуваних умовах; 

ПР18. Уміти використовувати сучасні методи обробки і інтерпретації інформації при 

проведенні інноваційної діяльності; 

ПР28. Знати правила і підходи до отримання інформативних цифрових знімків і сканів 

високої якості; 

ПР29. Опанувати принципи і методи обробки цифрових зображень для отримання 

об’єктивних, достовірних та науково цінних даних.; 
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ПР30. Вміти отримувати інформативні дані, вірно інтерпретувати та репрезентативно 

візуалізувати отримані результати. 

Компетентності – це комплекс теоретичних знань, практичних навичок, 

світоглядних і професійних навичок, які вирізняють фахівця певної галузі і 

надають йому можливість реалізувати себе в обраній професії. 

Курс «Комп’ютерна оцінка зображень» розрахований на студентів-магістрантів 

першого року навчання. Згідно з навчальним планом для його засвоєння відведено 120 

академічних годин (4 кредити). Із них: 30 год аудиторних практичних занять і 90 год 

самостійної роботи студента. 

Самостійна робота студента – це вид навчальної діяльності, за якого 

здобувач освітнього рівня самостійно опрацьовує навчальні матеріали з 

дисципліни за рекомендацією викладача, закріплюючи і доповнюючи 

інформацію, отриману під час аудиторних занять. 

Лекційних занять з цієї дисципліни не передбачено, тому матеріали теоретичного 

блоку посібника студенти вивчають самостійно. Самостійна робота передбачена й у 

практичному блоці. Витрачений студентом на опрацювання матеріалу час може 

відрізнятися від кількості годин, вказаних до кожної теми у дидактичній карті 

навчальної дисципліни, адже всі ми засвоюємо матеріал по-різному. 

 

Дидактична карта навчальної дисципліни 

Назви змістових модулів і тем: 

 

Кількість годин 

усього 

у тому числі 

практичні 
самостійна 

робота 

Теми теоретичного блоку для самостійного опрацювання 

Тема 1. Робота з цифровими зображеннями у 

сучасній екології 

2 - 2 

Тема 2. Базові характеристики та формати цифрових 

зображень 

2 - 2 

Тема 3. Спеціалізований програмний комплекс 

ImageJ 

2 - 2 

Тема 4. Методи отримання інформативних 

зображень для екологічних досліджень 
2 - 2 

Тема 5. Функціонал ImageJ та підготовка до роботи 4 - 4 

Тема 6. Базові операції над зображеннями у 

середовищі ImageJ 
4 - 4 

Тема 7. Базові навички роботи з плагінами ImageJ 4 - 4 

Тема 8. Основи інтегрування макросів у ImageJ 4 - 4 

Разом за блоком 24 - 24 

Теми практичного блоку для роботи в аудиторії 

Змістовий модуль 1. Робота зі вбудованими модулями програмного пакета ImageJ 

Тема 1. Програмний комплекс ImageJ. Ознайомлення 

з інтерфейсом та сайтом підтримки 
8 4 4 
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Назви змістових модулів і тем: 

Кількість годин 

усього 

у тому числі 

практичні 
самостійна 

робота 

Тема 2. Визначення розмірів та площі біологічних 

об’єктів засобами ImageJ 
6 2 4 

Тема 3. Підрахунок кількості особин у зграї птахів 

засобами ImageJ 
4 2 2 

Тема 4. Визначення вмісту хлорофілу у листі 

неінвазійним методом за RGB-спектром 
4 2 2 

Тема 5. Оцінка зімкнутості крон засобами ImageJ 4 2 2 

Тема 6. Запис користувацького макроса ImageJ 12 4 8 

Разом за змістовим модулем 1 36 16 22 

Змістовий модуль 2. Робота із плагінами вільного доступу до програмного пакета ImageJ 

Тема 7. Колірний аналіз в екологічних дослідженнях 6 2 4 

Тема 8. Побудова просторових полігонів за 

допомогою плагіна Interactive 3D Surface Plot 
8 2 6 

Тема 9. Автоматизоване визначення віку дерев за 

річними кільцями за допомогою плагіна ObjectJ 
6 2 4 

Тема 10. Напівавтоматизований аналіз 

морфологічних особливостей кореневої системи 
8 2 6 

Тема 11. Створення стеків і монтаж анімованих 

зображень часових рядів за даними GIS-

спостережень 

8 2 6 

Тема 12. Планування експерименту з урахуванням 

вимог ImageJ до зображень 
22 4 18 

Разом за змістовим модулем 2 58 14 44 

Усього годин  120 30 90 

 

Академічна доброчесність 
Навчальний процес, а також планування, проведення і презентація результатів 

наукових досліджень повинні здійснюватися з чітким дотриманням засад академічної 

доброчесності. 

Академічна доброчесність – це комплекс етичних норм і принципів, яких 

повинні дотримуватися усі, без винятку, учасники навчального процесу. 

Один із важливих елементів академічної доброчесності студентів – недопущення 

використання плагіату. Під час виконання практичних робіт із дисципліни 

«Комп’ютерна оцінка зображень» віддавайте перевагу власноруч зробленим 

фотознімкам біологічних об’єктів. В окремих випадках можна скористатися 

демонстраційними зображеннями, доступними для завантаження безпосередньо в 

програмі ImageJ або у комплекті до встановлених плагінів.  

Якщо з об’єктивних причин студент не має змоги зробити власні фотографії 

(наприклад при опрацюванні Теми 8 практичного блоку), дозволяється користуватися 

завантаженими з Інтернету зображеннями із обов’язковим вказуванням автора. Якщо 
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автор фотографії невідомий, необхідно вказати сайт, з якого завантажено фото. 

Свідоме викривлення посилань на джерела зображень, вказування неіснуючих імен та 

псевдонімів фотографів неприпустиме. 

Не допускається використання заповнених протоколів практичних робіт інших 

студентів, списування, видавання матеріалів наукових статей, наявних у вільному 

доступі, за результати власних досліджень. 

Заборонені фабрикація, фальсифікація та інші види модифікації результатів 

наукового експерименту під час виконання практичних робіт і підсумкового проєкту. 

 

Загальні вимоги до оформлення протоколів практичних робіт 
Чітко визначеного зразка заповненого протоколу практичної роботи з дисципліни 

«Комп’ютерна обробка зображень» немає. Студент має змогу виявити власні творчі 

здібності при компонуванні, форматуванні й оформленні отриманих результатів. 

Однак протокол повинен містити певні складові: 

• номер і назву практичної роботи; 

• прізвище, ім’я, номер групи виконавця; 

• вихідне зображення із зазначенням авторства; 

• скріншоти з важливими проміжними етапами виконання роботи; 

• скріншоти з отриманими результатами і поясненнями до них; 

• науковий висновок, котрий випливає з проведеного дослідження; 

• відгук на роботу з критичною оцінкою застосування інструментів ImageJ при 

виконанні практичної роботи. 

Відгук пишеться у довільній формі і повинен містити інформацію про практичні 

ситуації в екологічних дослідженнях, окрім тих, які вже вказані у практичному блоці, 

де можна застосувати набуті навички. У разі виникнення труднощів при виконанні 

роботи бажано їх також вказати.  

Скріншоти можна робити 

у будь-який спосіб, зручний 

для студента. Наприклад, за 

допомогою вбудованої у ОС 

Windows утиліти Засіб 
захоплення фрагментів, яка 

розташована у меню Windows 
> Стандартні програми. Для 

швидкого доступу рекомен-

довано закріпити інструмент 

на панелі завдань. 

Утиліта має лаконічний 

та інтуїтивно зрозумілий 

інтерфейс. Для створення 

миттєвого знімка потрібно 

натиснути кнопку Новий і 

обрати область охоплення 

майбутнього скріншоту. За 

замовчуванням це прямо-

кутник.  
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Для вибору іншого режиму захоплення фрагменту можна скористатися опціями з меню 

Режим. Функція Відкласти допомагає налаштувати затримку знімка від 1 до 5 секунд. 

Зазначеного часу вистачає для того, щоби розгорнути кілька вкладених підкатегорій 

меню після натискання кнопки Новий. 
 

Критерії оцінювання знань студентів під час складання іспиту з навчальної 
дисципліни «Комп’ютерна оцінка зображень» 

Іспит проводиться у формі презентації результатів виконання індивідуальних 

проєктів, що сприяє розвитку пізнавальних навичок студентів, умінню самостійно 

застосовувати набуті протягом курсу знання, орієнтуванню в інформаційному 

просторі, критичному мисленню та самостійному плануванню і виконанню дослідів із 

застосуванням графічних методів оцінки зображень біологічних об’єктів. 

На підготовку проєкту студентам відводиться один місяць. Завдання полягає в 

самостійному плануванні і реалізації експерименту із застосуванням програмного 

пакета ImageJ. Звітний продукт оформляється у формі письмового протоколу, який 

повинен містити такі компоненти: 

• аргументоване розкриття сфери застосування результату у професійній 

діяльності; 

• перелік використаних матеріалів, вимог до об’єктів дослідження та якості 

цифрових зображень; 

• детально розписаний та інформативно проілюстрований хід роботи; 

• результати власного дослідження, проведеного за запропонованим 

алгоритмом; 

• висновки, які відображають 1) технічні особливості виконання роботи; 

2) отримані в ході аналізу результати експерименту. 

Максимальний бал за виконання проєкту – 40 балів. Оцінювання роботи 

здійснюється за такими критеріями: 

40 балів Робота виконана із глибоким і повним знанням матеріалу, 

розумінням принципів роботи із цифровими зображеннями та 

програмним пакетом ImageJ, структура протоколу чітка, логічна, 

дослід можна повторити за описом, зроблені висновки чіткі, 

логічні і мають наукову цінність.  

30 балів Проєкт виконаний самостійно із розумінням суті та процесів, на 

яких базується експеримент, студент досить інформативно 
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проілюстрував хід роботи, зробив логічні висновки, проте допускає 

незначні помилки, неточності 

20 балів Матеріал висвітлено непослідовно, вибір методу і логіка 

експерименту викладені недостатньо чітко, низька 

інформативність ходу роботи, недостатня кількість ілюстрацій, 

висновки неповні. 

10 балів Робота виконана частково, немає логіки у викладі матеріалу, 

отримані результати не мають наукової цінності, висновків немає 

або вони нелогічні, студент погано орієнтується в роботі. 

0 балів Результати відсутні, плагіат.  

 

Критерії оцінювання за результатами засвоєння матеріалу дисципліни 
Критеріями успішного проходження навчальної дисципліни є виконання та 

захист практичних робіт, засвоєння теоретичного матеріалу, систематична самостійна 

робота, підготовка і проведення підсумкового дослідження, презентація та 

інтерпретація його результатів. Залежно від кількості балів, набраних студентом під 

час вивчення дисципліни, проводиться оцінювання за відповідною шкалою. 

90–100 балів Глибоке і повне знання теоретичного матеріалу, головних понять; 

вільне користування базовими інструментами ImageJ, вміння 

встановлювати та використовувати плагіни згідно з потребами 

екологічного експерименту; практикум виконаний згідно з 

викладеними вище вимог у повному обсязі; підсумковий проєкт 

сплановано, проведено і представлено результати на високому 

науково-методичному рівні.  

70–89 балів Володіння основами теоретичного матеріалу; вільне користування 

базовими інструментами та плагінами ImageJ, проте студент 

допускає незначні помилки, має труднощі зі встановленням 

плагінів; успішне виконання більшої частини практикуму; 

підсумковий проєкт сплановано, проведено і представлено 

результати на достатньому рівні. 

50–69 балів Студент показує репродуктивний характер знань теоретичного 

матеріалу, помиляється в термінології, практикум виконаний не в 

повному обсязі, протоколи практичних робіт оформлені недбало, 

не містять чітко сформульованих висновків; підсумковий проєкт 

сплановано, проведено і представлено результати не на достатньо 

високому рівні. 

35–49 балів Знання теоретичного матеріалу фрагментарні, студент не знає 

термінології і не має базових навичок користування інструментами 

та плагінами ImageJ; виконано і захищено менше 30 % практичних 

робіт. 

1–34 бали Відповідей немає, студент не може виконати практичних завдань, 

повна невідповідність знань ОКР. 
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2. Структура навчального посібника 

Для вашої зручності головний зміст навчального посібника поділений на два 

рівнозначні блоки: теоретичний і практичний. У першому з них ви знайдете стислий 

концентрат теоретичного матеріалу, який допоможе зорієнтуватися у сучасних 

уявленнях про обробку цифрових зображень у наукових цілях, ознайомитися з 

можливостями та інструментарієм спеціалізованого графічного редактора ImageJ, а 

також дізнаєтеся про методи отримання інформативних фотознімків для екологічних 

досліджень. Практичний блок містить протоколи практичних робіт з окресленою 

сферою застосування в екології, покроковими інструкціями виконання і способами 

вирішення можливих труднощів. Наприкінці посібника читач знайде перелік 

літератури, яка допоможе у подальшому розширити набуті знання і навички, а також 

корисні інформаційні ресурси. 

У цьому посібнику ви не знайдете підписів до ілюстрацій, оскільки їх багато і всі 

вони супроводжуються детальним описом у тексті. Важливі терміни і послідовність 

дій позначені контрастним виділенням. Для зручнішого сприйняття і уникання 

перевантаження тексту виділеннями деякі важливі виділення та іншомовна 

термінологія подані курсивом. 

Визначення, важливі для успішного засвоєння теоретичного матеріалу, та 

моменти, які потребують підвищеної уваги, подані окремими блоками 

тексту, обмеженими розділювальними лініями. 

Для відображення послідовності здійснення операцій, зокрема переходи з меню на 

підменю, позначені символом >. 

Для зручності користування електронним посібником зміст, компоненти 

дидактичної картки та окремі місця у тексті мають вигляд гіперпосилань на відповідні 

частини документа. 

Усі протоколи практичних робіт побудовані за однаковим шаблоном і містять: 

• перелік програмного забезпечення (ПЗ), матеріалів та обладнання, необхідних 

для виконання завдань; 

• короткий теоретичний блок, який окреслює сферу використання набутих 

умінь і навичок; 

• проілюстрований скріншотами хід роботи та приклад кінцевого результату; 

• перелік труднощів, які можуть виникнути під час виконання практичної 

роботи, та способи їх подолання. 

Остання практична робота (Тема 12) відрізняється від усіх попередніх, оскільки не 

містить покрокової інструкції, а являє собою інструктаж із виконання підсумкового 

проєкту, який замінює іспит у традиційному розумінні для дисципліни «Комп’ютерна 

обробка зображень». 

Шановні читачі, пам’ятайте про академічну доброчесність. Посібник, з яким ви 

працюватимете, захищений авторським правом і розповсюджується лише з 

навчальною метою. Копіювати його вміст повністю або частково і/або передавати його 

стороннім особам можна лише з дозволу автора. Змінювати структуру посібника, 

доповнювати чи вилучати інформацію стороннім особам заборонено. 
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Теоретичний блок 

Тема 1. Робота з цифровими зображеннями у сучасній 
екології 

У природничих науках робота із зображеннями та відеоматеріалами відома давно 

і ведеться на різних рівнях організації живого. Засоби дистанційного зондування Землі 

дають змогу досліджувати геологічні та ґрунтоутворюючі процеси, особливості 

ландшафтів та їхніх компонентів, процеси антропогенного впливу на біосферу, 

здійснювати геоботанічний аналіз тощо. Сучасні засоби відеозйомки суттєво 

розширили наші уявлення про поведінку тварин у природних умовах і стали 

невід’ємним джерелом інформації про динамічні процеси у біологічних системах, 

біоритми, фенологічні зміни. Рентгенівські знімки успішно використовуються як у 

наукових дослідженнях, так і в медичній та зоотехнічній практиці. На популяційно-

видовому, організмовому та клітинному рівнях широкий спектр даних про біологічні 

об’єкти можна отримати фотограмметричними методами. 

Фотограмметрія – це прикладний науковий напрямок технічного 

дослідження структури, розмірів, форм і просторового розташування 

об’єктів на основі аналізу їхніх фотознімків. 

Відправним пунктом фотограмметрії стало винайдення дагеротипії у 1839 році. 

Вже у 1858 році французький фотограф Гаспар Фелікс Турнашон здійснив першу 

аерозйомку Парижа з повітряної кулі. На основі цих знімків було оновлено існуючі 

плани міста. Так покладено основу аерофотогеодезії. 

Сучасний, цифровий, етап розвитку фотограмметрії характеризується значним 

розширенням асортименту технічних засобів, за допомогою яких миттєво можна 

отримати високоякісні зображення, придатні до подальшої обробки. Завдяки розробці 

багатофункціонального програмного забезпечення технічні можливості 

фотограмметрії значно зросли. Наприклад, фотограмметричні станції задовольняють 

потреби топографії, землевпорядкування, лісовпорядкування, геології, гірничої справи 

тощо. Системи цифрової мікроскопії широко застосовуються у медицині, 

мікробіології, біотехнології, біоінженерії. А самий процес отримання та опрацювання 

високоякісних знімків мікроскопічних біооб’єктів відомий як біоіміджинг. 

Біоіміджинг – це неінвазійний спосіб візуалізації біологічних процесів у 

режимі реального часу з інтегрованою функцією морфометричного 

скринінгу в автоматичному режимі. 

Оскільки екологічні дослідження мають спільні об’єкти з вищезазначеними 

дисциплінами, методи фотограмметрії та біоіміджингу придатні для вивчення багатьох 

явищ, процесів і закономірностей, які становлять інтерес для еколога. Потужний 

потенціал сучасних засобів отримання фотознімків із високою роздільною здатністю у 

сукупності з колосальними можливостями програмних засобів для опрацювання 
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цифрових фотографій щороку розширюють коло екологічних експериментів, які 

можуть здійснюватися у такий спосіб. 

Придатність методів фотограмметрії та біоіміджингу для екологічних досліджень 

обумовлені такими характеристиками: 

• неінвазивність – властивість, яка дає змогу досліджувати параметри живих 

об’єктів, завдаючи їм мінімально можливої шкоди, наприклад, не вилучаючи 

зі середовища існування; 

• оперативність – здатність миттєво отримувати високоякісні первинні 

матеріали для подальшого дослідження, а також автоматизація більшості 

операцій за допомогою спеціалізованого програмного забезпечення (ПЗ); 

• доступність – можливість застосування користувачами із мінімальними 

навичками фотографування та роботи з цифровими зображеннями; 

• сумісність з іншими методами дослідження, зокрема отримані у такий спосіб 

дані можна опрацьовувати математично і статистично; 

• інформативність, особливо у випадках, де пряме вимірювання дає неточні 

результати або майже неможливе; 

• багатопараметричність – один набір зображень може використовуватися 

необмежену кількість разів для визначення різних показників; 

• універсальність – відповідність потребам аутекологічних, демекологічних, 

синекологічних, біогеоценологічних досліджень; 

• зручність зберігання матеріалів та результатів досліджень. 

У біології та медицині переважно застосовуються цифрові знімки, відзняті у 

лабораторних умовах. Важливе місце належить роботі зі зображеннями, отриманими 

за допомогою діагностичної апаратури: світлових і електронних мікроскопів, систем 

автоматичної візуалізації, рентгенографічних апаратів, томографів тощо. 

Напрацьована у цьому напрямку методологічна база може успішно використовуватися 

в екології мікроорганізмів, широкому спектрі аутекологічних дослідів, біотестуванні, 

екотоксикології, дослідженні генетичних аспектів популяційної екології тощо. 

Не менший простір для дослідницької діяльності надає фото- і відеозйомка живих 

об’єктів і елементів абіотичного середовища у природних умовах. Яскравий приклад –

фотопастки, які давно використовуються натуралістами для фауністичних досліджень: 

спостереження за поведінкою тварин, дослідження їхнього раціону, добової активності 

тощо. У такий спосіб можна отримати великий масив первинних даних для потреб 

екології тварин, популяційної екології, біомоніторингу, інвентаризації біологічного 

різноманіття певної території, спостереження за популяціями рідкісних видів тварин. 

Аналіз цифрових зображень, отриманих за допомогою засобів дистанційного 

зондування Землі, набуває дедалі більшої популярності у агроекології, ландшафтній 

екології, гідроекології, моніторингу довкілля, біогеохімії, урбоекології. 

З одного боку, інструментарій еколога значно ширший, ніж у вузькогалузевого 

фахівця, оскільки може поєднувати технічні засоби для медичної діагностики, 

геодезичної аерофотозйомки, дистанційного зондування тощо. З іншого – за 

допомогою побутової цифрової камери і навіть камери смартфона можна отримувати 

фотознімки достатньої якості для обробки кількісних і морфометричних параметрів, 

оцінювання проєктивного покриття трав’яних рослин, фіксування фенологічних змін 

та багатьох інших показників. 
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Тема 2. Базові характеристики та формати цифрових 
зображень 

Цифрові зображення для подальшої обробки можна отримати за допомогою різних 

технічних засобів. Як наслідок, вихідні файли можуть мати різні формати. Сучасні 

фотокамери надають можливість зберегти щойно відзняте зображення на вибір у файлі 

з форматом JPEG, TIFF, RAW і DNG. Стандартне меню офісних сканерів, окрім 

наведених форматів, додатково містить опцію BITMAP. Смартфони зазвичай 

автоматично зберігають фотознімки у форматі JPEG, деякі моделі – у форматі PNG. За 

принципом роботи цифрові мікроскопи – це фактично звичайні цифрові камери зі 

збільшувальною здатністю у кілька сотень разів. Тому зображення, отримані за їх 

допомогою, можна зберігати у файлах з аналогічними форматами. Те саме стосується 

й цифрових насадок на оптичні мікроскопи. Дані дистанційного зондування 

передаються у файлах формату TIFF зі супутніми файлами метаданих. Усі перелічені 

формати призначені для збереження растрових зображень. 

Растровим називається зображення, яке складається з масиву дискретних 

пікселів різних кольорів і відтінків. При збільшенні таке зображення 

виглядає як сітка з квадратних чарунок. 

Растрові зображення, незалежно від формату збереження, мають певні 

характеристики, які впливають на якість візуалізації та придатність до подальшої 

обробки й аналізу. До них належать: 

1. Роздільна здатність – величина, яка відображає кількість дискретних мінімальних 

елементів у складі зображення на одиницю простору. Якщо йдеться про просторову 

роздільну здатність фотознімка, виведеного на монітор комп’ютера, за мінімальний 

елемент беруть піксель. У такий спосіб характеризують розміри зображення (довжину і 

ширину), а також площу. Чим більше пікселів містить фрагмент зображення стандартного 

розміру, тим більша роздільна здатність і, відповідно, краща деталізація. У цьому разі 

роздільна здатність вимірюватиметься у ррі (англ. pixel per inch) – пікселях на дюйм. 

 
Роздільна здатність сканування зображень вимірюється у dpi (англ. dot per inch) – 

точках на одиницю. Ця величина пов’язана з особливостями друкарського обладнання 

і використовується при оцифруванні ілюстрації з плоского носія (наприклад паперу) та 

при виведенні зображення на плоский носій, тобто при друці. Оптична роздільна 

здатність сканера залежить від кількості світлочутливих елементів (фотодатчиків) 

конкретної моделі, які припадають на дюйм горизонталі плоского носія. Більшість 

побутових сканерів мають оптичну роздільну здатність у межах 300–600 dpi, дорожче 

професійне обладнання – від 1200 dpi. 

2. Колірний простір – абстрактна модель, яка представляє певний відтінок як точку 

в системі координат основних кольорів. Колірний простір RGB (англ. Red, Green, Blue) 

– тривимірний, кожна умовна вісь якого відповідає червоному, зеленому і синьому  

https://northcoastphoto.com/digital-explained/
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основним кольорам, які прийнято називати колірними каналами. Це апаратно-

залежний простір, який відображається на екранах цифрової техніки. При цьому для 

відображення кольору вико-

ристовується світло від 

пристрою. За умови цілковитої 

відсутності світлового випро-

мінювання піксель залиша-

ється затемненим (чорним). 

Змішування відтінків у 

просторі RGB здійснюється 

за адитивним принципом із 

додаванням чорного до основних кольорів. Наприклад, для того, щоб отримати 

малиновий відтінок, змішуються червоний, зелений і чорний. Додаванням червоного, 

зеленого і синього у рівних пропорціях утворюється білий колір, тобто яскраве світло. 

Кожен із трьох базових кольорів у колірному просторі RGB має 256 відтінків, завдяки 

чому палітра відтінків RGB – одна з найнасиченіших.  

Ще одна широковідома колірна схема CMYK 

(англ. Cyan, Magenta, Yellow, Key) утворює 

чотиривимірний простір, оскільки базується на 

чотирьох каналах: блакитному, пурпуровому, 

жовтому і чорному (у точному перекладі – 

ключовому). Зелений колір у цьому просторі 

утворюється змішуванням, аналогічно до інших 

відтінків палітри.  

На відміну від RGB, у колірному просторі CMYK змішування кольорів 

відбувається за субтрактивним принципом. Цей простір використовується переважно 

для друкованих матеріалів і використовує чорнило для відображення кольору. Для 

передачі відтінків фарби пошарово накладаються на білий фон (наприклад папір), 

тобто білий у колірному просторі не передбачений і означає повну відсутність фарби 

на ділянці зображення. Коли всі спектри 

колірного простору CMYK перекриваються, 

результатом стає чорний колір. Незважаючи на 

це, чорний пігмент використовується додатково 

до блакитного, пурпурового. Кожен відтінок у 

просторі CMYK кодується чотирма числами, 

котрі позначають частку фарби основного 

кольору, яка входить до його складу. Ступінь 

яскравості відтінку у кожному каналі залежатиме від кількості відповідного базового 

кольору. Палітра відтінків CMYK значно бідніша, порівняно з RGB. 

Окрім наведених, існує чимало інших колірних просторів різної вимірності: від 

одновимірних, які застосовуються в окремих монохромних зображеннях, до сучасних 

десятивимірних. Окремої уваги варта група колірних просторів, незалежних від 

пристрою, які побудовані за принципом фізіологічного сприйняття кольору людським 

оком. До таких належать CIE 1931 XYZ, CIELAB, CIELUV, OKLab. Будь-який відтінок 

у таких колірних просторах визначається ступенем яскравості та двома хроматичними 

компонентами: а, котрий змінюється у спектрі від зеленого до червоного, і b, який 

змінюється від синього до жовтого. 

https://upload.wikimedia.org/wikipedia/commons/thumb/1/11/RGBCube_b.svg/440px-RGBCube_b.svg.png
https://media.contented.ru/wp-content/uploads/2022/02/1-1-1.png
https://bardotbrush.com/wp-content/uploads/2021/05/difference-between-RGB-and-CMYK-768x400.jpg
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3. Глибина кольору – величина, яка відображає максимальне число унікальних 

кольорів, використаних для представлення відтінку одного пікселя растрового 

зображення. Кожен колірний піксель у цифровому зображенні кодується за допомогою 

певної комбінації з основних кольорів колірного простору. Кожен основний колір 

(колірний канал) може мати будь-який діапазон значень інтенсивності, визначений 

його бітною глибиною. 

Біт (англ. bit) – найменша неподільна одиниця обсягу інформації, яка, згідно 

з правилами представлення даних у двійковій системі числення, може 

дорівнювати одному з двох значень: 0 або 1. 

Глибина в бітах для кожного основного кольору вимірюється bpc (англ. bits per 

channel) – бітами на канал. Величина bpp (англ. bits per pixel) – біт на піксель – 

застосовується до суми бітів у всіх каналах колірного простору і представляє загальну 

кількість кольорів, доступних для кожного пікселя. Залежно від кількості бітів у пікселі 

розрізняють колірні палітри різної глибини. 

 

bpp 

Кількість 

доступних 

відтінків сірого 

в монохромних 

зображеннях 

Кількість доступних відтінків в 

колірному просторі RGB 
Назва палітри 

1 21 = 2 (2R) × (2G) × (2B) = 23 = 8 Монохромна 

2 22 = 4 (4R) × (4G) × (4B) = 43 = 64 CGA 

4 24 = 16 (16R) × (16G) × (16B) = 163 = 4 096 EGA 

6 26 = 64 (64R) × (64G) × (64B) = 643 = 262144 Original Chip Set 

8 28 = 256 2563 = 16 777 216 VGA 

12 212 = 4 096 4 0963 = 68 719 476 736 Silicon Graphics 

16 216 = 65 536 65 5363 = 281 474 976 710 656 XGA, High Color 

24 224 = 16 777 216 16 777 2163 = 4,722366482869645 × 1021 SVGA, True Color 

 

Візуальну різницю цифрових знімків різної глибини кольору наведено нижче. 

 
Під час вибору пристрою для сканування важливо звертати увагу на дві 

характеристики: внутрішню і зовнішню глибину кольору. Внутрішня глибина 

https://uk.wikipedia.org/wiki/%D0%93%D0%BB%D0%B8%D0%B1%D0%B8%D0%BD%D0%B0_%D0%BA%D0%BE%D0%BB%D1%8C%D0%BE%D1%80%D1%83
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відображає можливості аналого-цифрового перетворювача сканера, вказуючи на 

кількість відтінків, які він здатний розрізнити. Зовнішня глибина характеризує 

кількість відтінків, яку сканер здатний передати на комп’ютер. Побутові моделі 

використовують для передачі кольору 24 біти: по 8 на кожний колірний канал RGB. 

4. Файловий розмір зображення – характеристика, яка визначається добутком 

ширини, висоти, роздільної здатності і глибини кольору. Вимірюється у одиницях, 

похідних від байта: кілобайт (КБ), мегабайт (МБ), гігабайт (ГБ).  

Байт (англ. byte) – це одиниця обсягу інформації, яка дорівнює 8 бітам. 

Аналогічно до бітів представляється двійковим числом. 

Висока якість цифрового знімка визначається насамперед високою роздільною 

здатністю, що неминуче збільшує файловий розмір зображення. Зберігання графічних 

файлів потребує багато місця на носії. Тому сучасні графічні формати являють собою 

своєрідний компроміс між достатньою якістю цифрового зображення і не надто 

великим файловим розміром. 

JPEG (розширення імені файлів – *.jpg, *.jpeg) – англ. Joint Photographic Expert 

Group – один із найпоширеніших форматів збереження растрових зображень, до яких 

застосовується технологія стиснення. Більшість цифрових камер мають налаштування 

ступеня стиснення і якості вихідного зображення. Максимальна роздільна здатність, 

яку здатний підтримувати формат, 65535×65535 пікселів.  

 

Переваги Недоліки 

Займає відносно небагато місця на диску 

або карті пам’яті. 

Втрата якості через стиснення 

зображення. 

Швидка передача файлів з одного 

пристрою на інший. 

Обмежений простір для маніпуляцій у 

графічних редакторах. 

Додатково містить інформацію про 

налаштування камери. 

Не підтримує прозорість. 

Підтримується більшістю графічних 

редакторів. 

Вузька область застосування у наукових 

дослідженнях. 

 

TIFF (розширення імені файлів – *.tiff) – англ. Tagged Image File Format – 

універсальний формат, створений для обміну даними між різними пристроями і 

програмними продуктами. Зазвичай не стискається і дає широкий простір для 

подальшої обробки. Якщо примусово застосувати опцію стиснення, файловий розмір 

зображення зменшується приблизно на третину від оригінального розміру. На 

відміну від файлів JPEG, процес стиснення не призводить до втрат інформації. 

Підтримує широкий спектр колірних моделей: RGB, CMYK, Grayscale, Pseudocolor, 

Line Art, YCbCr, Lab. 

Файли TIFF мають складну організацію і містять: 1) заголовок файлу IFH 

(англ. Image File Header); 2) директорії IFD (англ. Image File Directory), кожна з яких, 

окрім самого графічного файлу, містить його опис: лічильник і послідовність тегів, 

покажчик на наступну директорію; 3) численні теги – мітки з описовою інформацією. 

Повний перелік тегів містить понад 45 позицій, серед яких: модель і серійний номер 
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камери, дата і час створення, тип даних, глибина кольору, колірний простір, роздільна 

здатність, орієнтація зображення, вид компресії та інші. 

Один файл у форматі TIFF може містити цілу серію растрових зображень, 

наприклад, кадри динамічної сцени. Кожне таке зображення складає окремий 

растровий субфайл, дані якого описуються інформацією IFD. За потреби кожен 

субфайл TIFF може бути збережений окремо або об’єднаний з іншими субфайлами в 

один файл TIFF. Субфайли записуються в окремі директорії, причому одному 

зображенню може відповідати лише одна директорія. 

Формат має обмеження максимального розміру файлу до 4 ГБ. 

Переваги Недоліки 

Висока якість зображення навіть після 

стиснення. 

Займає багато місця на диску або карті 

пам’яті. 

Підтримується широким спектром 

сучасних графічних редакторів і програм 

для верстки. 

Повільна передача файлів з одного 

пристрою на інший. 

 

RAW (розширення імені файлів залежить від моделі камери) – англ. raw (сирий) 

– формат файлу, який містить необроблені дані. Відомий також як «цифровий 

негатив». Головна особливість файлу RAW полягає в тому, що дані зберігаються без 

апаратного коригування з боку камери, за допомогою якої його було відзнято. Це дає 

змогу власноруч залежно від подальших потреб змінювати параметри (контраст, 

насиченість, баланс білого, експозицію, різкість) за допомогою графічного редактора. 

Файли формату RAW зберігають більше відтінків за рахунок 12- або 14-бітного 

кодування інформації для кожного з колірних каналів. 

Зазвичай мають більший розмір, порівняно з файлами формату JPEG, але менший 

від файлів формату TIFF. Файл RAW містить дані про пікселі, отримані безпосередньо 

з матриці камери, метадані з інформацією про камеру, метадані з технічним описом 

умов зйомки,  метадані параметрів обробки зображення і графічну мініатюру у форматі 

JPEG для попереднього перегляду. 

 

Переваги Недоліки 

Містить набагато більше корисної 

інформації, порівняно з рештою 

форматами растрових зображень. 

Існує понад 40 файлових розширень, які 

підтримуються не всіма графічними 

редакторами і потребують попередньої 

конвертації. 

Зберігає максимальну якість зображення. Вимагає багато часу на обробку. 

Має широкі можливості для подальшої 

обробки за допомогою ПЗ. 

Займає багато місця на диску або карті 

пам’яті. 

Допомагає усунути оптичні дефекти 

зображення, наприклад хроматичні 

аберації або віньєтування. 

Інформація, яка міститься у файлі, не 

надає можливості попереднього 

перегляду зображення. 

 

DNG (розширення імені файлів – *.dng) – англ. Digital Negative Specification – 

уніфікований формат для файлів RAW, який не залежить від виробника фотокамер. 

Підтримується сучасним обладнанням з метою подолання необхідності конвертації у 

читабельний для графічного редактора формат. Окрім цього, створено програмний 
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продукт Adobe DNG Converter, який дає змогу конвертувати різні формати файлів 

RAW у новий стандарт *.dng.  

Як і формат RAW, разом зі самим цифровим зображенням зберігає набір 

метаданих і повнорозмірний файл JPEG для попереднього перегляду, проте розміри 

файлу значно компактніші. Містить повноколірну модель файлів RAW. Має кращу 

продуктивність порівняно з прототипом. Підтримує функцію архівації зображень зі 

збереженням якості при стисненні. Формат надає можливість злиття кількох знімків 

у панорамне зображення, зберігаючи їх вихідні характеристики. 

 

Переваги Недоліки 

Зберігає усі переваги формату RAW. Підтримується не всіма виробниками 

фотокамер. 

Допомагає усунути проблему з 

файловими розширеннями. 

Підтримується не всіма графічними 

редакторами. 

Попередній перегляд доступний не у 

вигляді мініатюри, а як повноформатне 

зображення. 

Конвертування файлів RAW у формат 

DNG потребує чимало часу. 

 

BITMAP (розширення імені файлів – *.bmp) – англ. device independent bitmap – 

стандартний формат файлу растрового зображення ОС Windows, який не 

підтримується іншими операційними системами. Містить інформацію про відтінок 

кожного окремого пікселя. Зберігає зображення довільного вихідного розміру та 

роздільної здатності з різною глибиною кольору. 

Як і у форматах TIFF і RAW, файл BITMAP має складну структуру: 1) заголовок 

файлу BITMAPFILEHEADER; 2) заголовок зображення BITMAPINFOHEADER 

(опційно); 3) палітра відтінків (опційно); 4) растрові дані. 

Заголовок файлу містить інформацію щодо його розмірів і розташування даних. 

Палітра відтінків у складі файлу має вигляд блоку байтів із переліком усіх відтінків, 

використаних у растровому зображенні. У блоці з растровими даними міститься 

інформація про розміри зображення і масив пікселів у вигляді матриці з указаним 

відтінком для кожної чарунки у колірному просторі RGB з додатковим альфа-каналом, 

який надає ефект часткової прозорості. Такий формат характеризується високою 

деталізацією зображення і зводить до мінімуму вірогідність виникнення помилки або 

неправильної інтерпретації растрових даних. Разом з тим, якість растрового зображення, 

збереженого у форматі BITMAP, нижча порівняно з файлами у форматі RAW. 

 

Переваги Недоліки 

Підтримується будь-яким Windows-

сумісним ПЗ. 

Займає багато місця на диску або карті 

пам’яті. 

Підтримка різної глибини кольору, 

альфа-каналів, колірних профілів. 

Стискає лише зображення з 4- і 8-бітною  

глибиною кольору. 

Стискає зображення без втрат. Апарат-залежний і ОС-залежний формат. 
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Тема 3. Спеціалізований програмний комплекс ImageJ 

Для обробки й аналізу цифрових зображень у екологічних дослідженнях придатні 

стандартні растрові графічні редактори, наприклад, Adobe Photoshop, Corel Photo-Paint, 

GIMP. Однак окремі завдання потребують професійного рівня володіння 

інструментарієм, а можливості автоматизації процесу немає. До того ж у науковій 

літературі готові рішення подані лише за окремими досить вузькими напрямками 

екології. Тому розробка, коригування, апробація кожної методики – процес складний і 

тривалий. 

Сучасне медико-біологічне обладнання часто постачається у комплекті зі 

спеціалізованим програмним забезпеченням, яке допомагає оперативно в 

автоматичному або напівавтоматичному режимі обробляти велику кількість зображень 

біологічних об’єктів. Таке ПЗ має вузьку спеціалізацію і не може використовуватися 

для цифрових знімків, отриманих з інших пристроїв. 

Растрові зображення, отримані у процесі дистанційного зондування Землі, 

зазвичай опрацьовуються геоінформаційними системами, наприклад AutoCAD, 

MapInfo, ArcGIS, QGIS. Робота з ними також потребує спеціальних знань і навичок. 

З метою подолання вказаних перешкод було розроблено спеціалізований 

програмний комплекс із відкритою архітектурою ImageJ для медико-біологічних 

потреб. Використання ImageJ безкоштовне і передбачає два варіанти на вибір: 

1) у браузерному режимі; 2) через встановлення на жорсткий диск комп’ютера. 

Відкритий код дає змогу гнучко нарощувати функціонал встановленням плагінів і 

макросів зовнішніх розробників. Вбудовані редактор і компілятор допомагають 

користувачеві писати власні плагіни і макроси мовою Java. Наразі бібліотека плагінів 

містить сотні розробок за авторством різних користувачів. 

Плагін – це окремий програмний модуль, який розширює функціонал базової 

програми і потребує встановлення. 

Макрос – це згрупована послідовність команд, яка виконується 

автоматично і записується за допомогою вбудованого у базову програму 

макрорекордера. 

Програмний комплекс придатний для перегляду, редагування, обробки, аналізу, 

збереження і друку 8-, 16- та 32-бітних зображень. Підтримує формати JPEG, TIFF, 

RAW, BMP, PNG, GIF, DICOM і FITS. Дає змогу працювати зі серіями та стеками 

растрових зображень і надає можливість одночасної обробки будь-якої кількості 

файлів, обмеженої лише обсягом доступної оперативної пам’яті пристрою. 

Базовий функціонал ImageJ підтримує стандартні для графічних редакторів 

функції обробки зображень, зокрема: 1) масштабування, поворот, перевертання та інші 

геометричні перетворення; 2) маніпуляції з різкістю, яскравістю, контрастом, 

згладжування; 3) логічні й арифметичні операції над зображеннями – накладання, 

обчислення середнього, добутку, різниці, збільшення яскравості на константу, 

піксельні перетворення; 4) створення гістограм щільності та графіків лінійних 

профілів; 5) фільтрація, аналіз Фур’є; 6) колірні перетворення тощо. Вбудований 

інструментарій допомагає вимірювати лінійні розміри і площу об’єктів, знаходити 

відстані та кути, автоматично ідентифікувати і підраховувати дискретні об’єкти. 
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Розроблений Вейном Расбандом у 1997 році продукт швидко еволюціонував і двічі 

зазнав редизайну. Наразі програма доступна у трьох форматах: ImageJ, ImageJ2, Fiji. 

 
Станом на серпень 2022 року формат ImageJ доступний у версії 1.53. З появою двох 

наступних продуктів його технічну підтримку не припинили. Оновлення виходять 

пакетом раз на 1–3 місяці, а користувачі продовжують розробляти плагіни та макроси. 

Редизайн 2010 року отримав назву ImageJ2 і був розроблений для повної інтеграції в 

існуючий інтерфейс користувача ImageJ. Найперше зміни стосувалися режиму 

розробника, зокрема програма має потужний редактор сценаріїв із підтримкою кількох 

мов програмування. Окрім цього, додано нові команди і вбудовану панель пошуку, 

розширено підтримку форматів файлів, підключено нові сайти з оновленнями, 

автоматизовано інтегрування плагінів у меню. Fiji – найновіший формат, який являє 

собою спільну оболонку для ImageJ та ImageJ2 і забезпечує стабільнішу роботу. Така 

реструктуризація допомагає програмі залишатися доступною для новачків, достатньо 

потужною для експертів і відповідати постійно зростаючим вимогам користувацької 

спільноти. Поява кожного наступного редизайну та кожної нової версії 

супроводжується зростанням вимог до ресурсів комп’ютера. Офіційний сайт 

рекомендує застосовувати найновішу збірку Fiji. 

Оболонку ImageJ можна розглядати як програму-конструктор, яку кожен користувач 

може налаштувати під власні дослідницькі потреби. Формуючи персоналізований набір 

налаштувань, встановлюючи комплект плагінів, використовуючи готові макроси і 

скрипти або створюючи власні, на виході користувач отримує індивідуальну версію 

прогами. Структуру інтерфейсу програми також можна охарактеризувати як модульний 

конструктор із численних окремих вікон, який допомагає зручно та ефективно 

організувати персоналізований користувацький робочий простір: 
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Головне робоче вікно програми компактне з послідовним, зручним та інтуїтивно 

зрозумілим розташуванням панелей меню, інструментів, стану і пошуку. Зображення 

відкриваються кожне в окремому вікні, причому кількість одночасно відкритих 

зображень у роботі обмежується лише можливостями пристрою. Окремо 

відображаються й вікна з налаштуваннями інструментів і параметрів. Кожне з таких 

вікон – незалежний елемент, який можна перетягувати по екрану, масштабувати, 

розміщувати у зручному порядку. Результати відображаються в окремих вікнах у 

вигляді таблиць, гістограм, графіків. Уміст таких вікон можна скопіювати, 

роздрукувати або зберегти в одному зі запропонованих форматів файлу. 

Для першого знайомства з можливостями ImageJ можна скористатися 

вбудованими демонстраційними зображеннями, розташованими у розділі Open 
Samples меню File: 

 

 
 

Бібліотека демонстраційних зображень містить фотознімки, рентгенографічні 

зображення, знімки, отримані з електронних, люмінесцентних, лазерних конфокальних 

та цифрових мікроскопів тощо. Окрім цього, плагіни зазвичай комплектуються 

додатковими демонстраційними матеріалами, які дають змогу протестувати 

можливості завантаженого доповнення. 

 

 



 23 

Додаткову функціональність ImageJ надають сайти оновлення. Вбудований 

модуль ImageJ Updater відстежує такі сайти на предмет нових версій колекцій файлів. 

Після встановлення програми на комп’ютер і після тривалої перерви у користуванні 

Updater пропонує встановити останні оновлення. Це рекомендовано робити для 

стабільної роботи плагінів. 

 
Користувач також має змогу примусово здійснити пошук оновлень і встановити їх, 

скориставшись опцією меню Help > Update ImageJ: 

 
Безперечна перевага комплексу ImageJ полягає саме у великому різноманітті 

плагінів, до створення яких залучається широке коло фахівців і любителів. 

Різноманітність інструментів дає користь користувачам, особливо, коли вони мають 

змогу взаємодіяти на спеціалізованих форумах. Проте це й великий недолік програми, 

оскільки не всі плагіни вдається встановити з першого разу, не всі вони працюють 

стабільно. Мова не про точність вимірювань, а про зручність користування і 

необхідність частих оновлень, вдосконалення і доповнення. Автори деяких успішних 

продуктів втрачають із часом до них інтерес і припиняють надавати підтримку 

користувачам. З іншого боку, відкритий код дає можливість іншим науковцям 

продовжувати роботу з такими перспективними, але «занедбаними» проєктами. Це й 

вирізняє програму від багатьох менше відомих аналогів. 

Серед численних спеціалізованих графічних редакторів ImageJ займає унікальну 

нішу завдяки тому, що це не монолітний або одноцільовий додаток, а скорше 

платформа для відкриттів, де науковці можуть самостійно адаптувати існуючі та 

застосовувати нові методи аналізу зображень. Хоча ImageJ було спочатку розроблено 

для потреб біології та медицини, програма знайшла широке поле використання й у 

інших наукових дисциплінах. Нині це потужний інструмент для будь-якої наукової 

галузі, яка отримує переваги від візуалізації, обробки та аналізу цифрових зображень: 

астрономії, наук географічного блоку, хімії, фізики, інженерних дисциплін тощо. 

Здатність до спільного використання і розширення наукового потенціалу роблять 

ImageJ зручним інструментом для міждисциплінарних досліджень.  
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Тема 4. Методи отримання інформативних зображень для 
екологічних досліджень 

Перш ніж перейти до ознайомлення з функціоналом та інструментами ImageJ, 

з’ясуємо, якими способами і засобами можна отримати інформативні цифрові 

зображення, придатні для використання у ролі первинних даних в екологічних 

дослідженнях. Критерії інформативності фотознімків для різних дослідів можуть 

суттєво відрізнятися залежно від наукових потреб та кінцевої мети кожного аналізу. 

Наприклад, під час визначення морфометричних параметрів об’єкта ручним методом 

важливі параметри суб’єктивного сприйняття зображення оператором. Об’єкт повинен 

контрастно виділятися на тлі, мати чіткі межі, супроводжуватися інформативною 

масштабною шкалою. Тобто має цінність візуальна складова. І, навпаки, при 

автоопрацюванні зображення програмним засобом важливо забезпечити об’єктивну 

ідентифікацію складових елементів адекватним кодуванням сигналів, навіть якщо 

спостерігачу суб’єктивно зображення видається тьмяним, нечітким, а кольори 

неприродними або занадто яскравими. Отже, перед зйомкою важливо чітко розуміти 

подальший алгоритм аналізу отриманих кадрів. 

Існує упередження, що якісно відзняти біологічні об’єкти можна лише із 

застосуванням професійного обладнання. В окремих випадках таке твердження 

справедливе. Однак, як ми з’ясували, кожний окремий науковий проєкт має свої 

критерії інформативності цифрових зображень. Зокрема, для визначення проєктивного 

покриття трав’яного покриву або підрахунку кількості насіння часто достатньо 

якісного цифрового фотознімка, зробленого на камеру смартфона. 

На знімку зліва ви бачите зображення 

мікропрепарату пилкових зерен вільхи білої, відзняте на 

камеру смартфона BlackBerry KeyOne з окуляра 

світлового мікроскопа Біолам Д-11, оснащеного 

зовнішньою LED-підсвіткою. На зображенні добре 

візуалізується не лише характерна для виду форма 

пилкових зерен у полярній та екваторіальній проекціях, 

але й структурні особливості: розташування повітряних 

пухирців, екзина та ентина пилкової оболонки, текстура 

поверхні. Оскільки препарат виготовлений без 

використання барвників, знімок дає уявлення і про 

природне забарвлення пилкових зерен. Для визначення 

видової належності пилку такого ступеня деталізації цілком достатньо. Додатковою 

обробкою у програмі ImageJ можна знизити зернистість та зменшити шуми. 

При зйомці біооб’єктів на камеру смартфона необхідно переконатися у 

тому, що декоративні фільтри вимкнені. 

Отже, камери смартфона буде достатньо для більшості екологічних досліджень 

пов’язаних із дослідженням морфометричних параметрів; кількісних обрахунків у 

ручному або напівавтоматичному режимі; визначення видової належності живих 

організмів; популяційних досліджень; аналізу особливостей оселищ тварин: гнізд, 

входу до нір, міток, які залишають тварини, тощо. 
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Знімки кращої якості для експериментів, які потребують більшої деталізації 

зображення, отримують на цифрові камери. Деякі побутові камери можуть мати 

характеристики, подібні до вбудованих камер смартфонів, і навіть гірші. Однак певні 

переваги цифрових фотоапаратів безперечні. Зокрема, на відміну від більшості 

моделей смартфонів, сучасні фотокамери надають можливість збереження відзнятих 

кадрів у форматах TIFF і RAW. При зйомці на природі широкий діапазон чутливості 

ISO дає можливість отримувати інформативні знімки навіть за поганого освітлення 

(туман, сутінки, нічна зйомка). 

Знімок зліва демонструє 

засвітку нічного неба над 

м. Чернівці у літній період. 

Зображення отримане магістрантом 

Денисом Вершигорою за допомогою 

цифрової фотокамери Nikon D5100 з 

3-кратним оптичним зумом і 

роздільною здатністю 921000 точок, 

16 Mpx. Через калібрування на 

основі аналізу гістограми серії 

знімків із різною апертурою, витримкою та рівнем світлочутливості отримано 

оптимальні налаштування: час витримки – 30 c, апертура діафрагми – від f/4.5, 

світлочутливість – ISO 100. Зауважимо, що такі налаштування найінформативніші 

саме в конкретних умовах спостережень. Для зйомки в зимовий період з цієї ж 

геопозиції на камеру Nikon Coolpix P500 з 36-кратним оптичним зумом і роздільною 

здатністю 921000 точок, 12,75 Mpx, оптимальними за результатами калібрування 

виявилися такі налаштування: час витримки – 1/2 c, апертура діафрагми – від f/4.2, 

світлочутливість – ISO 3200. Отже, інформативність цифрових зображень для 

дослідження світлового забруднення залежить не лише від апаратних параметрів, але 

й від налаштувань фотокамери. Знімати завжди з однієї геопозиції з однаковими 

налаштуваннями недостатньо. Необхідно враховувати також сезонні і погодні 

особливості на момент фотографування. Тому кожна сесія зйомки у цьому разі вимагає 

повторного калібрування. 

Окрім традиційних фотокамер, є чимало їхніх модифікацій, які відповідають 

конкретним дослідницьким потребам. Це може бути як професійне обладнання, так і 

саморобні пристрої на основі фото- і вебкамер. Фотопастки – це спеціалізовані 

фотореєстратори, які реагують на рух. Вони застосовуються для віддаленого 

спостереження за тваринами у природному середовищі існування. Сучасні моделі 

фотопасток оснащуються сонячними акумуляторами для безперебійної роботи 

протягом тривалого часу. Вбудоване інфрачервоне підсвічування уможливлює 

спостереження у сутінковий і нічний час. Для подібних потреб широко застосовують 

вебкамери, які, наприклад, встановлюють у пташиному гнізді, всередині вулика, 

мурашника або нори. Відеозаписи, отримані з вебкамер, допомагають будувати треки 

руху тварин, спостерігати за їхньою поведінкою, вести облік особин у популяції, 

фіксувати рухи і фенологічні зміни у рослин тощо. Підводні фотокамери дають змогу 

досліджувати гідробіонтів. Вони не тільки водонепроникні, але й дають можливість 

налаштовувати яскравість, контрастність, уникнути спотворень зображення у товщі 

води. Моделі для дослідження бентосу оснащують інфрачервоними діодами. 
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Цифрові USB-мікроскопи фактично являють собою вебкамери з високою 

збільшувальною здатністю і вбудованою LED-підсвіткою. Вони допомагають 

передавати зображення безпосередньо на екран комп’ютера, спостерігати за 

збільшуваними об’єктами у режимі реального часу і зберігати кадри для подальшого 

аналізу. Наявні на ринку моделі суттєво різняться за технічними характеристиками. 

Найпростіші USB-мікроскопи зазвичай погано фокусуються, мають низьку роздільну 

здатність, не підтримують плавного налаштування освітлення, а отже, непридатні для 

отримання високоякісних цифрових знімків. Водночас ринок поповнюється новими 

моделями, які можуть скласти конкуренцію світловим мікроскопам і подолати 

незручності фотографування через окуляр.  

На знімку зліва відображене 

поле на території с. Черепківка 

Чернівецької області, забур’янене 

карантинним видом – амброзією 

полинолистою. Його отримано за 

допомогою безпілотного літального 

апарата GJI Phantom 3 Advanced. 

Характеристики вмонтованої циф-

рової камери: роздільна здатність 

HD (1080p, 60 кадрів за секунду), 

фото – 12 Mpx (Raw, JPEG), кут 

огляду – 94 °. Висота зйомки – 30 м. 

Сучасні БПЛА дають можливість спостереження за джерелами і факторами 

антропогенного впливу на екологічні системи, аналіз актуального стану природних 

систем і біологічного різноманіття, моніторинг змін станів природного середовища, 

виявлення наслідків надзвичайних ситуацій тощо. Найкращі знімки можна отримати у 

безвітряну погоду за температури +20 ℃. Згідно з умовами експлуатації конкретних 

моделей безпілотників допускається робота за швидкості від 10 до 15 м/с у 

температурному діапазоні від –20 до +50 ℃. Висота польоту регулюється залежно від 

особливостей об’єкта аерозйомки. 

Для оцифрування гербарних зразків, окремих екземплярів або органів рослин 

зручно використовувати сканери. Підійдуть офісні моделі з високою оптичною 

роздільною здатністю (від 600 dpi). Для дрібних екземплярів, квіток, суцвіть і 

плодів складної форми оптимальна роздільна здатність – 1200 dpi і більше. Прилади 

з CIS-матрицею не дають необхідної якості, тому рекомендоване застосування 

моделей із ССD-матрицею.  

Вимоги до якості сканів для фенотипування і морфометричного 

аналізу нижчі, ніж для різновидів колірного аналізу. Деякі моделі 

офісних сканерів суттєво спотворюють колір. Це необхідно 

враховувати при плануванні експерименту. Перевірку якості 

передачі кольору здійснюють за допомогою калібрувальних 

колориметричних стандартів. Зразок портативного калібратора 

показаний на рисунку ліворуч. Окрім кольорової палетки, він 

містить рядок відтінків сірого, який допомагає налаштовувати 

баланс білого кольору. Калібратори можна використовувати не 
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лише для перевірки передачі кольору сканером, але й для корекції відтінків 

безпосередньо при роботі з графічними редакторами. 

Залежно від потреб при скануванні рослинного матеріалу можна використовувати 

колірні накладки для отримання необхідного фону (чорний або кольоровий картон). 

Застосування білого тонкого поролону або спіненого пінополіетилену, котрий 

використовують як пакувальний матеріал, допомагає уникнути можливої засвітки та 

зайвих тіней від об’ємних частин рослини. 

Уникнути подряпин скла сканера при скануванні зразків зі здерев’янілим 

корінням, а також часточок ґрунту чи піску на корінні можна, підклавши 

під них прозору щільну плівку.  

Для отримання об’ємних моделей біологічних об’єктів, а також об’єктів неживої 

природи використовують сучасні контактні та безконтактні силуетні 3D-сканери. 

Принцип їхньої роботи базується на зніманні пула геометричних маркерів (точок) з 

поверхні предмета з подальшою їх екстраполяцією для реконструкції об’ємного 

зображення. Поки що методологія використання силуетних 3D-сканерів у наукових 

дослідженнях розроблена недостатньо, проте таке обладнання має великий 

прикладний потенціал, особливо при застосуванні у тандемі з 3D-принтерами. Об’ємні 

анатомічні зображення отримують за допомогою сканувального медичного 

обладнання: апаратів ультразвукової діагностики, комп’ютерної та магнітно-

резонансної томографії, сканувальних лазерних апаратів тощо. Методи 3D-сканування 

суттєво підвищують інформативність цифрових зображень, проте залишаються 

дороговартісними і малодоступними для широкого застосування. 

Екологічні дослідження незрідка потребують мікроскопії. Фотознімки зі 

світлового мікроскопа можна отримати за допомогою камери смартфона (як показано 

вище), цифрової фотокамери, фотонасадок на об’єктив. Сучасні мікроскопи мають 

убудовані дисплеї та/або порти підключення до комп’ютерів. Це допомагає 

отримувати цифрові знімки високої якості безпосередньо з пристрою. 

Усі зображення, які планується використовувати для вимірювання 

морфометричних параметрів, повинні містити масштабну шкалу. Для багатьох об’єктів 

це може бути звичайна лінійка або міліметровий папір. У польових дослідах 

знадобляться рулетка, польова лінійка агронома. Може стати у пригоді й килимок для 

різання. Щоб уникнути плутанини, на всіх зображеннях з однієї серії у межах одного 

проєкту слід використовувати стандартизовану масштабну шкалу, а також робити 

знімки з однієї висоти за однакового освітлення під однаковим кутом. 

Для морфометричного аналізу мікропрепаратів здебільшого застосовуються два 

види специфічного обладнання: окуляри-мікрометри та об’єкт-мікрометри. В окуляр-
мікрометр вмонтоване скельце з нанесеною мікрометричною розміткою, ціна поділки 

якої становить 0,1 мм. При спостереженні у мікроскоп необхідно враховувати як 

розмірність окуляр-мікрометра, так і збільшення, яке дає об’єктив. Наприклад, для 

комбінації такого окуляра та об’єктива 20× ціна поділки складатиме 0,0025 (0,1 : 40 = 

0,0025). Тому для точного визначення розмірності шкали окуляр-мікрометрів при 

різному збільшенні здійснюють їхнє калібрування за допомогою об’єкт-мікрометра. 

Це предметне скло з нанесеною шкалою фіксованої величини. Найчастіше об’єкт-

мікрометр має ціну поділки 0,01 мм, рідше – 0,1 мм. Окрім звичайного окуляр-
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мікрометра, застосовують і складніші пристосування, зокрема гвинтовий окуляр-

мікрометр. Він оснащений спеціальним барабаном із нанесеною розміткою, за 

допомогою якого налаштовується шкала в полі зору. 

 

Будувати кадр необхідно у такий спосіб, щоб об’єкт дослідження був у фокусі. 

Об’єм і повнота інформації, яку містить зображення, залежать від правильного вибору 

точок зйомки. Бажано уникати наявності у кадрі об’єктів, які не стосуються предмета 

дослідження. Для невеликих за розмірами нерухомих об’єктів корисно підбирати 

контрастний фон. Використання штативу під час фотозйомки дає змогу значно 

поліпшити якість кадрів за рахунок надійної фіксації апарату. Якщо це неможливо, 

потрібно зайняти стійке положення, наприклад, притулитися до опори. У випадках, 

коли не досліджуються оптичні властивості та колірна гама об’єкта, варто забезпечити 

додаткове штучне освітлення. При цьому необхідно переконатися, що тіні не 

спотворюють контури, рельєф і текстуру об’єкта.  

У природних умовах, по можливості, експеримент планується з урахуванням 

погодних особливостей. Наприклад, під час дощу рекомендовано фотографувати з 

мінімальною витримкою. При фотографуванні у тумані рекомендовано зменшити 

відстань між камерою та об’єктом зйомки. Для отримання максимально чітких 

зображень варто дублювати кадри щонайменше у 3-х–4-х повтореннях. Узимку 

необхідно переконатися у здатності апарату нормально працювати за впливу низьких 

температур. Отже, важливий етап планування експерименту – створення сприятливих 

умов для зйомки або застосування компенсаційних заходів, якщо несприятливий вплив 

неможливо цілком усунути. 

Категорично заборонено фальсифікувати фотознімки або окремі об’єкти на 

зображенні, змінювати у ручному режимі значення окремих пікселів, 

компілювати кадри з метою переконливої інтерпретації наукових даних тощо. 

Екологічний експеримент здебільшого передбачає роботу з об’ємними базами 

зображень. Для їхньої систематизації та адекватної інтерпретації важливо, щоб 

кожен знімок супроводжувався метаданими. Не варто завантажувати файли 

зображень з автоматично згенерованими назвами. Назва файлу може, наприклад, 

відображати порядковий номер об’єкта або місце і час зйомки, назву локації. 

Більшість сучасних пристроїв самостійно визначають і маркують географічні 

координати зйомки, якщо функцію попередньо активовано. Для маркування знімків 

можна користуватися вбудованими засобами камери, ОС Windows, програми-

переглядача або графічного редактора.  
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Тема 5. Функціонал ImageJ та підготовка до роботи 

Хоча інтерфейс ImageJ надзвичайно лаконічний, рядок меню містить великий 

вибір команд. Корисно розпочати ознайомлення з інтерфейсом із команд меню Help.  

 
Посилання ImageJ Website відсилає користувача до офіційного сайту продукту. На 

стартовій сторінці можна знайти посилання на перелік оновлень (news); супровідну 

документацію (docs), де доступна для завантаження інструкція англійською мовою, 

отримати доступ до інформаційного ресурсу ImageJ Wiki, навчальних матеріалів, 

знайти відповіді на часто задавані питання; дистрибутиви для встановлення програми 

на комп’ютер (download); бібліотеку готових до завантаження плагінів (plugins); 

ресурси для розробників плагінів, макросів і додатків (resources); контактні дані для 

листування з розробниками (list); посилання на самостійні програмні продукти, 

розроблені на основі ImageJ (links). Новий користувач може розгубитися від такого 

обсягу інформації, однак у процесі глибшого ознайомлення з можливостями ImageJ 

можна усвідомити і гідно оцінити всебічну підтримку від розробників і користувацької 

спільноти продукту. 

 

 
Нещодавно з’явилася браузерна версія програми, яку знаходять за посиланням Run 

ImageJ in Browser! Цей посібник орієнтований на роботу з версією, яка потребує 

завантаження на жорсткий диск комп’ютера, оскільки вона дає змогу працювати без 

постійного доступу до Інтернету. Однак коротко розглянемо особливості браузерної 

версії, яка знадобиться у разі нестабільної роботи завантаженої програми. 

 

 

https://ij.imjoy.io/
https://ij.imjoy.io/
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На перший погляд, відмінності в інтерфейсі непомітні, що дуже зручно при роботі 

з різних пристроїв. Головна відмінність полягає у наявності додаткового меню для 

розробників плагінів, макросів і додатків: 

 
Також немає деяких функцій. Наприклад, меню Image не містить інструментів для 

редагування відеофайлів та деяких інших опцій: 

 

 
За бажання ви можете самостійно дослідити інші відмінності між версіями ImageJ, 

оцінити переваги та недоліки кожної. 

Наступний блок меню Help містить три опції, які стосуються режиму розробника. 

Для зручності користувача представлений багатий вибір прикладів коду для побудови 

графіків, які не входять до стандартного переліку, створення унікальних інструментів, 

написання макросів різними мовами програмування: JavaScript, Python тощо. 

 



 31 

Залежно від версії ImageJ, меню Help може містити дві або навіть три функції 

оновлення: 

 
Перша з них Update ImageJ ініціює автооновлення програми. Ми розглянули її в 

Темі 3. Друга Update Fiji наявна не в усіх версіях програми і за функціоналом дублює 

третю – Update. Розглянемо останню детальніше. Вона дає змогу примусово 

оновлювати у ручному режимі не лише програму, але й попередньо встановлені 

плагіни. Обране меню ініціює допоміжну утиліту ImageJ Updater. Для просунутих 

користувачів передбачена функція Advanced mode, для початківців достатньо 

скористатися кнопкою Manage update sites, яка відкриває сусіднє вікно з переліком 

сайтів, звідки підтягуватимуться оновлення. За замовчуванням відмічено головні бази 

оновлень програми: ImageJ, Fiji та Java-8: 

 
Опційно користувач може зазначити оновлення до окремих плагінів або ініціювати 

додаткові функції. Для того, щоби оновлення набули сили, необхідно перезапустити 

програму. Наприклад, відмітивши Cookbook, можна активізувати доступ до 

однойменного меню, яке з’явиться у рядку меню поруч із вбудованими розділами: 

 
Для того, щоби ознайомитися з повним переліком сайтів оновлень та опціями, які 

отримає користувач, активізувавши відповідні сайти, можна за посиланням: 

https://imagej.net/list-of-update-sites/ 

https://imagej.net/list-of-update-sites/
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Корисна опція Help on Menu Item при активації 

перенаправляє користувача на відповідну сторінку 

інформаційного сайту при подвійному натисканні на будь-який 

інструмент у панелі інструментів або будь-яку опцію меню. 

Меню File містить стандартні для багатьох програм команди операцій із файлами. 

Детальніше окремі з них ми розглядатимемо у практичному блоці. 

 
Меню Edit запускає операції з редагування файла, а також містить команди 

налаштування програми у підменю Options. Зокрема, Clear витирає виділену область і 

заповнює її кольором фону (за замовчуванням – білим), а Clear Outside здійснює 

аналогічну операцію за межами виділення. Операція Invert міняє місцями світлі і темні 

елементи зображення, відображаючи його негатив. Великий вибір інструментів для 

виділення елементів зображення та операції з ними пропонує пункт меню Selection: 
 

 
За допомогою цих команд можна виділяти все зображення або область, яка має 

форму прямокутника, еліпса, довільної фігури, заданої користувачем; знімати 

виділення; створювати бінарну маску, формувати виділення за цією маскою або 
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колірним порогом; перетворювати лінії на виділену площу товщиною в один піксель, 

здійснювати зворотну операцію та багато інших маніпуляцій. Важлива функція Add to 
Manager дає змогу зберегти виділення як область інтересів у менеджері ROI Manager, 
де такі області можна додавати, перейменовувати, сортувати, а також обчислювати 

задані параметри. 

ROI (англ. region of interest) – область інтересів, тобто частина 

зображення певної конфігурації, яка підлягає наступній обробці, 

трансформації або аналізу 

Параметри візуалізації й анотації зображень можна налаштувати за допомогою 

опцій меню Image. Тут містяться команди для трансформації з однієї колірної моделі 

в інші (опції підменю Type), редагування розміру, яскравості, контрастності, колірного 

балансу (опції підменю Adjust), роботи зі стеками і гіперстеками тощо. Детальніше 

окремі з них ми розглядатимемо у Темі 6 та у практичному блоці. 

 
Меню Window містить команди для управління численними відкритими вікнами, 

які можуть бути одночасно в роботі. 
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Якщо розглянуті вище розділи меню типові для багатьох графічних редакторів, то 

наступні три специфічні для програми ImageJ і стосуються безпосереднього 

опрацювання наукових даних, які містяться у цифрових зображеннях. 

Меню Process містить команди, які допомагають здійснювати операції над 

зображеннями та ROI у їх складі. Користувачеві доступні функції згладжування 

зображення (Smooth), збільшення контрастності (Sharpen), виділення межі різкої 

зміни інтенсивності (Find Edges), знайдення максимумів зображень або максимумів 

яскравості для зображень RGB (Find Maxima), підвищення контрастності за рахунок 

нормалізації гістограми (Enhance Contrast). 
 

 
Підменю Noise поєднує команди додавання і вилучення шумів, Shadows – 

маніпулювання тінями. Для створення й опрацювання бінарних (чорно-білих) 

зображень призначений об’ємний блок інструментів Binary. 

Часто наукові дослідження передбачають 

здійснення математичних і логічних операцій над 

зображеннями. Інструменти для математичних дій 

над пікселями представлені у підменю Math. 

Застосування цих опцій дає змогу попіксельно 

опрацьовувати за раз одне цифрове зображення або 

цілі стеки. Опція Macro надає користувачу 

можливість задати код для зміни зображення за 

власною формулою. 

Математичні дії над цілими зображеннями, 

наприклад їх додавання або віднімання, 

здійснюється за допомогою опції Image Calculator. 
За допомогою калькулятора можна виконувати 

операції над стеками за умови однакової кількості 

слайдів у кожному. Calculator Plus – вбудований 
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плагін, який працює з двома зображеннями, котрі мають різну глибину кольору, та 

надає деякі додаткові можливості. 

При роботі з численними однотиповими об’єктами на зображенні, наприклад 

клітинами, насінням, бджолиним обніжжям тощо, стає у пригоді опція вилучення фону 

Subtract Background. 

Об’ємне за вмістом підменю Filters пропонує великий вибір фільтрів, які 

використовуються для згладжування зображення, зменшення шумів, збільшення 

контрасту, виділення внутрішніх і зовнішніх країв зображення, формування стеків, які 

містять приклади кожного з доступних фільтрів тощо: 
 

 
 

Великий пакет наукових інструментів містить підменю Analyze. Їхнє використання 

дає змогу обирати налаштування для подальшого аналізу, здійснювати вимірювання і 

статистичний аналіз біологічних об’єктів: 

 

Перший блок команд стосується різноманітних морфометричних вимірювань: 

Measure, Analyze Particles, Summarize, Set Measurements. Вони здійснюють 
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вимірювання у межах ROI або усього зображення лінійних розмірів, площі, кутів, 

координат точок. Детальніше про застосування цих інструментів ви дізнаєтеся у 

процесі виконання завдань з практичного блоку. 

Команди вибору параметрів Set scale і Calibrate допомагають налаштувати 

подальші вимірювання для отримання достовірних наукових даних. Функція Histogram 

виводить на екран гістограму розподілу значень сірого. Для RGB-зображень значення 

конвертуються у шкалу градації сірого. Функція Plot Profile будує двовимірний графік 

інтенсивності пікселів уздовж довільної лінії на зображення, а Surface Plot – 

тривимірний графік активного виділення будь-якої форми. 

Підменю Gels містить команди для одновимірного аналізу електрофоретичного 

гелю. Підменю Tools повторює і розширює кнопки панелі інструментів. 

Окремий блок меню Analyze містить спеціалізовані інструменти для конкретних 

наукових завдань. Окремі з них ми розглядатимемо у практичному блоці. 

Меню Plugins містить вбудовані та завантажені додатково користувачем плагіни і 

макроси, а також інструменти для їх завантаження, сортування і налаштування. Для 

зручності використання для кожного з них можна окремо налаштувати комбінації 

клавіш швидкого доступу, скориставшись командами підменю Shortcuts. 

Перш ніж почати роботу з ImageJ, важливо уважно ознайомитися з інформацією, 

наведеною нижче. 

Зображення – це ваші первинні дані. Ніколи не зберігайте зміни в 

оригінальному файлі зображення! Якщо ви внесли корективи у зображення, 

збережіть його як новий файл. 

Якщо колір не має принципового значення для подальшого аналізу, наприклад, 

кінцева мета – обчислення площі об’єкта, рекомендовано переводити кольорові RGB 

зображення у монохромний 8-бітний формат. 

Пам’ятайте про академічну доброчесність! Не компілюйте зображення, не 

вносьте зміни, які надалі можуть вплинути на інтерпретацію результатів. 

Для новачків корисно використовувати чек-список послідовності дій, в якому 

відмічати кожну послідовно виконану операцію. Це допоможе уникнути багатьох 

помилок у багатоетапних дослідженнях, особливо, якщо здійснювати аналіз із 

довготривалими перервами. 

Не забувайте зберігати результати аналізу. Багатокрокові алгоритми 

потребують збереження усіх підготовчих і проміжних налаштувань. 

Оскільки програма ImageJ постійно доопрацьовується, вдосконалюється, працює 

зі сторонніми плагінами і макросами, її регулярне оновлення сприятиме уникненню 

багатьох проблем. Після встановлення оновлень рекомендується перезавантажити 

програму у примусовому порядку. 
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Тема 6. Базові операції над зображеннями у середовищі 
ImageJ 

Незалежно від кінцевої мети користування ImageJ, корисно вміти здійснювати 

базові операції над зображеннями. Усі вони можуть бути віднесені до одного з класів: 

• поліпшення візуальної складової та реставрація – дії, спрямовані на зміну 

властивостей цифрового зображення для комфортнішого суб’єктивного 

сприйняття; 

• аналіз – автоматичне вилучення пристроєм змістової інформації зі знімка; 

• анотування – додавання текстової інформації: легенди, написів, символів, 

масштабних шкал тощо;  

• кадрування, монтаж, панорамування – візуалізація результатів дослідження, 

підготовка до публікації. 

Зміна яскравості/контрастності цифрового зображення. Комплекс операцій, 

спрямованих на поліпшення візуального сприйняття цифрового зображення, широко 

використовується у побуті для надання привабливості фотознімкам. Важливо 

розуміти, що це не робота з науковими даними, які містяться у фотографії, а процедура, 

покликана забезпечити зручність ручного опрацювання цифрових знімків. Наприклад, 

обробка мікрофотографії з рослинним пилком у складі бджолиної обніжки суттєво 

полегшить визначення видової належності пилкових зерен. 

У вікні цифрового зображення зліва ви бачите оригінальний знімок, отриманий на 

камеру смартфона з об’єктиву мікроскопа. Для деталізації морфологічної структури 

пилкових зерен скористаємося функцією Image > Adjust > Brightness/Contrast… > Auto 
> Apply. Меню Brightness/Contrast… можна також викликати комбінацією клавіш 

Ctrl+Shift+C. Результат автоматичного коригування яскравості/контрасту відображено 

у вікні зображення справа: 

 
Вікно налаштувань B&C, окрім автоматичного режиму, надає можливість ручного 

коригування перетягуванням повзунків мінімального і максимального значень, 

яскравості та контрасту. 
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Робота з багатоканальними зображеннями. Для багатоканальних зображень 

передбачена можливість налаштування яскравості/контрастності для кожного каналу 

окремо. Для цього необхідно попередньо розбити зображення RGB на складові канали: 

Image > Color > Split Channels. 

 
Для того, щоби розпочати роботу з окремим каналом, необхідно перевести 

відповідне вікно в активний режим, клацнувши на ньому лівою кнопкою миші. На 

рисунку нижче ви бачите результати ручного налаштування яскравості/контрастності 

у вікні червоного каналу. 

 
Після завершення налаштувань у кожному з каналів їх можна знову об’єднати в 

одне зображення: Image > Color > Merge Channels. 
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Результат після ручного налаштування вихідного зображення у червоному каналі 

в об’єднаному вікні виглядатиме так: 

У вікні Merge Channels можна обрати порядок накладання колірних каналів. 

Традиційно вони йдуть у порядку червоний > зелений > синій, що й відображено у 

абревіатурі RGB. При зміні цього порядку візуальне відображення рисунка 

відрізнятиметься. Поекспериментуйте з налаштуваннями будь-якого повноколірного 

цифрового зображення, щоби самостійно у цьому переконатися. 

Працювати з окремими каналами зручніше зразу у вікні композитного зображення. 

Для розкладання на колірні канали та їхнього подальшого компонування в одному 

вікні необхідно скористатися опцією Image > Color > Make Composite. 

В інформаційному рядку вікна із зображенням відображатиметься активний колірний 

канал (на фото нижче – червоний), а знизу з’явиться повзунок, який дасть змогу зручно 

перемикати активні канали у вікні: 
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Як видно з наведеного рисунка, у такому представленні, незалежно від активного 

каналу, спостерігач бачить повноколірне зображення, а не відтінки сірого, як у 

попередньому прикладі. Рухаючи повзунок перемикання активного каналу, 

спостерігаємо не лише зміну забарвлення тексту в інформаційному рядку, але й зміну 

кольору гістограми. 

 

Усі операції з яскравістю/контрастністю орієнтовані на суб’єктивне 

сприйняття спостерігача. Оскільки у різних осіб воно різниться, 

універсальних налаштувань для певного виду зображень немає.  

Для виконання додаткових операцій із каналами у вікні композитного зображення 

можна скористатися вікном налаштувань Сhannels, яке викликається послідовністю 

команд: Image > Color > Сhannels Tool… або комбінацією клавіш Ctrl+Shift+Z. Для 

ознайомлення з повним переліком команд у меню потрібно натиснути кнопку More. 
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Результати окремих налаштувань композитного багатоканального зображення на 

основі мікрофотографії з пилком ріпака представлені на рисунках: 

 

 
Для людей із порушеннями колірного сприйняття рекомендовано заміювати 

червоний канал (Red) на пурпуровий (Magenta). Цей відтінок утворюється червоним та 

синім у рівних пропорціях. Дальтоніки, яким важко розпізнати червоний компонент, легко 

розпізнають синій. Отже, зміна колірної моделі допомагає компенсувати розлади зору. 

 

 

https://imagej.nih.gov/ij/docs/guide/images/Dichromacy.png


 42 

У режимі композитного зображення можна окремо редагувати шари каналів. 

Наприклад, на рисунку в активному червоному каналі виділити пилкове зерно і 

вилучити виділений фрагмент, скориставшись командою Edit > Cut або комбінацією 

клавіш Ctrl+X. Як наслідок, у цій частині зображення значення червоного не додається 

до зеленого і синього каналів. 

 
Робота з колірними таблицями. Зручний інструмент візуалізації об’єктів на 

цифрових знімках – колірні таблиці LUT (англ. Lookup tables). Принцип їхнього 

застосування базується на забарвленні об’єкта у псевдокольори, що може поліпшити 

видимість низькоконтрастних елементів на зображенні та допомогти людському оку їх 

краще інтерпретувати. У мікроскопії таку функцію використовують кольорові фільтри. 

Застосовувати такі палітри можна лише до одноканальних цифрових зображень. 

Тому RGB знімки попередньо потрібно трансформувати, наприклад, у 32-бітне 

зображення: Image > Type > 32-bit. Відтак відтінки сірого можна зафарбувати у 

псевдоколірні відтінки згідно з обраною палітрою. Переглянути всі доступні палітри 

LUT можна, скориставшись функцією Image > Color > Display LUTs: 
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Розглянемо на прикладі, як зафарбовування у псевдокольори може зробити дані 

більш видимими. На рисунку зліва ви бачите оригінальне зображення. Його було 

переведено у 32-бітне і почергово застосовані різні палітри LUT. Серед багатьох 

можливих варіантів обрані найінформативніші. Зокрема, на центральному рисунку, до 

якого застосована палітра Fire, краще візуалізована структура оболонки пилкових 

зерен. Застосування палітри blue orange icb дало змогу змістити акцент на особливості 

фактури й апертуру пилкових зерен. У споріднених видів рослин у межах роду пилкові 

зерна можуть бути дуже подібними. Лише поглиблений аналіз морфології пилкових 

зерен дає достатньо інформації для їхнього визначення до виду. 

 
Окрім вбудованих колірних таблиць, можна створювати власні. Для цього 

програма пропонує меню Image > Color > Edit LUT, яке викликає таблицю з градієнтною 

розтяжкою кольорів. Наведений приклад демонструє часткову заміну відтінків 

розтяжки, що позначається на вихідному зображенні. 
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Виділення ROI. Обробка й аналіз цифрових зображень передбачають попереднє 

виділення області інтересів. Для цього в ImageJ наявний великий вибір інструментів, з 

якими детальніше ви ознайомитеся у практичному блоці. Користувач може 

застосовувати певну ROI одноразово під час сеансу використання ImageJ або зберегти 

її для подальших сеансів за допомогою опцій меню ROI Manager. Зберегти виділення 

можна й, скориставшись послідовністю операцій: File > Save as… > Selection. Для того, 

щоб відновити роботу з виділеною ROI, потрібно послідовно відкрити файл 

зображення, а потім файл зі збереженим виділенням. 

Різноманітні за розмірами і формою області інтересів можуть бути як обмеженими, 

так і необмеженими. За замовчуванням програма визначає як ROI все зображення 

повністю. Користувацькі налаштування вносять корективи, задаючи контурами межі 

ROI для конкретного зображення або серії зображень. У межах одного зображення 

можна задавати довільну кількість областей інтересів і зберігати кожну окремо або усі 

разом у складі композитного виділення. ROI може мати вигляд точки, групи точок, 

ліній, геометричних фігур, закритих контурів довільної форми. 

Менеджер ROI частково дублює команди і функції, які можна знайти у різних меню 

головного вікна програми. Його зручність полягає не лише у тому, що всі необхідні 

інструменти зібрані в одному вікні, але й у можливості здійснювати численні операції з 

набором ROI (об’єднання, перетину тощо). Для активізації менеджеру області інтересів 

достатньо виділити певний фрагмент зображення і викликати контекстне меню, 

клацнувши правою кнопкою миші всередині виділення. Окрім опції Add to ROI Manager, 
меню містить додаткові операції, які можна застосовувати до області інтересів. 

Наприклад, налаштувати властивості конкретного виділення (ROI properties…) і 

виділення за замовчуванням (Roi Defaults…), додати до нового шару (Add to Overlay), 

створити копію (Duplicate), виміряти (Measure) тощо. Меню More містить інструменти 

логічних, арифметичних, геометричних маніпуляцій з областями інтересів: 

 
Для додавання нової ROI до менеджера з головного вікна ImageJ застосовують 

команду Image > Overlay > To ROI Manager, з самого менеджера – натиснувши кнопку 

Add або гарячу клавішу t. Після редагування області виділення, її можна перезберегти 
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за допомогою кнопки Update. Для перегляду всіх збережених областей інтересів та 

здійснення з ними маніпуляцій потрібно відмітити опцію Show All. 

 
Додавання написів і шкал. При підготовці зображень для публікації нерідко 

виникає потреба у пояснювальних підписах, розміщенні додаткових елементів, 

наприклад, масштабних шкал або калібрувальних смуг. ImageJ містить усі необхідні 

для анотування інструменти. 

Додати текст можна за допомогою кнопки із зображенням літери A на панелі 

інструментів, яка формує прямокутну ROI з місцем для введення тексту. Подвійне 

натискання кнопки викликає меню регулювання шрифту: стилю написання, 

розташування, кольору, розміру тощо. Коли текст відредаговано, необхідно перевести 

ROI в елемент зображення, скориставшись опцією Edit > Draw: 

 
Інструмент Текст не підтримує можливості окремого форматування слів у межах 

однієї фрази. У наведеному прикладі процедуру введення і збереження тексту 

повторено двічі: окремо для латинської назви ріпака і окремо – для скорочення за 

прізвищем автора, оскільки за вимогами біологічної номенклатури біноміальне 

найменування виду подається курсивом, а скорочене написання прізвищ авторів – 

звичайним написанням шрифту.  
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Окрім текстових написів, ImageJ надає можливість додавати до цифрового 

зображення векторні елементи, наприклад, контурне обведення будь-якої форми, 

стрілки або інші види міток. Розглянемо, як це зробити на прикладі стрілки. Щоби 

активізувати інструмент Стрілка на панелі інструментів, потрібно натиснути лівою 

кнопкою миші на червоному трикутнику у нижньому правому кутку піктограми Лінія. 

Наступне подвійне натискання кнопки активізує меню налаштувань, яке допомагає 

регулювати розміри, колір стрілки, стиль та інші налаштування: 
 

 
Щоб зберегти зміну, потрібно викликати контекстне меню, клацнувши правою 

кнопкою миші на стрілці і обрати опцію Add to Overlay. Аналогічно можна 

використати будь-який інший інструмент виділення. 

Для додавання масштабної шкали передбачений окремий інструмент, який можна 

активізувати у меню Analyze > Tools > Scale Bar…:  
 

 
У меню налаштувань можна обрати розміри та колір масштабної шкали, 

налаштувати шрифт колір фону, розташування на рисунку. 

Для того, щоби масштабна шкала відображалась у коректних одиницях 

вимірювання, а не в пікселях, потрібно попередньо відкалібрувати розмір 

зображення. Як це зробити, докладно пояснюється у Темі 2 практичного блоку.  
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Тема 7. Базові навички роботи з плагінами ImageJ 

Наразі бібліотека ImageJ нараховує тисячі плагінів, кожен з яких – окремий модуль 

коду, орієнтований на розв’язання конкретної дослідницької проблеми. Усі вони 

нерівнозначні за функціоналом, зручністю користування, стабільністю роботи та іншими 

технічними характеристиками, оскільки розроблені користувачами з різним досвідом 

програмування. Умовна ієрархічна структура плагінів ImageJ має три щаблі: 

• вбудовані в програмний інтерфейс (Core ImageJ plugins та Core Fiji plugins); 

• плагіни, котрі можна завантажити з офіційної бази ImageJ і потребують 

додаткового встановлення через сервіс Updater; 

• додаткові плагіни, доступні на численних сторонніх ресурсах, які потребують 

ручного встановлення. 

Вбудовані плагіни не потребують встановлення. Їхній перелік можна знайти у 

меню Plugins головного вікна програми: 
 

 
Як видно зі скріншоту, більшість інтегрованих в інтерфейс плагінів згруповано за 

призначенням і головне меню містить вкладені категорії. Всі вони мають супровідну 

документацію: інструкцію до використання, опис інструментів, деякі – демонстраційні 

матеріали. Цю інформацію можна знайти в офіційному переліку плагінів ImageJ: 

 

https://imagej.net/list-of-extensions
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Плагіни з основної колекції ImageJ та Fiji постійно оновлюються, розробники 

виправляють помилки, підтримують зворотний зв’язок з користувачами, поповнюють 

пов’язані бібліотеки. Оновлення вбудованих плагінів відбувається автоматично при 

оновленні головної програми. Нерідко в соціальних мережах і наукових спільнотах 

формуються групи підтримки, в яких користувачі можуть ділитися досвідом 

використання плагіна, пропонувати шляхи вдосконалення тощо. Нижче як приклад 

наведено окремий випадок вирішення технічної проблеми, виявленої користувачем: 

 
 

Плагіни з офіційної бази ImageJ, котрі потребують встановлення, зручно 

завантажувати через модуль оновлення Updater. У Темі 5 ми розглянули, як його 

запустити через меню Help. Кнопка Manage update sites відкриває сусіднє вікно з 

переліком доступних для встановлення плагінів і відповідним посиланням на сайт, 

звідки надалі автоматично завантажуватимуться оновлення. І навпаки, прибравши 

галочки навпроти плагінів, у яких більше немає потреби, можна скоротити перелік, 

який відображається у меню Plugins. 

Розглянемо, які зміни відбудуться, якщо відмітити плагін Microglia-Morphometry, 

якого немає в стандартному наборі ImageJ: 

 
Після закриття вікна з переліком плагінів обрана позиція відобразиться у вікні ImageJ 
Updater як поставлена у чергу для встановлення. Натиснувши Apply changes, користувач  
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підтверджує бажання інсталювати плагін. Для того, щоби він з’явився у складі меню 

Plugins потрібно перезавантажити вікно програми. 

 
Незважаючи на те, що остання версія ImageJ працює коректно і стабільно на різних 

пристроях, може виникнути необхідність у ручному встановленні плагінів. Для цього 

необхідно попередньо завантажити архів із плагіном на комп’ютер. Велика бібліотека 

плагінів, доступних для завантаження, розміщена за адресою https://sites.imagej.net/. 

Наприклад, тут міститься архів з наведеним вище плагіном Microglia-Morphometry. 

 
Ще одна об’ємна бібліотека плагінів з описами і супровідною документацією 

розміщується на сторінці https://imagej.nih.gov/ij/docs/menus/plugins.html. Тут вони 

згруповані за призначенням: 

 
Завантажений архів необхідно розархівувати. Плагін може складатися з одного або 

кількох файлів, які потрібно розмістити у папці ImageJ > plugins. Специфіка ручного 

встановлення плагіна залежить від його виду. Зокрема, для файлів які мають 

https://sites.imagej.net/
https://imagej.nih.gov/ij/docs/menus/plugins.html
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розширення *.jar або *.class, зазвичай достатньо просто перезапустити ImageJ після 

переміщення файлу в папку plugins. Якщо файл має розширення *.java, потрібно 

попередньо виконати команду Compile and Run… , щоб привести його до формату 

*.class. Після одноразового виконання цієї команди і перезапуску ImageJ плагін стане 

доступним у меню Plugins. 

 
Для окремих плагінів режим встановлення може суттєво відрізнятися. Зазвичай 

розробники супроводжують їх детальним описом зі встановлення. Наприклад, 

популярний у науковому середовищі плагін ObjectJ має потужний сайт підтримки, де 

не лише представлена покрокова інструкція зі встановлення, але й наводяться численні 

приклади використання інструментів для досліджень різного характеру: 
 

 
Детальніше з особливостями встановлення плагінів у ручному режимі ви 

ознайомитеся у практичному блоці цього посібника. 

Щороку з’являються сотні нових плагінів. Деякі з них – продукт дипломних 

проєктів студентів з усіх куточків світу. Хоча бібліотеки ImageJ відкриті до 

поповнення новинками, не всі розробники виявляють бажання їх там розміщувати. 

Такі продукти можна знайти на сторонніх ресурсах, зокрема й у соціальних мережах. 

Це не обов’язково свідчить про недбале ставлення автора до свого плагіна. Проте 

користувач повинен встановлювати любительські плагіни, усвідомлюючи можливу 

некоректну роботу, несумісність з операційною системою, відсутність зворотного 

зв’язку і подальшого розвитку.  



 51 

Тема 8. Основи інтегрування макросів у ImageJ 

Якщо більшість плагінів ImageJ реалізовані у вигляді додаткових інструментів і 

навіть окремих повноцінних модулів програми зі своїм меню, додатковими функціями, 

можливістю налаштовувати опції, то макроси являють собою текстовий файл із кодом, 

написаним мовою програмування ImageJ Macro (IJM). Фактично це сценарій 

послідовних дій у середовищі ImageJ. Зазвичай макроси застосовуються для: 

• автоматизації однотипових дій (наприклад, стандартних вимірювань у межах 

серії цифрових зображень); 

• документації послідовності дій користувача для можливості відтворення умов 

досліду; 

• змоги ділитися власними надбаннями з іншими користувачами у спільноті; 

• додавання користувацьких інструментів до панелі та налаштування 

користувацьких комбінацій клавіш. 

Макрос ImageJ – це проста програма, яка містить серію команд і виконується 

вибором опції меню, натисканням клавіші або клацанням по піктограмі на панелі 

інструментів. Аналогічно до інших мов програмування IJM має базові структурні 

команди, за допомогою яких можна побудувати алгоритм дій програми. Її основу 

складають змінні, математичні або логічні функції та контролюючі складові (команди 

умов). Головна ж відмінність IJM полягає у доступі до всіх вбудованих функцій і 

цільових об’єктів ImageJ: цифрових зображень, вікон, у яких вони відкриваються, ROI, 

таблиць результатів, графіків тощо. 

Для початківців розроблено чимало онлайн-бібліотек, довідників, інструкцій з 

основ написання макросів для ImageJ. Посилання на деякі з них ви знайдете у 

підрозділі Інформаційні ресурси.  

 
 

На сайті https://imagej.nih.gov/ij/macros/ міститься колекція шаблонів макросів у 

форматі файлу *.txt, котрі можна використовувати як зразок для створення власних. 

Ознайомитися зі змістом можна, відкривши обраний зразок у вікні браузера. 

Поверхневого перегляду достатньо для того, щоби порівняти окремі макроси між 

собою. Деякі мають лаконічний код, який займає 20–40 рядків. Інші при перенесенні у 

текстовий редактор можуть займати кілька сторінок. Складність коду залежить від 

https://imagej.nih.gov/ij/macros/
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кінцевої мети: чим більшу кількість послідовних операцій він містить, тим більше 

команд знадобиться для реалізації сценарію. 

У спеціалізованих спільнотах науковці нерідко діляться готовими макросами для 

виконання конкретних завдань. На відміну від плагінів, які встановлюються переважно 

кількома стандартними способами, готові макроси можуть вбудовуватися в ImageJ по-

різному. Зазвичай спосіб встановлення прописаний в інформаційному блоці макроса 

або в супровідних документах, якщо такі є. 

Інструменти ImageJ для роботи з макросами містяться у меню Plugins > Macros: 

 
Функція Install… призначена для встановлення готових макросів із файлу. При її 

активації відкривається вікно з папкою macros, яка за аналогією до папки plugins міститься 

у директорії Fiji.app. Отже, для того, щоби встановити макрос у такий спосіб, попередньо 

потрібно його розмістити у вигляді файлу з розширенням *.txt у папку macros. У 

наведеному прикладі файл із назвою Vegetation indices .txt був доданий заздалегідь: 

 
Натиснувши кнопку Відкрити, користувач вбудовує щойно доданий файл у 

інтерфейс головного вікна ImageJ. Тепер він відображатиметься у нижній частині меню 

Macros, як показано на скріншоті нижче. Такий спосіб встановлення зручний у 

випадку, коли макрос буде застосовано один раз для виконання конкретного завдання, 

і його повторне використання у найближчий час не передбачається. При наступній сесії 
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роботи з ImageJ макрос Vegetation indiced calculated by Fiji з наведеного прикладу 

більше не відображатиметься у меню. 

 
Для того, щоб макрос зберігся у переліку меню і завантажувався щоразу при 

відкритті головного вікна ImageJ, його необхідно занести вручну до наявного у папці 

macros файлу StartupMacros.txt. У випадку, якщо такого файлу немає, потрібно його 

створити самостійно. Для цього потрібно натиснути правою кнопкою миші у вікні 

папки macros і обрати опцію Створити > Текстовий документ, назвавши новостворений 

документ StartupMacros. 

 
Для виділення коду з файлу макроса зручно використовувати комбінацію клавіш 

Crtl+A, для його копіювання в буфер обміну – Ctrl+C. Вставити виділений текст у 

порожній поки що файл можна, скориставшись комбінацією клавіш Ctrl+V. 

 
Файл StartupMacros.txt може містити скільки завгодно макросів, які потрібно 

відокремлювати між собою порожнім абзацом (кнопка Enter). 
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Додані у такий спосіб макроси не відображатимуться напряму в меню Macros. Їх 

тепер можна буде знайти у підменю StartupMacros…  

 
 

Однойменний файл відкривається в окремому вікні менеджера макросів, 

призначення й можливості якого ми детальніше розглянемо нижче. 

Команда Run... з підменю Macros запускає макрос напряму з файлу, обраного з 

переліку наявних у папці macros. 

 
 

Команда Edit... викликає вікно вибору макроса. Обраний файл відкривається у 

вікні менеджера макросів, яке являє собою окрему оболонку для роботи з кодом. 

 
Як і в багатьох інших редакторах для роботи з програмним кодом для зручності 

користувача різні групи операторів підсвічені різними кольорами. Рядки 

пронумеровано для швидкого доступу до потрібної частини коду. Кнопка Show Errors 
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допомагає віднайти можливі помилки сценарію. Інструменти редагування із 

вказуванням комбінацій клавіш швидкого доступу розміщені в меню Edit: 

 
Останні версії ImageJ підтримують не лише мову програмування IJM, але й перелік 

інших, широко вживаних у науковій спільноті, наприклад, R, Python, JavaScript, 

BeanShell тощо. Користувачі, які опанували одну з представлених у переліку мов, 

можуть налаштовувати макроси з використанням знайомих команд. 

 
Меню Templates містить зразки коду для макросів найрізноманітнішого 

спрямування. Дослідження їх структури, модифікація, доповнення суттєво 

полегшують завдання початківцю. Меню Tools і Options пропонують інструменти і 

налаштування для перевірки готового коду, налаштувань, поліпшення візуальної 

складової та інші корисні функції. Надзвичайно корисні для новачка ресурси містить 

інформативне меню Help. 

Для створення найпростіших макросів досвід програмування не потрібний взагалі. 

ImageJ пропонує інтерактивний інструмент Record, який дає можливість записувати 

послідовність дій користувача у вигляді коду IJM і зберігати його як повноцінний 

макрос. Практичні навички його використання ви отримаєте, виконавши завдання 

Теми 6 з практичного блоку посібника. 
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Практичний блок 

Тема 1. Програмний комплекс ImageJ. Ознайомлення з 
інтерфейсом і сайтом підтримки 

Матеріали, обладнання та ПЗ 

Вимоги до операційної системи: Windows (XP, Vista, 7, 8, 10, 11) розрядністю 32-bit та 

64-bit, macOS та Linux тільки 64-bit. 

Мінімальні вимоги до комп’ютера: двоядерний процесор Intel або AMD, 8 ГБ 

оперативної пам’яті, 40 ГБ жорсткий диск.  

Підключення до мережі Інтернет необхідне для скачування програмного комплексу, 

подальших оновлень та встановлення плагінів і макросів. 

Сфера використання набутих умінь і навичок 

Сучасний стиль життя ставить перед фахівцем-екологом багато завдань, а вимоги 

до професійних умінь і навичок лише зростають. Здатність самостійно встановлювати, 

налаштовувати та підтримувати спеціалізоване програмне забезпечення розширює 

базовий набір фахових компетентностей і забезпечує незалежність дослідника від 

інших вузьких спеціалістів. Оскільки інформаційні системи і технології обіймають в 

екологічному експерименті важливе місце, навички, набуті при виконанні цієї роботи, 

можуть знадобитися й при встановленні інших подібних програмних продуктів для 

виконання інших практичних завдань. 

Ознайомлення з інтерфейсом програмного комплексу ImageJ корисне не лише 

екологам, але й біологам, медикам, географам, фотографам, фізикам, матеріалознавцям та 

багатьом іншим фахівцям, які використовують цифрові зображення у професійній царині. 

Хід роботи 

1. Завантажте версію програмного комплексу, яка підходить для операційної системи 

Windows за посиланням https://imagej.net/Fiji/Downloads 

 

 

 

На рисунку показано, що дистрибутиви доступні у версіях для двох розрядностей 

операційної системи: 32-бітної та 64-бітної. Дізнатися розрядність операційної системи 

для власного пристрою ви можете, натиснувши правою кнопкою миші на кнопці Пуск. 

У списку панелі керування натисність Cистема. Потрібна інформація відобразиться у 

підрозділі Специфікації пристрою: Тип системи. На наведеному нижче рисунку можна 

переконатися, що для даного пристрою необхідно завантажити версію дистрибутивів 

на 64 біти. До таких належить більшість сучасних комп’ютерів, лише деякі старі моделі 

можуть мати 32-бітну операційну систему. 

https://imagej.net/Fiji/Downloads
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2. Архів збережіть у зручному для вас місці. Краще – зразу на той диск, куди плануєте 

встановити програму, а не на Робочий стіл.  

 

На рисунку показане розташування ImageJ на диску С, оскільки на даному пристрої 

це єдиний диск. Зазвичай при встановленні ОС Windows для ефективнішого використання 

фізичний жорсткий диск комп’ютера розбивають на кілька логічних. При цьому 

системний диск автоматично позначається літерою С, а решті присвоюються інші літери 

латинського алфавіту – D, E, F тощо. Бажано закачувати архів ImageJ саме на один із цих 

дисків, а не на системний для забезпечення стабільної роботи. 

На відміну від багатьох інших програм, ImageJ не встановлюється 

автоматично у папку Program Files. Більше того, рекомендовано уникати 

збереження її саме у цій директорії для уникнення подальших проблем із 

оновленням. 

3. Розархівуйте папку з програмним комплексом, вказавши шлях збереження: 
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4. Відкрийте видобуту з архіву папку та запустіть програмний комплекс: 

 

 

5. У результаті повинне з’явитися початкове вікно, як на скріншоті нижче: 
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Для зручності подальшого використання можна створити ярлик швидкого 

доступу на вибір на робочому столі або у панелі завдань. 

Можливі труднощі 

Під час виконання роботи можуть виникнути певні труднощі. Розглянемо 

найпоширеніші. 

Не відкривається сторінка https://imagej.net/software/fiji/downloads 

Розв’язання проблеми: 

а) перевірити підключення до мережі Інтернет; 

б) переконатися, що немає блокування сторінки зі сторони антивірусу або firewall. 

Архів із програмним комплексом не зберігається на комп’ютері. 
Розв’язання проблеми: 

а) перевірити наявність необхідного вільного місця на диску; 

б) переконатися, що системі дозволено завантажувати та зберігати файли з 

розширенням *.zip. 

Архів із програмним комплексом не відкривається, видає помилку. 

Розв’язання проблеми: 

а) завантажити файл архіву повторно. 

Папка з програмним комплексом не видобувається з архіву. 

Розв’язання проблеми: 

а) завантажити файл архіву повторно; 

б) перевірити наявність необхідного вільного місця на диску. 

 

Огляд панелі інструментів. Головне вікно ImageJ лаконічне, але досить містке. 

Воно складається лише з рядка меню, панелі інструментів у вигляді піктограм, рядка 

стану та пошукового меню. Детальний огляд меню проведений у теоретичному блоці. 

Нижче наведено короткий огляд кожного з інструментів програмного комплексу. Для 

зручності кожен інструмент позначений цифрами або літерами латинського алфавіту: 

 

Якщо внизу піктограми наявний маленький червоний трикутник, для цього 

інструменту доступні додаткові опції, які викликаються довгим кліком лівої 

кнопки миші, коротким кліком правої кнопки миші або натисканням клавіші Alt. 

1. Прямокутне виділення (прямокутник звичайний, прямокутник із закругленими 

кутами, прямокутник обертальний). 

 

https://imagej.net/software/fiji/downloads
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Додаткові опції: 

1.1. Затискання клавіші Shift – прямокутник перетворюється на квадрат. 

1.2. Затискання клавіші Alt змінює довжину/ширину прямокутника за допомогою 

клавіш-стрілок на один піксель при кожному натисканні. 

1.3. Затискання клавіші Ctrl – центром виділення стає початкова точка. 

1.4. Затискання комбінації клавіш Ctrl + Alt – при зміні розміру виділення 

зберігаються пропорції. 

Різновиди прямокутних виділень у програмі ImageJ: 

 
2. Кругове виділення (овал, еліпс, пензель).  

 
Використання допоміжних клавіш для овального виділення активізує додаткові опції, 

аналогічні до інструментів прямокутного виділення: 

2.1. Затискання клавіші Shift – овал перетворюється на коло. 

2.2. Затискання клавіші Alt – змінює довжину/ширину овалу за допомогою клавіш-

стрілок на один піксель при кожному натисканні. 

2.3. Затискання клавіші Ctrl – центром виділення стає початкова точка. 

2.4. Затискання комбінації клавіш Ctrl + Alt – при зміні розміру виділення 

зберігаються пропорції. 

Еліпс, аналогічно до обертального прямокутника має закріплену початкову точку. 

При виборі інструмента пензель доступні такі можливості: 

2.5. Затискання клавіші Shift – пензель додається до виділеної області. 

2.6. Затискання клавіші Alt – пензель вилучається з виділеної області. 
 

 
Затисканням клавіші Shift можна додавати нові елементи визначеної форми до 

загальної області виділення: 
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3. Виділення багатокутною фігурою будь-якої форми дає змогу сформувати складну 

область виділення:  

 
Інструмент зручно використовувати для виділення об’єктів із плавними лініями, 

яких важко досягти комбінацією простих фігур, як показано у прикладах на попередній 

сторінці. Окрім цього, гарячі комбінації клавіш дають можливість зручного 

редагування окремих вершин (вузлів) складного контуру. 

 
Додаткові опції: 

3.1. Затискання клавіші Shift – створює додаткову вершину фігури. 

3.2. Затискання клавіші Alt – вилучає існуючу вершину фігури. 

3.3. Подвійний клік лівою кнопкою миші з’єднує останню точку зі стартовою. 

4. Вільне виділення – інструмент, який дає змогу обрати область будь-якої форми за 

аналогією до стандартного інструмента олівець у інших графічних редакторах: 

 
5. Набір інструментів лінійного виділення: (пряма лінія, сегментована лінія, лінія від 

руки, стрілка). 

 
5.1. Пряма лінія служить переважно для виділення фрагментів зображення з метою 

подальшого вимірювання лінійних розмірів. 

Доступні можливості функціональних клавіш та їхніх комбінацій: 

5.1.1. Затискання клавіші Shift встановлює лінію строго горизонтально чи 

вертикально. 

5.1.2. Затискання клавіші Alt блокує зміну довжини лінії при її переміщенні або 

обертанні навколо одного з кінців. 

5.1.3. Затискання клавіші Ctrl – при переміщенні лінії за один із кінців вона 

обертається навколо центру. 

5.2. Сегментована лінія дає змогу будувати ламані лінії. Завершити виділення 

можна подвійним натисканням лівої кнопки миші. 



 62 

Додаткові функції: 

5.2.1. Затискання клавіші Shift створює додаткову вершину лінії. 

5.2.2. Затискання клавіші Alt вилучає існуючу вершину лінії. 

5.3. Лінія від руки допомагає намалювати лінії довільної форми. 

5.4. Стрілка повторює властивості інструмента Пряма лінія, від якого відрізняється 

тільки наявністю вістря на одному або на двох кінцях. 

6. Інструмент Кут надає можливість виміряти кут, визначений трьома точками. Для 

того, щоб увімкнути вимірювання зворотних кутів, необхідно двічі клацнути на 

піктограму. 

 
7. Набір інструментів Точка, Мультиточка. 

7.1. Інструмент Точка зазвичай використовується для підрахунку об’єктів. 

Додаткові функції: 

7.1.1. Затискання клавіші Shift додає на зображенні точку з порядковим 

номером. 

7.1.2. Затискання клавіші Alt видаляє точку. 

7.1.3. Комбінація Shift + А – видаляє всі точки на зображенні. 

7.2. Мультиточка практично те ж саме, що й Точка, але не потребує затискання 

клавіші Shift при додаванні точок. Інші клавіші та їхні комбінації дають змогу 

виконувати ті ж дії, що й для інструмента Точка. 

 
Подвійник клік на піктограмі викликає меню налаштувань. Перші три з них 

змінюють вид точки, колір та її розмір. 

 
7.2.1. Auto-Measure. Активація функції допомагає записати місцезнаходження 

та інтенсивність пікселя при кліку на зображенні. 
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7.2.2. Auto-Next Slice. Програмний комплекс автоматично переходить до 

наступного зрізу. 

7.2.3. Add to overlay. Додає точку до верхнього шару зображення. 

7.2.4. Add to ROI Manager. Точки автоматично будуть додані до ROI Manager. 

7.2.5. Label Points. Кожна точка матиме цифрову мітку. 

7.2.6. Show on all slices. Показує точки на всіх зрізах. 

8. Чарівна паличка – інструмент, призначений для виділення через трасування 

об’єктів подібного кольору або з однаковим пороговим значенням. Для того, щоби 

виділити об’єкт, необхідно клацнути всередині біля правого краю, або ззовні 

ліворуч. У такий спосіб чарівна паличка виділяє всі пікселі в безперервній області, 

які торкаються один одного і мають значення у межах заданого діапазону, котрий 

називається допуском.  

Затискання клавіші Shift дає змогу додавати невиділені автоматично фрагменти 

зображення до області виділення. 

Зауважимо, що цей інструмент може некоректно виділяти деякі об’єкти, особливо 

лінії завтовшки в один піксель, якщо в них немає порогового значення (виділення 

червоним кольором) у меню Image > Adjust > Color Treshold: 

 
Подвійне клацання на іконці інструмента викликає конфігураційне меню, де: 

• Tolerance – повзунок, який налаштовує діапазон допуску, тобто значення 

суміжних пікселів, які будуть додані до виділення. Наприклад, якщо піксель, 

який ви клацаєте, має значення 30, а допуск встановлено на 20, усі суміжні 

пікселі зі значеннями від 10 (30 – 20 = 10) до 50 (30 + 20 = 50) увійдуть у 

область виділення. 

• Mode – опція, котра допомагає додатково налаштувати режим виділення і 

має такі опції: 1) Legacy – допуск не використовується, тобто сусідні точки 
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не перевіряються; 2) 4-connected – вважаються пов’язаними тільки чотири 

сусідні пікселі; 3) 8-connected – вважаються пов’язаними тільки вісім 

сусідніх пікселів. 

 
9. Інструмент Текст використовується для додавання написів до зображень. При його 

застосуванні створюється прямокутне виділення, у якому міститься один або кілька 

рядків тексту. Подвійне клацання на іконці викликає меню налаштувань, де можна 

обрати шрифт, стиль, вирівнювання, колір тексту та колір підкладки, а також розмір 

та кут нахилу шрифту. 

 
10. Лупа використовується для збільшення (лівою кнопкою миші) або зменшення 

(правою кнопкою миші) розмірів зображення. Поточне збільшення відображається 

у дужках біля назви файлу зображення. Подвійне клацання на іконку інструмента 

відновлює оригінальне збільшення. Всього доступний 21 рівень збільшення від 

3,1 % до 3200 % від оригінального розміру. 

Клацнувши правою кнопкою миші по піктограмі лупи, можна викликати 

контекстне меню інструмента, яке містить опції: 1) відміни попередньо здійснених 

маніпуляцій із розмірами зображення (Reset Zoom); 2) збільшення (Zoom In); 

3) зменшення (Zoom Out); 4) повернення до вихідних розмірів (View 100%); 
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5) збільшення попередньо виділеної області зображення (Zoom to selection); 

6) збільшення рисунка до розмірів вікна (Scale to Fit); 7) регульованого масштабування 

(Set…); 8) збільшення вікна на висоту екрана (Maximaze). 

 
 

11. Переміщення – інструмент, котрий допомагає пересувати зображення, розмір 

якого більший за розмір вікна. У режим переміщення можна тимчасово 

переключитись при використанні інших інструментів (крім тексту), утримуючи 

клавішу Пробіл. 

 
 

12. Вибір кольору – функція, яка задає колір малюнка переднього плану. Клацнувши у 

палітрі з утримуванням клавіші Alt, можна змінити колір фону. Піктограма 

інструмента вказує поточний колір переднього плану, а рамка навколо неї –

поточний колір фону. Довге натискання на іконку дає можливість вибрати 

попередньо встановлені кольори, а подвійний клік видає вікно вибору кольору.  
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Іконки від А до F – це вже готові додаткові набори інструментів та макросів, які 

можна обрати, натиснувши на крайню справа іконку з двома червоними стрілками 

Залежно від того, який набір обрано, змінюються інструменти на панелі. На скріншотах 

нижче наведено варіанти панелей із різними додатковими інструментами та 

макросами, які попередньо задані в програмному комплексі. Крім того, є можливість 

створити власну панель інструментів та макросів, яка буде повністю відповідати цілям 

того чи іншого дослідження. 

 
Опційні кнопки після завершення роботи над проєктом можна прибрати з панелі 

інструментів. Щоби повернутися до стандартного набору інструментів необхідно 

обрати у спадному меню StartupMacros*. 

 
Додаткову інформацію щодо інструментів, меню і можливостей програмного 

комплексу ImageJ можна отримати на сайті підтримки за посиланням: 

http://imagej.nih.gov/ij/docs/guide 

  

http://imagej.nih.gov/ij/docs/guide
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Тема 2. Визначення розмірів та площі біологічних 
об’єктів 

Матеріали, обладнання та ПЗ 

білий папір формату А4, вузький прозорий скотч, прозорий файл формату А4, сканер, 

міліметровий папір, екземпляри листків різних рослин, програмний пакет ImageJ. 

Сфера використання набутих умінь і навичок 

Визначення розмірів і площі клітин, органів, мікроорганізмів, екземплярів рослин 

і тварин, вимірювання кутів, аналіз контурів – основа багатьох кількісних екологічних 

досліджень. Результати морфометричного аналізу дають уявлення про анатомічні, 

фенотипові, пристосувальні особливості живих організмів, тому цей метод нерідко 

застосовується в популяційній та еволюційній екології. Варіабельність 

морфометричних показників широко використовується як тест-ознака у біоіндикації 

стану навколишнього природного середовища. 

Широкий ряд аутекологічних досліджень потребує різного роду вимірювань. 

Наприклад, оцінка лінійних розмірів і площі листка слугує інформативним показником 

росту рослин. Такі параметри, як продуктивність фотосинтезу, вміст пігментів, 

інтенсивність транспірації, дихання також обчислюються з урахуванням розмірів 

об’єкта. Цікавим є аналіз розподілу листя за площею і вплив на цей показник гормонів 

росту, факторів навколишнього середовища, умов мінерального живлення і 

вологозабезпечення. Інструменти напівавтоматичного вимірювання дають можливість 

не лише характеризувати індивідуальні особливості біологічних об’єктів, але й 

виявляти відхилення від норми та вади розвитку, визначати площу ураження, ступінь 

пошкодження тощо. 

Нова галузь – ознакова екологія (англ. trait-based ecology) – досліджує 

морфологічне і функціональне різноманіття на різних рівнях біологічної організації та 

вводить поняття морфоніші (англ. morphoniche), котра визначається як сукупність 

подібних рис будови і характеризує межі фенотипової пластичності. Згідно з 

концепцією морфоніші морфо-фізіо-фенологічні ознаки еволюціонували у відповідь 

на абіотичні умови середовища та взаємодію з іншими видами. Цілий методологічний 

апарат ознакової екології побудований на різнобічному аналізі цих ознак. 

Хід роботи 

1. Зберіть зразки листкових пластинок різної форми та розмірів. 

2. За допомогою вузького прозорого скотчу прикріпіть листки до паперу. При цьому 

ретельно розгладжуйте усі складки, щоби листок не м’явся, не скручувався, добре 

тримався паперу.  

3. Якщо немає можливості зразу ж відсканувати рослинний матеріал, листки 

попередньо гербаризуйте, а аркуш з наклеєними об’єктами обережно розмістить в 

прозорий файл. У такому разі на момент сканування аркуш із файлу не виймається. 

4. Під аркуш паперу або всередину файлу акуратно розмістіть і прикріпіть прозорим 

скотчем невеликий квадрат або прямокутник міліметрового паперу зі стороною не 

менше 4–5 см. За відсутності міліметрового паперу можна помістити у файл лінійку 

з чіткими написами для подальшого масштабування зображення. Упевніться, що 

лінійка ніде не перекриває рослинний матеріал. 
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5. Відскануйте файл із листками у режимі чорно-білого напівтонового зображення з 

роздільною здатністю не менше 200 dpi і збережіть зображення у форматі *.bmp: 

 
6. Отримані зображення завантажте у програму ImageJ. Для цього викличте меню File 

> Open… або перетягніть піктограму зображення у вікно програми. 

 

Якщо немає можливості отримати вихідне чорно-біле зображення, необхідно 

перевести кольоровий знімок у градації сірого, скориставшись командою Image > 
Type > 16-bit: 

 

Оброблене зображення виглядатиме так: 
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7. Для встановлення зв’язку між реальною одиницею довжини (мм) і розмірами 

пікселя налаштуйте масштаб. Для цього оберіть інструмент Straight Line і 

проведіть пряму по контурах однієї з ліній зображення міліметрового паперу: 

 

8. В підменю пункту меню Analyze оберіть Set Scale: 

 

9. У допоміжному вікні встановіть одиницю вимірювання – сантиметри, задайте 

довжину відрізка 5 см. Якщо потрібно зробити серію вимірювань з одного аркуша 

зі спільною шкалою, відмітьте маркером опцію Global. 

 

10. Скориставшись інструментом Straight Line, відрізком відмітьте той параметр, який 

збираєтесь виміряти, наприклад довжину листка: 
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11. В меню Analyze оберіть пункт Measure: 

 
Результати обрахунку відобразяться у наступному вікні в колонці Length: 

 
12. Аналогічно виміряйте ширину листка. Для складних листків виміряйте 

морфометричні параметри усіх модулів. При цьому зручно користуватися 

комбінацією клавіш  Ctrl+M. 

13. Зроблені виміри збережіть у файлі *.xls, скориставшись у цьому вікні функцією File 

> Save us… для подальшої обробки в Microsoft Office Excel або Гугл Таблицях. 

 
14. Для вимірювання площі листкової поверхні необхідно отримати з монохромного 

зображення максимально контрастне. Для цього викличте меню Image > Adjust > 

Threshould: 

 
 

У наступному вікні рухайте маркерами прокрутки, поки об’єкт не стане повністю 

червоним, а фон повністю білим: 
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Для різних зображень положення маркерів прокрутки один відносно одного 

може бути різним. Необхідно орієнтуватися за змінами у вікні зображення. 

15. Отримавши потрібний результат, натисніть кнопку Apply й закрийте діалогове 

вікно. Вікно з перетвореним зображенням листка має залишатися відкритим. Якщо 

все зроблено правильно, листок буде повністю забарвлений в чорний колір, а фон 

залишатиметься повністю білим. 

На фоні можуть виділятися контури міліметрового паперу, це надалі не 

впливатиме на обчислення 

16. На панелі інструментів оберіть кнопку Wand (tracing) tool та клацніть нею по 

фігурі, яку збираєтесь міряти. Контур листка підсвітиться кольоровим контуром (на 

фото нижче – рожевим): 
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17. Для подальшої оцінки площі листя необхідно встановити тип аналізу зображення. 

Якщо ви збираєтесь обчислювати площу кожного листка окремо, можна 

скористатися меню Analyze >Measure. 

 

У такому разі з’явиться наступне діалогове вікно, де в першій колонці 

відображатиметься площа об’єкта у колонці Area: 

 

18. Якщо на одному зображенні представлені кілька об’єктів, оберіть меню Analyse > 
Set Measurements і поставте прапорець навпроти опції Area. Інші опції вимірювань 

повинні залишатися без прапорців. Діалогове вікно закрийте. 

19. Зніміть виділення з листка, активізувавши інструмент «Прямокутник» Rectangle. 

Оберіть меню Analyse > Analyse Particles.  

 

Відкриється діалогове вікно, налаштування якого повинні відповідати зображенню 

нижче: 
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20. Натисніть Ok. Порівняйте результати із отриманими вище: 

 

У верхньому вікні відображатиметься сумарна площа всіх виділених об’єктів на 

зображенні, у нижньому – окремі площі цих об’єктів. Поміркуйте, з яких причин 

результат відрізняється. 

 

21. Для того, щоб виділити інструментом «Чарівна паличка» Wand (tracing) tool усі 

об’єкти одночасно, обирайте кожен листок окремо, утримуючи клавішу Shift. 
Нижче зображено головне та допоміжні робочі вікна програми ImageJ під час 

обчислення сумарної та окремої площі 3 листків одного виду. У вікні «Summary» в 

колонках послідовно вказані кількість об’єктів, їх загальна площа, середня площа, 

а також частка обчисленої площі. 

 

22. Вікна Summary та Results збережіть у вигляді файлів з розширенням *.xls – File > 
Save us… Надалі такі файли можна відкрити програмами MS Exel, Гугл Таблиці або 

Statistica і обробити дані, користуючись інструментами цих програм – обчислити 

середнє, максимальне або мінімальне значення, стандартне відхилення, побудувати 

діаграму частотного розподілу листя за площею. 

23. Користуючись інструкцією, обчисліть окремо площу кожного відсканованого 

листка, а також їх загальну площу. 
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Можливі труднощі 

Під час виконання роботи можуть виникнути певні труднощі. Розглянемо 

найпоширеніші. 

Неадекватні результати вимірювання здебільшого виникають у разі, якщо не 

визначено одиниці вимірювання (див. пункти 8–9) 

 
Індикатор NaN розшифровується як Not-a-Number (нечислове значення) і 

повідомляє про неможливість подальших обчислень. 

 
Щоби розв’язати цю проблему, переконайтеся, що зняли виділення з листка перш 

ніж активувати функцію Analyse Particles (див. п. 19). 

 

Додаткові можливості 

Розроблено чимало плагінів, призначених для вузьких завдань у межах екологічної 

морфометрії. Наприклад, FijiWings застосовується для напівавтоматичного 

контурування жилок крил комах, визначення площі окремих комірок і крила загалом, 

кількості та щільності дрібних структур поверхні. MorphoLibJ – цілий пакет плагінів, 

основаних на методах математичної морфології. Для калібрування й анотування 

вимірювань, отриманих за допомогою мікроскопа, зручно застосовувати плагін 

Measure And Label.   
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Тема 3. Підрахунок кількості особин у зграї птахів 
засобами ImageJ 

Матеріали, обладнання та ПЗ 

фотознімок зграї птахів у польоті, програмний пакет ImageJ 

Сфера використання набутих вмінь і навичок 

Орнітологічні дослідження часто потребують визначення кількості особин у 

популяції. Особливо це актуально для мисливських і мігруючих птахів, птахів-

переносників захворювань, ворон, граків та інших видів, які завдають значної 

сільськогосподарської шкоди. Досліджувати чисельність популяції у видів зі сімейним 

типом гніздування легше. Для великих зграй і колоній підрахунок особин – досить 

складне завдання. З одного боку, рухливість птахів робить їх помітнішими, а отже, їх 

можна охарактеризувати як зручний об’єкт для дослідження. З іншого боку, за 

короткий проміжок часу важко розгледіти, а тим більше підрахувати кількість птахів у 

зграї, яка може налічувати кілька тисяч особин. В таких випадках практикується 

фотографування зграї у польоті на цифровий фотоапарат з подальшим аналізом 

зображення на комп’ютері в камеральних умовах. Аналогічні дослідження актуальні 

для обліку кількості риб у зграї, мікроорганізмів у полі зору, підрахунку голів у стаді. 

Хід роботи 

1. Для підрахунку кількості птахів у зграї в ручному режимі завантажте фотографію 

у робочий простір програми ImageJ: 

 

2. Використайте інструмент Multi-point для виділення кожного птаха на фотографії. 

Для цього двічі клацніть на відповідну кнопку панелі меню: 

 

3. У вікні меню оберіть зручний для вас розмір та колір маркера: 

 

4. На фотографії послідовно відмічайте кожного птаха, поки не будуть відмічені всі. 
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5. Коли роботу буде завершено, збережіть зображення у форматі *.tiff. Якщо роботу 

не завершено і ви збираєтеся продовжити її пізніше, також обов’язково зберегти 

результат роботи саме у цьому форматі. 

 

До звіту із результатами роботи долучіть марковане зображення, 

зазначивши у підписі кількість особин у зграї для вашого фото. 

6. Для автоматичного обчислення необхідно перевести кольоровий знімок у чорно-

білий: 
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7. Викличте меню Image > Adjust > Threshould: 

 

8. Рухайте маркерами прокрутки, поки силуети птахів не стануть червоними: 

 

Для різних зображень положення маркерів прокрутки один відносно одного 

може бути різним. Необхідно орієнтуватися за змінами у вікні зображення. 

9. Отримавши потрібний результат, натисніть кнопку Apply й закрийте діалогове 

вікно. Вікно з перетвореним зображенням має залишатися відкритим. 

10. Оберіть меню Analyse > Analyse Particles. Відкриється діалогове вікно, 

налаштування якого повинні відповідати зображенню нижче: 
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Зверніть увагу на мінімальне значення розміру контуру, який 

враховуватиметься при підрахунку: 5-Infinity (від 5 до безкінечності). 

11. Аналізатор опрацював зображення. Оскільки було обрано опцію Outline, програма 

автоматично розпізнала, навела і пронумерувала контури птахів: 

 

Поруч із вікном опрацьованого зображення на екран виведено інформаційні вікна 

Summary і Results. У наведеному досліді ми ігноруємо інформацію, наведену у вікні 

Results, адже не визначали шкалу, відносно якої буде вимірюватися площа об’єктів. 

Програма автоматично обчислила її у пікселях, що у нашому разі неінформативно. 

Кількість силуетів птахів на зображенні за обчисленням ImageJ становить 297 особин, 

а їхня сумарна проєкція на тлі неба складає 10,2 % від загальної площі знімка: 

 
При застосуванні алгоритму Analyse Particles для аналізу зображень зі шкалами, 

наприклад, цифрових знімків мікроорганізмів, хлоропластів у складі клітини, особин 

дрібних членистоногих тощо, може бути обчислена й доволі точна площа об’єктів. Тоді 

інформація у вікні Results виявиться інформативною і корисною. 

12. Вікно Summary збережіть у вигляді файлу з розширенням *.csv – File > Save us… 

13. Порівняйте результати, отримані після ручної і автоматичної обробок 

фотографії. Чи збігаються значення? Який із методів вважаєте кращим? Чому? 
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Відповіді на запитання, а також числові значення надішліть разом із зображенням у 

форматі *.tiff (для ручного режиму обробки) і файлом у форматі *.csv 

(для автоматичного режиму обробки). 

Можливі труднощі 

При ручному опрацюванні фотознімків кінцевий результат залежить від уважності 

і старанності оператора. Об’єкти на зображенні можуть перекриватися (рис. а), 

візуально їх неважко розпізнати і відмітити як окремі особини (рис. b) При 

автоматичному ж контуруванні вони розпізнаються як злитий об’єкт (рис. c, d). Якщо 

точність обрахунків має важливе значення для дослідження, перед запуском функції 

Analyse Particles можна попередньо опрацювати області злиття, вручну розділивши 

контури на зображенні (рис. e). У кінцевому результаті кожен об’єкт буде відмічений 

при автообчисленні окремо (рис. f). 
 

 

Для об’єктів зі складними контурами лінії для відокремлення можна провести, 

скориставшись інструментом Pencil (олівець), попередньо обравши піпеткою колір тла (на 

наведеному зразку – чорний). Якщо ж програма випадково розділила один об’єкт на кілька 

частин, об’єднати їх можна, обравши колір силуету (на наведеному зразку – білий). 

 
Для об’єктів із простим контуром, наприклад клітин дріжджів, можна 

скористатися функцією автоматичного розділення об’єднаних об’єктів Process > Binary 
> Watershed: 
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Тема 4. Визначення вмісту хлорофілу у листі 
неінвазійним методом за RGB-спектром 

Матеріали, обладнання та ПЗ 

листкові пластинки рослин, чорний однорідний папір або картон, цифрова 

фотокамера, програмний пакет ImageJ 

Сфера використання набутих вмінь і навичок 

Зміна вмісту пігментів у листі – інформативна тест-ознака стресових станів рослин 

у відповідь на зміну параметрів навколишнього середовища. Здебільшого полютанти 

після проникнення всередину рослинної клітини акумулюються у хлоропластах, 

змінюючи їхню структуру. Рослина реагує на стрес підвищенням активності ферменту 

хлорофілази, який знижує інтенсивність фотосинтезу через руйнування хлорофіл-

білково-ліпідного комплексу фотосинтетичного апарату. 

Відомо, що вміст пігментів чутливо реагує на сезонні зміни. Зростання в 

несприятливих умовах також призводить до зменшення загального вмісту хлорофілу в 

клітинах рослин. Наприклад, надлишок важких металів (Cu, Co, Zn, Сd, Мn, Ni) у 

субстраті зумовлює зниження рівня хлорофілу до 10–15 %. Подібний ефект має й 

дисбаланс між загальним Карбоном і Нітрогеном у рослині. Співвідношення 

хлорофілів а : b у фотосинтетичних клітинах також розглядають як маркер 

фітотоксичного впливу. За нормальних умов цей показник коливається у межах від 2 

до 5. Варіювання у бік зменшення пропорції розцінюють як неспецифічну реакцію на 

зміни у водному і температурному режимах, засоленість ґрунтів, інтоксикацію 

важкими металами, дію УФ-випромінювання, нестачу поживних елементів. 

Численними дослідженнями доведено зменшення співвідношення хлорофілів а : b в 

умовах техногенного навантаження, зокрема за наявності аерополютантів. 

Точна кількісна оцінка концентрації пігментів в рослинних тканинах проводиться 

трудомісткими лабораторними методами. Разом з тим існує можливість досить 

точного визначення кількості фотосинтетичних пігментів за допомогою спектрального 

аналізу цифрових знімків зелених частин рослин. Ці методи належать до неінвазійних 

(недеструктивних) і дають змогу проводити велику кількість аналізів за короткий 

проміжок часу або відстежувати динаміку пігментного складу в реальному часі. 

Хід роботи 

1. Сфотографуйте щойно зірваний листок на чорному фоні за допомогою цифрової 

фотокамери із фіксованою світлочутливістю ISO 100, роздільною здатністю 

4096×3072 з відстані ~ 10 см. Якщо немає можливості зробити знімок зразу, 

допускається інтервал між зриванням листка і моментом фотографування не більше 

30 хв. Можна скористатися сканером з чорною підкладкою. 

2. Отримане зображення завантажте на жорсткий диск комп’ютера і відкрийте за 

допомогою ImageJ. 
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3. Скориставшись інструментом Polygon selections, виділіть фігуру по периметру 

листка максимально близько до краю, але так, щоби не захопити чорні пікселі 

з фону: 

 

4. Викличте меню Analyze > Color Histogram:  

 

Ця процедура виведе результати обчислення середнього значення (mean) і 

стандартного відхилення (std.dev) для кожного колірного каналу колірної моделі RGB. 

Зазначені величини відображені внизу отриманої гістограми, а також у вікні 

результатів, яке з’являється разом із гістограмою. 
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5. Вікно Results збережіть у вигляді файлів з розширенням *.csv – File > Save us… 
6. Вміст пігментів в аналізованому листку обчисліть за формулами: 

𝐶хл.𝑎 = |0,50 + 0,27𝑙𝑛 (
𝐺−𝐵

𝐺+𝐵
) + 0,01|; 

𝐶хл.𝑏 = |0,11 − 0,01(𝐺 − 𝐵) − 0.04(𝐺 − 𝐵)2 − 0,02(𝐺 − 𝐵)3|; 

7. Обчисліть співвідношення хлорофілів а : b. 

8. На основі отриманих даних зробіть висновки про стан листя та умови, в яких 

зростає аналізована рослина. 

Додаткові можливості 

Практична робота має на меті, насамперед, ознайомити з можливостями програми. 

Для серйозних наукових досліджень необхідно враховувати видові особливості 

рослинних об’єктів та провести попередню серію калібрувальних випробувань.  

Світова наукова спільнота щороку публікує доопрацьовані та модифіковані 

формули для обчислень вмісту хлорофілу у листі на основі аналізу колірних каналів у 

середовищі ImageJ. Зокрема, за результатами тестування на трьох видах рослин 

Ali et al. (2012) рекомендують використовувати уніфіковану формулу визначення 

загального вмісту хлорофілу: 

𝐶ℎ𝑂𝐿 = 𝑙𝑜𝑔𝑠𝑖𝑔 (
𝐺 −

𝑅
3 −

𝐵
3

255
) 

Застосовану сигмоїдальну функцію logsig можна обчислити у пакеті R або 

здійснити перетворення для опрацювання у MS Excel: 

𝑙𝑜𝑔𝑠𝑖𝑔(𝑛)  =  1 / (1 +  𝑒𝑥𝑝(−𝑛))  
Отже, кінцеве рівняння матиме вигляд: 

𝐶ℎ𝑂𝐿 =  1

(1 +  𝑒𝑥𝑝(− (
𝐺−

𝑅

3
−

𝐵

3

255
)))⁄
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Тема 5. Оцінка зімкнутості лісового намету засобами 
ImageJ 

Матеріали, обладнання та ПЗ 

цифрові знімки крон дерев на фоні неба, програмний пакет ImageJ 

Теоретичні відомості і сфера застосування 

Під зімкнутістю лісового намету розуміють частку сумарної площі 

горизонтальних проєкцій крон дерев відносно загальної площі ділянки. Від зімкнутості 

деревних крон у лісових екосистемах залежать світлопроникність намету та його 

мікрокліматичні умови, що впливає на формування нижніх ярусів і живого наземного 

покриву. Розвиток деревного ярусу зумовлює динамічність намету деревостану. Із 

ростом дерев спостерігається зниження світлопроникності до 8–10 %, відбувається 

сукцесія за переважної участі лісових тіневитривалих видів рослин. І, навпаки, 

відмирання старих і пошкоджених дерев знижує зімкнутість лісового намету, у ньому 

формуються природні вікна. У масивах з переважанням широколистяних деревних 

порід вікна в наметі деревостану відіграють вирішальну роль для його відновлення, 

оскільки світловий фактор життєво необхідний для розвитку деревного підросту. 

Отже, оцінка ступеня зімкнутості крон дерев у насадженні надає інформацію про 

повноту намету, оскільки зазвичай ці показники тісно корелюють між собою. Крім 

цього, характер намету деревостану відображає його стан та фазу розвитку. За 

кордоном розповсюджений фенологічний моніторинг деревного намету протягом 

усього року. Особливе зацікавлення у науковців викликає дослідження характеру 

намету природних і старовікових деревостанів, оскільки формування таких насаджень 

відбувається тільки під впливом природних факторів. Вивчення таких насаджень може 

дати важливу інформацію для планування заходів раціонального 

природокористування у деревних насадженнях, наближеного до природних умов. 

Хід роботи 

1. Сфотографуйте крони дерев на фоні неба на цифрову камеру з високою роздільною 

здатністю. 

Найкращі зображення можна отримати в безхмарну погоду: бажано, щоби 

фон був однорідним. Намагайтеся також уникати сонячних відблисків, які 

можуть спотворювати цифрові дані. 

2. Отримане зображення завантажте на жорсткий диск комп’ютера із розширенням 

*.jpg і відкрийте за допомогою ImageJ. 

 

3. Готове до роботи зображення виглядає так: 
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4. Викличте меню Process > Binary > Make Binary: 

 

5. У результаті зображення відображатиметься в контрастному двійковому чорно-

білому вигляді. Небо може бути як чорним, так і білим. Необхідно це враховувати 

при подальшій обробці зображення. 
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6. Викличте меню Analyze > Histogram:  

 

7. У вікні оберіть опцію List: 

 

8. Якщо небо відображається в білому кольорі, а крони – в чорному, як зображено в 

даному прикладі, необхідно враховувати значення навпроти value = 0: 

 

Якщо небо відображається в чорному кольорі, а крони – в білому, необхідно 

враховувати значення навпроти value = 255. 
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9. Отримані результати збережіть у вигляді окремого файлу з розширенням *.csv – File 
> Save us… 

10. Для того, щоби обчислити відсоток зімкнутості лісового намету (% ЗЛН), 

необхідно поділити кількість чорних (або білих) пікселів на загальну кількість 

пікселів та помножити отримане значення на 100 %: 

 

% ЗЛН =  
321518

667000
∙ 100 % = 48 %  

Альтернативний спосіб: після переведення зображення у бінарний формат 

натисніть на клавіатурі М латиницею. Розділіть значення Mean на значення Max. 

Відніміть отриманий результат від одиниці та помножте на 100 %: 

 

% ЗЛН = (1 −
132,081

255
) ∙ 100 % = 48 % 

Додаткові можливості 

Для опрацювання великих масивів цифрових зображень лісового намету можна 

скористатися макросом Hemispherical_2.0. У першій редакції макрос розроблений для 

роботи зі сферичними панорамами, які можна 

отримати, наприклад, на камеру смартфона за 

допомогою спеціалізованих додатків. У другій 

редакції макроса реалізована можливість 

обробки прямокутних цифрових зображень. Для 

цього, відмічаючи ROI, необхідно переключити 

режим «овальне виділення» на режим 

«прямокутне виділення». Форма виділення не 

впливає на подальші операції зі зображенням. 

Окрім автоматичної бінаризації знімків, 

алгоритм макроса опрацьовує інформацію щодо 

вікон у наметі: їхню кількість, площу і фракцію.  
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Тема 6. Запис користувацького макроса ImageJ 

Матеріали, обладнання та ПЗ 

програмний пакет ImageJ, цифрові знімки бджолиного обніжжя або насіння, цифрові 

знімки крон дерев на фоні неба з попередньої роботи 

Теоретичні відомості і сфера застосування 

Зазвичай екологічні наукові дослідження передбачають роботу з великим масивом 

однотипових цифрових зображень. Наприклад, біотестування токсичності певних речовин 

потребує аналізу серії розведень. Для отримання статистично значущих результатів кожне 

розведення тестується щонайменше у трьох повторах. Кожен повтор нараховує від 10 

екземплярів тест-об’єкта. Отже, простий дослід з екотоксикології може потребувати 

обробки 50 і більше фотознімків. Алгоритм їхнього аналізу від знімка до знімка залишається 

незмінним. Для швидкого опрацювання таких даних доцільно автоматизувати 

послідовність кроків, необхідних для отримання результату. 

Навіть не маючи досвіду програмування користувач ImageJ може створити власний 

макрос або вдосконалити існуючий за допомогою інтерактивного інструмента Record. Він 

фіксує кожен крок у послідовності дій оператора і відображає його у вигляді відповідної 

команди мовою програмування IJM. Усі попередні практичні роботи можуть бути 

повністю або частково записані і збережені у вигляді макросів. Елементарні навички 

автоматизації роботи з цифровими зображеннями стануть у пригоді при виконанні 

магістерських проєктів, а також у майбутній професійній діяльності. 

Хід роботи 

Спосіб І. Автоматичний запис макроса 

1.  Підготуйте серію з 3–5 однотипових цифрових зображень з дискретними об’єктами 

на контрастному фоні. Це можуть бути фотознімки бджолиного обніжжя, як у 

наведеному зразку, дрібного насіння рослин, пилкових зерен під мікроскопом або 

зграя птахів, як у Темі 3 практичного блоку. 

Чим кращої якості будуть знімки, тим кращий результат ви отримаєте. 

Неоднорідне освітлення, строкатий фон, зайві предмети у кадрі 

призведуть до некоректної роботи записаного макроса. 

2. Відкрийте зображення, за допомогою якого створюватимете макрос будь-яким 

зручним способом. 

3. Активізуйте опцію Record з меню Plugins: 
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4. Результат виглядатиме так: 

 
5. Послідовно виконуйте пункти 6–11 Теми 3 з практичного блоку і спостерігайте за 

відповідними змінами у вікні Recorder. 
Переведення зображення у 8-бітний формат 

 
Застосування функції Threshould 

 
Автоматичне розділення об’єднаних об’єктів Process > Binary > Watershed  
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Застосування функції Analyse Particles 

 
6. Усі зайві вікна можна закрити, залишивши тільки вікно Recorder. Результати 

вимірювань і зображення з нанесеними масками можна не зберігати. 

7. Зверніть увагу на надлишкові елементи коду, які з’явилися у процесі закриття 

зайвих вікон, а також при переключенні з одного вікна на інше. Вони 

перешкоджатимуть коректній роботі плагіна, тому їх необхідно видалити вручну. 

 

Будьте уважні! Не видаліть випадково сусідні рядки. Порядок надлишкових 

команд у вашому випадку може відрізнятися від наведеного на скріншоті. 

8. Коли надлишковий код буде вилучено, дайте назву згенерованому макросу у полі 

Name. Бажано у назві використовувати літери латинського алфавіту. Наприклад, 

Bee_Pollen_Count.ijm. Якщо все виконано правильно, натисніть кнопку Create. 
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9. Згенерований код відобразиться у вікні менеджера макросів. Для зручності зміст 

буде представлений у кольорі. Щоби перевірити наявність механічних помилок, 

натисніть кнопку Show Errors. 

 
10. У разі, якщо знайдено помилки і ви розумієте, як їх виправити, внесіть корективи у 

код із клавіатури. Деякі з можливих помилок ми розглянемо нижче. Якщо 

виправити код самостійно не вдається, вимкніть всі вікна і повторіть усю 

послідовність процедур.  

11. Перевірте, чи макрос коректно працює. Для цього повторно відкрийте необроблене 

зображення у програмі ImageJ і натисніть кнопку Run. Якщо все виконано 

правильно, послідовність процедур, задана у макросі, буде виконана автоматично 

майже миттєво (залежно від швидкості пристрою). 

12. Якщо помилок немає, збережіть створений макрос у папці macros. 

 



 91 

13. Перевірте, чи макрос працює коректно на інших зображеннях з цієї ж серії. 

14. Завантажте у програму фотографію зі зграєю птахів, яку ви використовували при 

виконанні практичної роботи з Теми 3. Запустіть макрос, переконайтеся, що він 

працює не тільки для зображень об’єкта, обраного як прототип. 

Спосіб ІІ. Запис макроса з користувацькими налаштуваннями 

1. Підготуйте серію з 3–5 однотипових цифрових зображень із кронами дерев на фоні 

неба, як у Темі 5 практичного блоку. 

2. Відкрийте зображення, за допомогою якого створюватимете макрос, будь-яким 

зручним способом. 

3. Активізуйте опцію Record за допомогою кнопки розробника в панелі інструментів: 

 
4. Виконайте пункт 4 Теми 5 з практичного блоку: перетворіть повноколірне 

зображення на бінарне. Спостерігайте за змінами у вікні Recorder. За умови 

правильного виконання послідовності дій, код виглядатиме так: 

 
setOption("BlackBackground", true); 
run("Convert to Mask"); 

 

5. Перш ніж перейти до наступного кроку, необхідно налаштувати набір показників, 

які відображатимуться у таблиці Measurements. Для цього викличте меню Analyze 
> Set Measurements: 

 
6. У вікні налаштувань оберіть лише потрібні для подальших обчислень опції: Mean 

gray value і Min & max gray value: 

 
Переконайтеся, що до коду у вікні Recorder додалася команда: 

 
run("Set Measurements...", "mean min add redirect=None decimal=3"); 

 

Якщо команда у вашому вікні відрізняється, відредагуйте її у ручному режимі. 
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7. Далі скористайтеся спрощеним альтернативним способом, запропонованим 

наприкінці Теми 5: клавішею М викличте меню Measure. При цьому до коду у вікні 

додасться рядок: 

 
run("Measure"); 

 

А кінцевий результат обчислень виглядатиме так: 

 
8. На цьому процедура автозапису макроса завершена. Переконайтеся, що код не 

містить зайвих команд, наприклад, відкривання чи закриття вікон. Макрос повинен 

складатися лише з чотирьох рядків команд: 

 

setOption("BlackBackground", true); 
run("Convert to Mask"); 
run("Set Measurements...", "mean min add redirect=None decimal=3"); 
run("Measure"); 

 

9. Перейдіть у режим менеджера макросів, скориставшись кнопкою Create. 

Попередньо дайте назву створеному макросу, наприклад Canopy. 

 
10. Новостворений макрос відкриється у менеджері макросів, в якому ми доповнимо 

наявний код. Вікно Recorder вже не знадобиться, його можна закрити. 

 
11. Закрийте всі зайві вікна у програмі ImageJ, залишивши активним тільки менеджер 

макросів.  
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12. Переконайтеся, що макрос працює. Для цього повторно завантажте вихідне 

зображення і скористайтеся кнопкою Run у вікні менеджера. 

13. Альтернативний метод обчислення зімкнутості лісового намету у Темі 5 містить 

формулу: 

% ЗЛН = (1 −
𝑀𝑒𝑎𝑛

𝑀𝑎𝑥
) ∙ 100 % 

Для її автоматизованого обчислення необхідно записати цю формулу у вигляді коду. 

Щоб це зробити, розіб’ємо її на три дії: ділення (1), віднімання (2) і множення (3): 

 
14. Перш ніж записати першу дію, необхідно дати визначення її компонентам. Для 

цього потрібно вказати, звідки макрос повинен підтягнути значення для змінної 

Mean. Мовою програмування ImageJ Macro для цього передбачена команда 

getResult("Column", row). У режимі конструктора, коли користувач починає 

набирати команду, менеджер підтягує всі можливі команди, які починаються 

подібним способом. Для кожної команди наводиться пояснення: 

 
З підказки зрозуміло, що у змінній "Column"потрібно замінити аргумент на назву 

відповідної колонки; у нашому випадку – "Mean", а у змінній row вказати номер ряду, 

для якого здійснюватимуться обчислення. При цьому рекомендовано вказувати 

значення 0 для того, щоб автоматично обчислювалися всі ряди таблиці. Отже, у 

нашому випадку змінна mean визначається так: 

 
mean=getResult("Mean", 0); 
 

Для того, щоби переконатися, що написаний код працює правильно, можна додати 

перевірочну функцію print, яка виводить значення змінної mean у окреме вікно Log. 

Блок написаного коду у такому разі матиме наступний вигляд. 
 
mean=getResult("Mean", 0); 
print(mean); 

 

15. Вимкніть усі зайві вікна, залишивши тільки основне вікно програми ImageJ і вікно 

менеджера. Завантажте вихідне зображення і натисніть кнопку Run, щоби 

впевнитися, що код працює. У результаті зображення повинне бінаризуватися, а 

результати відображатися у вигляді двох вікон: Results зі середнім, мінімальним і 
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максимальними значеннями, а також Log – зі середнім значенням, яке має 

дорівнювати показнику Mean у вікні Results: 

 
16. У такий самий спосіб додайте до коду визначення змінної Max і налаштуйте її 

виведення у вікні Log. За умови правильного виконання, вікно Log міститиме два 

значення, які дублюватимуть дані таблиці у вікні Results: 

 
17. До визначених змінних можна застосовувати арифметичні дії. Позначимо частку 

змінною ratio та визначимо її через арифметичний вираз. Результат обчислення 

виведемо у вікно Log: 

 
ratio=mean/max 
print(ratio); 

 

18. Аналогічно кодуємо змінну другої дії: 

 

difference=1-ratio 
print(difference); 

 

19. Змінній остаточної, третьої дії можна дати назву показника. Наприклад, canopy: 

 

canopy=difference*100 

 

Для виведення кінцевого результату у вікні Log можна, як і в попередніх випадках,  
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скористатися скриптом print(canopy), тоді результат відобразиться числовим значенням. 

Проте для зручності користування макросом можна додати до числового значення 

текстове пояснення і знак відсотка. При цьому у синтаксисі ImageJ Macro текстовий 

формат позначається лапками, тоді як числовий – без лапок. Для додавання текстової 

частини результату до числової використовуйте знак + : 

 
print("Your result:"+canopy+"%") 

 

У кінцевому результаті вікно Log міститиме результати проміжних обчислень і 

кінцевий результат у встановленому форматі: 

 
20. Отже, ми переконалися, що макрос працює правильно. Можна відредагувати 

надлишковий код, прибравши зайві проміжні результати. Відредагований макрос 

виглядатиме так: 

 
 

21. Закрийте усі зайві вікна, завантажте повторно вхідне зображення і запустіть макрос 

кнопкою Run. Якщо все виконано правильно, кінцевий результат виглядатиме так: 
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22. Збережіть готовий макрос, як показано у пункті 12 попереднього способу. 

23. Перевірте, чи макрос працює коректно на інших зображеннях з цієї ж серії. 

Можливі труднощі 

Під час роботи з макросами нерідко виникають труднощі. Здебільшого вони 

стосуються помилок синтаксису мови ImageJ Macro. У такому разі спливає вікно Macro 
Error з описом помилки. У наведеному зразку пропущено лапки у команді 

run("Measure"). У вікні редактора команду підсвічено кольором, це полегшує 

розуміння, де саме потрібно шукати помилку: 

 

 

Додаткові можливості 

У результаті виконаної роботи, ви самостійно створили два макроси: простий із 

автозгенерованою послідовністю дій і ускладнений із додаванням власного коду. За 

цим принципом можна автоматизувати і вдосконалити практично будь-який дослідний 

алгоритм обробки й аналізу цифрових зображень. Проте окремі операції, наприклад 

виділення об’єктів зі складним контуром, доведеться виконувати в ручному режимі. 

Розібратися зі структурою певних команд і синтаксисом ImageJ Macro 

допомагають так звані шпаргалки, які можна знайти, задавши у пошуковику браузера 

запит imagej cheat sheets. Великий вклад у створення таких шпаргалок зробив 

фахівець з біоіміджингу Дрезденського технічного університету dr. Robert Haase. 
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Тема 7. Колірний аналіз в екологічних дослідженнях 

Матеріали, обладнання та ПЗ 

листки декоративно-листяних рослин, білий папір, сканер з високою роздільною 

здатністю або цифрова фотокамера, кольорові цифрові зображення метеликів 

високої роздільної здатності, програмний пакет ImageJ, плагін Color Inspector 3D 

Теоретичні відомості і сфера застосування 

Базові поняття колористики використовуються науковцями для проведення 

порівняльного якісного аналізу забарвлення живих об’єктів. Наприклад, якісні 

відмінності за ознакою забарвлення використовуються генетиками при дослідженні 

закономірностей спадковості і мінливості. Класичним прикладом є досліди Г. Менделя 

із горохом. Окрім того, широко відомими стали роботи з аналізу пігментної строкатості 

у квіткових рослин, забарвлення очей у дрозофіл, черепашок молюсків тощо. Отже, 

колірний аналіз в екології може використовуватися для аналізу стану, динаміки й 

еволюції природних популяцій.  

Часто забарвлення має пристосувальний характер і може відрізнятися в окремих 

особин або в місцевих елементарних популяціях залежно від особливостей оточуючого 

середовища. Це явище добре ілюструє класичний приклад індустріального меланізму 

в популяціях березового п’ядуна. З іншого боку, зміна забарвлення може свідчити про 

погіршення якості середовища існування: хлорози, некрози, утворення бурих та 

червоних плям (наприклад, на листі смородини за дії SO2) тощо. Отже, у біоіндикації 

та в біотестуванні колірний аналіз також знаходить застосування при дослідженні 

реакції фенотипово пластичних видів на вплив різних подразників. 

Забарвлення відіграє важливу роль у формуванні міжвидових зв’язків в 

екосистемах. Зокрема, запилювачі часто віддають перевагу квіткам в окремому 

колірному діапазоні, формуючи таким чином вузькі екологічні ніші. Встановлено, що з 

метою репродуктивної ізоляції два види флокса Рhlox drummondii и P. cuspidata при 

зростанні поруч формують квітки темно-рожевого та ясно-блакитного кольорів, 

приваблюючи різних метеликів. Коли ж ці два види зростають на різних територіях, вони 

продукують кожен ясно-блакитні квіти, оскільки ризику перехресного запилення немає. 

Цей напрямок в екології ще мало досліджений, тому вартий уваги і може реалізовуватися 

за допомогою сучасних засобів колірного аналізу цифрових зображень. 

На екосистемному рівні останніми роками дедалі частіше використовується 

колірний аналіз стану зелених насаджень, а також ґрунтового покриву за допомогою 

ряду вегетаційних та ґрунтових індексів (наприклад, NDVI, SAVI).  

Хід роботи 

1. Перевірте, чи вбудовано у вашу версію ImageJ плагін Color Inspector 3D. У 

нормальній комплектації він має бути вбудованим. 
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2. Якщо плагіна немає у переліку, завантажте його за посиланням 

https://imagej.nih.gov/ij/plugins/color-inspector.html. Потрібний файл називається 

Color_Inspector_3D.jar. Розмістіть завантажений файл у папці plugins, яка 

знаходиться у вашій папці fiji-win64 > Fiji.app. 

3. На робочій панелі ImageJ оберіть меню Plugins > Install Plugin 

 
4. Відкриється вікно вибору файлів, у ньому знайдіть файл плагіна 

Interactive_3D_Surface_Plot.jar за директивою: fiji-win64 > Fiji.app > plugins. 

 
Дослід І. Аналіз клональної мінливості 

Залежно від особливостей будови тіла організми поділяють на унітарні і 

модулярні. Будова унітарних організмів, як правило, визначається генетично. У 

модулярних організмів із зиготи утворюється певна одиниця будови (модуль), із якої 

розвиваються нові модулі, подібні до першого. На відміну від унітарних, окремі 

модулярні організми складаються із наборів головних конструктивних елементів, 

кількість яких дуже мінлива, а розвиток модулярних організмів залежить від їхньої 

взаємодії з оточуючим середовищем. 

Рослини здебільшого належать до модулярних організмів. Головний 

конструктивний модуль, який визначає характер росту надземних частин вищої 

рослини, – це листок із прилеглою ділянкою стебла – міжвузлям. Розвиток і 

проростання бруньки зумовлює появу нових листків, які, своєю чергою, мають власну 

пазушну (піхвову) бруньку. Ріст рослин полягає у накопиченні таких модулів. Дерева 

характеризуються кількома рівнями модулярності. Першому рівню відповідає листок, 

другому – пагін, третьому – система гілок. 

Нащадки однієї зиготи, яка складається із певної кількості модулів називається 

клоном. Сукупність модулів становить генет, або генетичний індивідуум – сукупність 

клональних модулів, отриманих з однієї зиготи. При дослідженні популяційних 

характеристик модулярних організмів потрібно враховувати не лише кількість генет, 

але й модулів у їхньому складі. Тому модулярні організми варто вивчати на двох 

взаємодіючих рівнях. 

https://imagej.nih.gov/ij/plugins/color-inspector.html
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Індивідуальною мінливістю характеризуються й унітарні організми, однак у 

модулярних організмів можливість прояву індивідуальної мінливості значно ширша. 

Отже, клональна мінливість – це мінливість модулів у межах одного генету під 

впливом факторів середовища. 

 

1. Відберіть кілька листків з однієї строкатої рослини (наприклад, фікуса 

Бенджаміна, конюшини білої, бегонії королівської, пеларгонії садової тощо). 

Відскануйте свіжозрізані листки на фоні білого паперу із роздільною здатністю не 

менше 200 dpi і збережіть зображення у форматі *.jpg. 

2.  Відкрийте зображення. Скориставшись інструментом Polygon selections, виділіть 

один із листків. Намагайтеся виділяти якнайближче до контуру, щоби не захопити 

білі пікселі фону, які значно знизять об’єктивність результатів. 

 

https://zelenvsit.cx.ua/wp-content/uploads/2018/3/nzm-354.jpg
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3. Викличте меню Plugins > Color Inspector 3D: 

 
4. У вікні, яке відкрилося, у меню Color Space встановіть значення RGB, а в меню 

Display Mode оберіть Histogram. Повзунком Number of Color Cells можна об’єднати 

дрібні кольорові кулі за відтінками в більші групи. Проте прокручувати повзунок 

вліво до мінімуму не рекомендується, оскільки це дуже спростить кольорову гаму 

і втратиться різниця між близькими за часом фотографування знімками. Як і не 

варто занадто подрібнювати кулі, оскільки візуально вони скупчуються і важко 

оцінити зміни. 

 

5. Якщо навести курсор на будь-яку ділянку листка, на діаграмі відобразиться 

відсоток обраного кольору. Його не можна зберегти автоматично, але можна 

записати для 3–5 найоб’ємніших куль. 

6. Порівняйте інформативність відображення результатів у різних системах кольорів 

у меню Color Space та різні види відображення у меню Display Mode. Збережіть 

найвдаліші, на вашу думку, у вигляді файлу з розширенням *.tif за допомогою меню 

File > Save Visualization. 
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7. Порівняйте між собою візуальні зміни кольорової гами на серії об’ємних фігур, 

побудованих для різних листків. Порівняйте внесок того чи іншого відтінку в їх 

кольорову гаму. 
 

 

Для того, щоби дізнатися частку певного відтінку у колірній гамі зображення, 

наведіть курсор на нього на знімку зліва. Справа з’явиться значок хреста на відповідній 

кулі. Водночас на інформаційній панелі вікна відобразиться інформація щодо кількості 

пікселів відміченого відтінку, його код у колірному просторі RGB, а також частота 

його трапляння на зображенні Frequency: 

 
Натисканням на кнопку LUT викликається окреме вікно, яке містить інформацію 

про усі наявні в ROI відтінки: 

 
8. Зробіть висновки на основі отриманих результатів та теоретичних відомостей, 

поданих вище. 
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Дослід ІІ. Аналіз статевого диморфізму лускокрилих 

1. Знайдіть в Інтернеті якісне зображення самки і самця метеликів, яким притаманний 

статевий диморфізм. 

 

2. За допомогою плагіна Color Inspector 3D проведіть колористичний аналіз 

різностатевих особин. 

Увага! При виділенні контурів враховуйте лише крила. 

 

3. У вікні, що відкрилося, в меню Color Space встановіть значення RGB, а в меню 

Display Mode оберіть Median Cut. Таким чином ви отримаєте градієнт відтінків, які 

легше порівнювати. 

 

4. На основі двох отриманих колірних спектрів зробіть висновки. 

  

https://dic.academic.ru/pictures/wiki/files/80/Parnassius_arcticus_M%2BF.jpg
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Тема 8. Побудова просторових полігонів за допомогою 
плагіна Interactive 3D Surface Plot 

Матеріали, обладнання та ПЗ 

цифрове зображення мікробоценозу в чашці Петрі, цифрове зображення нафтової 

плівки на воді, супутниковий знімок певної території, програмний пакет ImageJ, плагін 

Interactive 3D Surface Plot 

Теоретичні відомості і сфера застосування 

Часто результати екологічних досліджень потребують зрозумілої та 

репрезентативної візуалізації. Для цього існує багато спеціалізованих програмних 

пакетів, а також способів візуалізації в широковживаних універсальних графічних 

редакторах. Проте їх використання викликає чимало труднощів. Зокрема, 

картографування різних біологічних систем зазвичай забирає багато часу, зусиль і 

потребує спеціальних знань. Для побудови ортогональних полігонів у MathCad, 

Statistica та інших програмних пакетів необхідно мати масив вхідних даних та 

математичну модель, яка допоможе зобразити ці дані в графічно-логічному вигляді.  

Засобами ImageJ можна автоматично будувати просторові полігони об’єктів і 

територій, які легко інтерпретувати й описувати при аналізі результатів, на основі 

цифрових фото-, аеро- або космознімків високої роздільної здатності. Зокрема, плагін 

Interactive 3D Surface Plot дає змогу деталізувати й аналізувати неоднорідність 

поверхні та зміну інтенсивності забарвлення різних дискретних об’єктів, різницю 

висот рельєфів, рослинного покриву, різницю глибин водних об’єктів, масштаби 

забруднення води і ґрунту нафтою, інтенсивність ураження сільськогосподарського 

угіддя хворобами чи бур’янами тощо. 

Цей плагін створює інтерактивні графіки поверхні з усіх видів зображень. 

Яскравість кожного пікселя на зображенні інтерпретується як висота. Модифіковане 

зображення можна переглядати у різних колірних схем. Для форматування об’ємної 

моделі доступні функції масштабування, повороту, зміни кутів перспективи. 

Використання опції згладжування дає змогу знизити шуми.  

Хід роботи 

1. Підготуйте заздалегідь цифрове зображення чашки Петрі з колоніями 

мікроорганізмів високої роздільної здатності та завантажте його на комп’ютер. 

2. Завантажте плагін Interactive 3D Surface Plot за посиланням 

http://imagej.net/plugins/surface-plot-3d.html (необхідно завантажити файл  

Interactive_3D_Surface_Plot.jar). 

3. Розмістіть завантажений файл у папці plugins та проведіть усі маніпуляції з 

інсталювання плагіна аналогічно до попередніх робіт (наприклад, пункти 2–4 Теми 7). 

4.  Після перезавантаження програми у меню Plugins з’явиться об’єкт Interactive 3D 
Surface Plot: 
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5. Відкрийте цифрове зображення чашки Петрі у програмі ImageJ будь-яким зручним 

способом. 

6. Скориставшись опцією Oval, встановіть межі аналізованого об’єкта. 

 

7. Скориставшись меню Plugins, запустіть плагін Interactive 3D Surface Plot. 
8. У вікні, яке з’явилося, спробуйте змінити налаштування. Спостерігайте за змінами, 

котрі відбуваються. Коли зрозумієте, яка функція за які зміни відповідає, оберіть 

режим Filled і кольорову гаму Spectrum LUT. Знайдіть найкращий кут перегляду, 

величину та пропорції осей x, y i z. Нижче наведено приклад інформативного 

зображення: 

 

9. Проаналізуйте отримане зображення. Яким кольором зображені найбільші висоти, 

яким – найменші? Які висновки можна зробити про параметри різних колоній? Чи 

інформативне ваше зображення? Чому? 
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10. На сайті Google Maps оберіть будь-яку територію в режимі супутникового 

перегляду. Збережіть його собі на жорсткий диск комп’ютера у форматі *.jpg. 

Приклад такого зображення наведено нижче. 

 

11. Відкрийте його за допомогою ImageJ та запустіть плагін Interactive 3D Surface Plot. 
У вікні, яке з’явилося, спробуйте змінити налаштування. Спостерігайте за змінами, 

котрі відбуваються. 

12. Оберіть режим Isolines та контрастний колірний режим. 

13. Оберіть контрастний до ізоліній фон, скориставшись опцією Background. 

14. Поекспериментуйте зі значеннями максимуму і мінімуму. Що, на вашу думку, вони 

відображають? За яких показників рисунок стане інформативнішим? Чому? 

15. На наступному прикладі представлено інформативне зображення, яке ілюструє 

особливості ландшафту обраної території. Він містить інформацію лише про 

рельєф антропогенно трансформованих територій. 

 

16. Збережіть собі на жорсткий диск комп’ютера зображення води із нафтовими 

плямами. 

 

https://www.innovationnewsnetwork.com/wp-content/uploads/2021/03/Oil-spills-696x392.jpg
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17. Відкрийте його за допомогою ImageJ та запустіть плагін Interactive 3D Surface Plot. 
18. Оберіть режим Filled та колірний простір Original Colors. Нижче зображено два 

варіанти інтерпретації одного й того ж полігону. Який, на вашу думку, 

найінформативний? Чому? Про що він свідчить? 

 

 

Можливі труднощі 

Після встановлення плагін може не відображатися у меню Plugins. Спробуйте 

перезавантажити програму. Якщо проблема збереглася, спробуйте перезавантажити 

операційну систему. Якщо проблему не вдалося розв’язати, завантажте плагін за 

посиланням у пункті 2 і замініть старий файл на новий у папці plugins. Заміну файлу 

рекомендовано здійснити й у разі, якщо плагін працює некоректно. 

Якщо плагін працює повільно, при зміні налаштувань зображення завантажується 

уривками, перешкодою може бути брак вільного місця на жорсткому диску, або 

недостатньо оперативної пам’яті. На старих моделях комп’ютерів можливі ці та інші 

труднощі при роботі з плагіном Interactive 3D Surface Plot. 
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Тема 9. Автоматизоване визначення віку дерев за 
річними кільцями за допомогою плагіна ObjectJ 

Матеріали, обладнання та ПЗ 

цифрове зображення поперечного перерізу стовбура дерева, на якому чітко видно річні 

кільця, програмний пакет ImageJ, додатковий плагін ObjectJ 

Теоретичні відомості і сфера використання 

Одна з головних переваг програмного пакета ImageJ – відкритий вихідний код із 

можливістю написання плагінів у середовищі Java та вільний доступ до понад 5000 

готових плагінів, більшість із яких підтримують можливість автоматичного оновлення 

до актуальної версії. 

Плагін ObjectJ розроблений нідерландськими дослідниками і призначений для 

маркування елементів цифрового знімка та подальшої роботи з цими маркерами. В 

екологічних дослідженнях він цінний можливістю здійснення різноманітних 

нелінійних вимірювань із подальшим їх математичним опрацюванням і кількома 

варіантами інтерпретації отриманих результатів. Автори пропонують використовувати 

ObjectJ для здійснення морфометричних вимірювань біологічних об’єктів, підрахунку 

типів клітин на зображенні тканини, калібрування флюоресцентних каналів при 

дослідженні знімків бактерій, автоматичного обчислення діаметра ікринок риб, 

маркування й аналізування трекеру росту спор мікроскопічних грибів тощо. 

ObjectJ також допомагає визначати вік дерева за цифровим фотознімком 

поперечного перерізу стовбура, на якому чітко візуалізуються річні кільця.  Ця 

методика зручна і для підрахунку віку здерев’янілих гілок або коренів за річними 

кільцями на поперечних перерізах. Для базового використання можливостей 

плагіна в цьому напрямку автори пропонують макрос, до якого занесено алгоритм 

маркування і розпізнавання маркерів. Для розширеного використання плагіна 

користувач має можливість створювати власні різновиди маркерів та блоки таблиці 

інтерпретації результатів. У практичній роботі ми користуватимемося базовим 

макросом для плагіна ObjectJ. 

Хід роботи 

1. Підготуйте якісний цифровий знімок поперечного перерізу стовбура дерева та 

завантажте зображення на комп’ютер. 

2. Завантажте останню версію плагіна ObjectJ на сайті авторів за посланням: 

https://sils.fnwi.uva.nl/bcb/objectj/download/current/ (необхідно завантажити файл 

objectj_.jar). 
3. Розмістіть завантажений файл у папці plugins та проведіть усі маніпуляції з 

інсталювання плагіна аналогічно до попередніх робіт (наприклад, пункти 2–4 

Теми 7). 

 

https://sils.fnwi.uva.nl/bcb/objectj/download/current/
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4. Завантажте один із архівів (будь-який із запропонованих розробником) 

демонстраційного проєкту зі вбудованим макросом на сайті авторів за посланням: 

https://sils.fnwi.uva.nl/bcb/objectj/examples/TreeRings/treering-projects/. Розархівуйте 

його у папку plugins. 

5. Запустіть макрос із архіву File > Open > Tree Rings 11 > TreeRings-11.ojj (у вашому 

випадку цифра в назві може бути іншою) 

 

6. На робочій панелі з’явиться меню ObjectJ. 

 

А також відкриються робочі вікна плагіна: 

 

7. Заздалегідь заготовлений знімок поперечного перерізу стовбура дерева перенесіть 

в папку TreeRings-11 (у вашому випадку цифра в назві може бути іншою). 

https://sils.fnwi.uva.nl/bcb/objectj/examples/TreeRings/treering-projects/
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8. Завантажте це зображення, скориставшись кнопкою Link. Фотографію буде додано 

до переліку робочих файлів: 

 

9. Подвійне натискання відкриє це зображення в окремому вікні: 

 

10. На панелі ObjectJ Tools оберіть червоний точковий маркер і опцію Begin. 
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11. Проставте точку усередину центрального кола (вона має відобразитися у яскраво-

рожевому кольорі) і послідовно по одній – на кожне наступне коло (мають 

відобразитися у синьому кольорі). Результат виглядатиме так: 

 

12. Для видалення однієї неправильно проставленої точки, потрібно обрати інструмент 

з зображенням пістолету і відмітити цю точку. Щоби видалити весь ряд, необхідно 

відмітити останню точку в ряді. 

13. В меню ObjectJ оберіть опцію Enter year. Можна скористатися швидкою клавішею 

F4. У вікно Enter year введіть поточний рік зі знаком «–». Від’ємне число відмічає 

вихідну дату, коли дерево було зрубане. Якщо ввести додатне число, воно 

враховуватиметься як рік початку росту. 

 

 

14. Плагін автоматично розрахує рік формування кожного річного кільця.  
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15. Для того, щоби переглянути результати обчислень, в меню ObjectJ оберіть опцію 

Results > Recalculate: 

 

16. Результати виводяться у вигляді таблиці, де вказано рік, коли дерево було зрубане, 

рік формування першого річного кільця, а також вік дерева. Таблиця міститиме не 

лише результат ваших обчислень, але й три демонстраційні рядки: 

 

17. Подвійним клацанням лівою кнопкою миші на певному ряді таблиці можна 

викликати зображення, за яким було вираховано дані. 

 
Щоб очистити таблицю від зайвих даних, потрібно вилучити відповідні файли з 

аналізу, скориставшись кнопкою Unlink у головному вікні проєкту. У нашому 

прикладі ми цього не робитимемо, щоби мати можливість здійснити статистичний 

аналіз даних на прикладі чотирьох вимірювань. Результати статистичного аналізу 

відображатимуться не зовсім коректно, оскільки у прикладі наводяться дати 

початку росту, а у нас дата вирубування. 
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18. За допомогою кнопки Copy/Export збережіть отримані результати. У вікні 

налаштувань відмітьте опцію Include Statistics. Для збереження результатів 

натисніть кнопку Export…  

 
Результати будуть збережені у вигляді текстового файлу: 

 
19. Імпортуйте збережений файл у табличний редактор, наприклад, MS Excell або Гугл 

Таблиці. Для цього створіть новий файл із назвою Річні кільця і скористайтеся 

опцією Імпортувати. При імпорті вкажіть місцерозташування файлу. Якщо ви 

користуєтеся редактором Гугл Таблиці, його попередньо потрібно перенести на 
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Гугл Диск. У параметрах імпорту оберіть Додати на поточний аркуш і задайте 

автоматичне визначення типу роздільника: 

 
Кінцевий результат виглядатиме так: 

 
20. У сервісі Tree Rings плагіна ObjectJ є функція автоматичного проставляння 

маркерів річних кілець. Щоби скористатися нею, проставте перший (рожевий) 

маркер і 1–3 наступні у ручному режимі, а далі, затиснувши клавішу F2, проведіть 

лінію до краю спилу. Тепер натисніть клавішу F3 для перетворення білих намічених 

маркерів на сині: 

 
21. Автоматичне відмічування річних кілець дає досить точні результати, однак для 

отримання точного результату потрібно внести деякі правки у ручному режимі. Для 

цього збільшити масштаб зображення до 400 % або й більше, щоби річні кільця 

добре візуалізувалися. Для додавання нових точок на непромарковані кільця 

затисніть клавішу Shift, попередньо обравши інструмент маркування, і відмічайте 

у необхідних місцях. Не всі автоматично проставлені маркери розмістилися точно 
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на кільцях. Перенести їх на відповідні місця можна, затиснувши клавішу Shift із 

попередньо обраним інструментом стрілки: 

 
22. Коли річні кільця на спилі будуть промарковані правильно, здійсніть усі необхідні 

для аналізу операції, описані вище у пунктах 13–19. 

23. Порівняйте отримані у такий спосіб результати з попередніми. Який режим 

підрахунку річних кілець видається вам зручнішим: ручний чи автоматичний? 

Відповідь обґрунтуйте. 

Можливі труднощі 

При використанні плагіна ObjectJ можуть виникати певні труднощі. Розглянемо 

найтиповіші. Зокрема, при новому запуску програми ImageJ меню ObjectJ зникає з робочої 

панелі. Щоби його відновити, необхідно двічі клацнути на ньому у меню Plagins: 
 

 
При спробі ввести рік може з’явитися повідомлення Object must be open or 

selected. Для розв’язання проблеми потрібно закрити це вікно, зробити активним вікно 

зі зображенням, клацнувши на ньому, і повторити процедуру заново. 

 
У таблиці може відображатися тільки вік спилу. Таке трапляється, якщо ви забули 

вказати вихідний рік для підрахунків. Як тільки його ввести і оновити результати, вони 

відображатимуться у повному обсязі. 
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Тема 10. Напівавтоматизований аналіз морфологічних 
особливостей кореневої системи 

Матеріали, обладнання та ПЗ 

білий та темний папір формату А4, вузький скотч, сканер або камера, лінійка або 

міліметровий папір, екземпляри різних рослин із добре збереженою кореневою 

системою, програмний пакет ImageJ, плагіни ObjectJ та SmartRoot 

Теоретичні відомості і сфера застосування 

Коренева система рослин часто досліджується екологами у процесі біоіндикації та 

біотестування стану довкілля. За ступенем розвинення, станом, конфігурацією 

кореневої системи можна робити висновки про якість ґрунту, води та інших субстратів. 

Зміни габітуса кореневої системи можуть викликатися онтогенетичними змінами, 

конкуренцією за поживні речовини, особливостями механічного складу ґрунту, 

витоптуванням, ушкодженням шкідниками та хворобами. 

Дослідження морфологічних показників кореневої системи в лабораторних умовах 

досить складна і кропітка праця. Чим менші і слабкіші корінці, чим більше вони 

розгалужені, тим більша загроза їхнього механічного пошкодження під час 

вимірювання. Одноразова робота із рослинним матеріалом при отриманні цифрового 

зображення зводить ці ризики до мінімуму. Окрім того, напівавтоматичне 

вимірювання за допомогою широкого асортименту засобів програмного пакета ImageJ, 

дає змогу за короткий час отримати точні результати у зручному форматі, а також 

частково здійснити статистичну обробку даних. 

Хід роботи 

1. Підготуйте кореневу систему зразка: обережно очистьте її м’яким пензликом від 

грудочок ґрунту так, щоби не пошкодити окремі корінці. Темне коріння необхідно 

фотографувати (сканувати) на білому папері; світле – на контрастному. Якщо всі 

корінці лежать в одній площині, немає необхідності прикріплювати кореневу 

систему до паперу. Якщо ж вони просторово зорієнтовані в різні боки, необхідно за 

допомогою скотчу якомога ретельніше розправити та закріпити кореневу систему, 

щоб отримані результати не були спотворені. 

 

2. Отримайте цифрове зображення заздалегідь підготовленої до зйомки кореневої 

системи. Якщо це можливо, перевага надається скануванню з високою роздільною 

здатністю. В усіх інших випадках допускається фотографування. Кут та висоту при 

фотографуванні необхідно підбирати в кожному випадку індивідуально так, щоб 

освітлення було достатнім, тіні не спотворювали результатів та було видно всі 

корінці, навіть найменші. 



 116 

Поруч із матеріалом дослідження необхідно розмістити лінійку або 

міліметровий папір для калібрування шкали. 

3. Обробку отриманих зображень здійсніть трьома різними способами і порівняйте 

отримані результати. 

Спосіб І. Засобами базового пакету ImageJ 

4. Відкрийте зображення у програмі ImageJ будь-яким зручним для вас способом. 

5. Налаштуйте масштаб для встановлення зв’язку між реальною одиницею довжини 

(мм або см) і розмірами пікселя. Для цього оберіть інструмент Straight Line і 

проведіть пряму від поділки до поділки лінійки або міліметрового паперу: 

 

6. В допоміжному вікні встановіть одиницю вимірювання – міліметри або 

сантиметри, задайте довжину відрізка 2–5 см. У разі, якщо потрібно зробити серію 

вимірювань з одного аркуша зі спільною шкалою, відмітьте маркером опцію Global. 

 

7. На піктограмі інструмента Straight Line викличте контекстне меню правою 

кнопкою миші і оберіть опцію Freehand Line: 
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8. Проведіть лінію вздовж одного з корінців. Намагайтеся повторити форму корінця 

якомога точніше. В меню Analyze оберіть пункт Measure. Величина Length 

відповідатиме довжині корінця у обраних одиницях вимірювання: 

 
 

9. Послідовно виміряйте довжину всіх корінців. Коли усі виміри буде зроблено, в 

меню Results оберіть опцію Summarize для статистичної обробки результатів 

 
10. Оберіть піктограму Angle Tool. Щоби виміряти кут між двома корінцями, необхідно 

поставити три точки: 1) на першому корінці, 2) у вершині кута, який утворюють два 

корінці, 3) на другому корінці: 

Ця ознака використовується тільки для стрижневих кореневих систем для визначення 

кутів між осьовим та бічними коренями. 

Наведене нижче зображення не відповідає зазначеним вимогам, оскільки 

сфотографований паросток каланхое пірчастого має мичкувату кореневу систему. 

Воно використане винятково для демонстрації особливостей роботи зі вбудованими 

інструментами ImageJ, які можна використовувати для дослідження кореневої 

системи. 
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11. Коли буде знайдено кути між осьовим коренем і кожним із бічних, скористайтеся 

опцією Summarize, яка знаходиться в меню Results аналогічно до пункта 9. Так ви 

отримаєте середнє значення (Mean), стандартне відхилення (SD), мінімальне (Min) 

і максимальне (Max) значення. 

 

Спосіб ІІ. Засобами плагіна ObjectJ 

12. У меню Plagins знайдіть оцію ObjectJ. Якщо на неї натиснути, у панелі з’явиться 

нове меню. Ви вже встановили цей плагін для визначення віку дерева за річними 

кільцями, тому він буде у переліку. 
 

 
 

13. Створіть новий проєкт, скориставшись опціями Project > New Project: 

 
14. Збережіть новостворений проєкт із розширенням *.ojj у свою папку. Зображення, з 

яким працюватимете, повинно розміщуватися у тій самій папці. 
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15.  При відкритті цього файлу має з’явитися два додаткові вікна, знайомих вам із 

попередньої практичної роботи, але на цей раз повністю порожні. 

 

16. У більшому з двох вікон оберіть вкладку Objects. У полі Item Name запишіть 

значення об’єкта scale. У чарунці Item Shape оберіть опцію Line, у чарунках Marker 
Type, Line Type, Item Color налаштуйте характеристики за власним уподобанням 

 

Зверніть увагу: у малому вікні зліва відобразився новий об’єкт scale. 

17. У такий спосіб створіть об’єкти max RL, no root, left point за зразком: 
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18. Додайте нове поле для об’єкта, натиснувши на кнопку New Item Type. Назвіть його 

centre, так само створіть об’єкти right point, angle, sys width. Звіртеся з рисунком 

нижче. Типи маркера, товщина ліній та кольори залишаються на ваш вибір. 

 

Як видно з рисунка, у маленькому вікні з’явились об’єкти, які характеризують 

калібрувальну шкалу, максимальну довжину кореня, відсутність кореня, ліву точку, 

центр та праву точку кута, самий кут і протяжність кореневої системи. 

19. Тепер усі згадані показники треба продублювати у вкладці Columns. Для додавання 

нових колонок використовуйте кнопку New. Після введення назви натискайте Enter. 

 

Характеристики для кожної колонки наведені в таблиці: 

Column Title Operation Item type 

scale None  

MaxRL Length max RL 

NoRoot Count no root 

RootAngle Angle left point 

centre 

right point 

Sys_Width Length sys width 



 121 

20. Коли завершите заповнення форми, натисніть кнопку ObjectJ Results. З’явиться 

нове вікно із такою таблицею 

 

21. Тимчасово закрийте вікно з таблицею. У великому вікні перейдіть на вкладку 

Images та, скориставшись кнопкою Link, завантажте робоче зображення. Відкрийте 

його подвійним натисканням миші. 

 

22. У маленькому вікні з інструментами активізуйте верхній червоний хрестик та 

оберіть об’єкт scale. Як тільки перший пункт (встановлення шкали) буде виконано, 

плагін автоматично переходить на наступний крок. 

  

23. Уздовж першого корінця проставляєте ряд точок так, щоб лінія повторювала його 

форму. Коли робота з першим корінцем закінчена, необхідно натиснути кнопку Tab 

стільки разів, щоби підсвіченим знову став об’єкт max RL. Якщо забути це зробити, 

лінія від попереднього корінця продовжиться. У разі, якщо таке сталось, 

активізуємо кнопку пістолет і клацаємо на останню поставлену точку, знищуючи у 
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такий спосіб усю криву. Потім треба впевнитися, що підсвічено правильний об’єкт 

і починати знову працювати з цим корінцем. 

 

Важливо! Будьте уважними, не переплутайте корінці із тінню. 

24. Коли з цим етапом роботи буде покінчено, можете перевірити таблицю результатів, 

натиснувши на кнопку ObjectJ Results у великому вікні. Аналізуючи таблицю і 

рисунок, можемо побачити довжину окремих корінців за номерами. 

 

25. Наступні об’єкти пропустіть, почніть працювати із об’єктом angle. Для цього 

відмічайте кути трьома крапками: 1) головний корінь; 2) кут; 3) бічний корінець. 

Переключайтесь за допомогою Tab щоразу, коли закінчили працювати з 

попереднім кутом. Помилки виправляйте пістолетом. 
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26. Поверніться до об’єкта, який позначає ліву точку. Знову проставте три чорні точки 

поверх жовтих. За допомогою Tab перейдіть до роботи із наступним коренем. 
 

 

27. Перевірте таблицю результатів: 

 

28. Переходьте до роботи із об’єктом sys width. Це лінія, тому проведіть ії між двома 

точками кореневої системи в найширшому місці. 

 

29. Перевірте таблицю результатів 

 

30. Порівняйте отримані результати з одержаними способом І. 
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Спосіб ІІІ. Засобами плагіна SmartRoot 

31. Завантажте архів із плагіном SmartRoot за посиланням: https://smartroot.github.io/ 

32. Розмістіть завантажений архів, не розпаковуючи, у папку plugins, яка знаходиться 

у вашій папці fiji-win64 > Fiji.app. 

33. На робочій панелі ImageJ оберіть меню Plugins > Install Plugin… 

 

 
 

34. Відкриється вікно вибору файлів, у ньому знайдіть файл плагіна Smart_Root.jar за 

директивою: fiji-win64 > Fiji.app > Plugins > SmartRoot. 

35. Вийдіть із програми ImageJ і зайдіть повторно. В меню Plugins з’явиться об’єкт 

SR Explorer. 

 

 

35. Має відкритися три додаткові вікна: SmartRoot, SmartRoot Explorer, Log. Крім того, 

на панелі інструментів ImageJ з’явилися нові кнопки. 

 

36. Скориставшись вікном SmartRoot Explorer, відкрийте зображення. Якщо воно у 

кольорі, плагін пропонує автоматично конвертувати його у необхідний формат 

8-bit. 

https://smartroot.github.io/
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37. На панелі інструментів оберіть інструмент Trace Root. Лівим кліком миші відмітьте 

початок осьового кореня. Проставляйте послідовно точки вздовж осьового кореня 

від початку і до кінця. Подвійне натискання лівої кнопки миші на останній точці 

допоможе закінчити виділення кореня. Дайте кореню назву root_1. 

 

38. Правою кнопкою миші викличте контекстне меню та видаліть щойно 

збережений корінь. 
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39. Тепер повторіть процедуру, але в автоматичному режимі. Для цього затисніть 

клавішу Alt та лівою кнопкою миші клацніть на осьовому корені. 

40. Порівняйте результат автоматичного трендування із ручним трендом. Якщо 

отриманий автоматично тренд вас влаштовує, збережіть результат. Якщо ні, 

повторіть пункт 39, а потім пункт 38. 

41. Аналогічно у ручному режимі побудуйте тренди для всіх крупних бічних 

коренів, які відходять від осьового і мають додаткові корінці. Великі бічні 

корені, які не мають відгалужень, вважаються додатковими. Кожен корінь 

зберігайте окремо. 

Осьовий корінь та крупні бічні зберігаємо із назвою root_1, root_2, … , 

root_28 тощо. 

 

42. Коли всі основні корені відмічено, оберіть інструмент Trace lateral. За його 

допомогою у автоматичному режимі можна буде відмітити усі бічні корені. При 
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цьому важливо орієнтувати зелену лінію так, щоб підсвічувалась назва основного 

кореня, від якого відходить цей бічний корінець.  

 

Ця робота потребує підвищеної уваги, оскільки для бічних корінців не 

передбачений ручний режим трендування. Проте можливе редагування за 

допомогою пунктів контекстного меню. 

 

За допомогою опції Delete root можна видалити невдалий тренд. Спочатку обравши 

Multiply nodes, а потім Append nodes можна продовжити лінію тренда. Опція Remove 

node дає змогу видалити одне зі спрямовуючих тренд кіл. 

Зберігати такі корінці необхідно із назвою lat_1,  lat _2, … , lat _28 тощо. 

43. Коли буде виділено усі корінці, почніть роботу із математичним апаратом плагіна 

у вікні SmartRoot. Почергово проставляйте та прибирайте галочки навпроти 

окремих показників у вкладці Layers. Спостерігайте за змінами зображення. 
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44. У вкладці Root List зліва оберіть зображення. Справа відобразиться інформація про 

кореневу систему. Проаналізуйте її, окремим висновком коротко охарактеризуйте 

отримані математичні показники: кількість коренів (# roots), середня довжина 

(Mean length), середній діаметр (Mean diameter), середня щільність бічних коренів 

(Mean child density). Параметр #nodes неінформативний, оскільки характеризує 

кількість вузлів, які виконують функцію суто маркерів і не містять даних про 

кореневу систему. Поміркуйте, чи варто включати до звіту параметри Ticks і Marks. 

Відповідь обґрунтуйте.  

 

45. У вкладці Plot проставте галочки навпроти окремих опцій за зразком нижче або за 

власним уподобанням. Після цього натисніть кнопку Plot. В окремих вікнах 

відобразиться низка відповідних діаграм і графіків. Збережіть скріншоти 

найінформативніших, на вашу думку, та додайте їх до файлу з результатами. 

Поміркуйте, яку інформацію відображає кожна з них. У яких екологічних 

дослідженнях вона може бути цінною? Які графіки і діаграми видаються вам 

малоінформативними? Відповідь обґрунтуйте.  
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46. У висновках дайте відповіді на усі запитання, поставлені в ході виконання роботи. 

Обґрунтуйте вибір кожного з трьох наведених способів аналізу кореневої системи 

для конкретних екологічних досліджень. 

Додаткові можливості 

Деякі з інструментів аналізу кореневої системи придатні для дослідження 

надземних органів рослин. Наприклад, можна порівнювати кути між стеблом і 

гілками у рослин, вирощених в умовах різного освітлення. Інструменти плагінів 

ObjectJ і SmartRoot стануть у пригоді при дослідженні аномалій моноподіального 

галуження у хвойних рослин за несприятливого впливу екологічних факторів різної 

природи. Модулярні тваринні організми, наприклад корали, також можна 

досліджувати у такий спосіб. 
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Тема 11. Створення стеків і монтаж анімованих зображень 
часових рядів за даними GIS-спостережень 

Матеріали, обладнання та ПЗ 

хронологічна серія тематичних супутникових зображень, програмний пакет ImageJ. 

Сфера використання набутих умінь і навичок 

ImageJ дає змогу працювати зі смартоб’єктами, які складаються з двох і більше 

шарів, в одному вікні у режимі стека. Шари, які утворюють стек, називаються 

зрізами. Режим упорядкування зрізів у стеку відрізняється від стандартних способів 

накладання шарів у процесі обробки й аналізу цифрових зображень. Зручність роботи 

зі стеками полягає, насамперед, у можливості одночасного застосування окремих 

операцій (фільтрація, поліпшення контрастності, вимірювання) до серії зображень. 

Стеки використовуються для відображення й аналізу масиву зображень, які у 

певний спосіб пов’язані одне з одним, наприклад, за часом (темпоральний стек), 

простором (просторовий стек) або кольором (спектральний стек). Складання 

анімованих часових рядів має на меті полегшити перегляд і розуміння змін окремих 

областей зображення з часом. Стеки просторових даних використовуються як для 

вимірювань, так і для створення стереомоделей біологічних об’єктів. Використання 

стеків мультиспектральних даних поліпшує ідентифікацію і деталізацію об’єктів, 

надає більше параметрів і інструментів для їхнього аналізу. 

Сучасні геоінформаційні бази даних містять первинний матеріал для 

найрізноманітніших екологічних досліджень: аналізу кліматичних змін, динаміки 

стану деревного покриву, деградаційних процесів у ґрунтах, світлового 

забруднення, інтенсивності опустелювання, поведінки океанічних течій та багато 

іншої корисної інформації.  

Серії космознімків, зібраних для одного регіону, але в різний час – яскравий 

приклад часового ряду. Організація масиву таких даних у вигляді стека допомагає 

краще візуалізувати процеси, які відбуваються в абіотичному середовищі за 

довготривалий час, а також швидко й ефективно проводити серії вимірювань. Перевага 

упорядкування зображень у вигляді стека для вимірювання полягає в тому, що при 

виділенні ROI на одному зрізі стека, цей вибір автоматично застосовується до всіх 

зрізів у його складі. Це гарантує вимірювання ідентичної частини зображення в 

кожному зрізі, а отже й отримання зівставних результатів. 

Наприклад, NASA з 1970-х рр. веде спостереження за аномаліями температури 

на земній поверхні. Для проведення аналізу збираються загальнодоступні дані з 6300 

наземних метеорологічних станцій по всьому світу. Дані оновлюються приблизно 10 

числа кожного місяця. Як контрольний період використовується середня температура 

за 1951–1980 роки: у глобальному масштабі вона становить 14 °C з похибкою в кілька 

десятих градуса Цельсія. Суттєві відхилення від середніх локальних температур, 

зафіксовані кількома станціями у радіусі 1200 км, позначається як температурна 

аномалія. За даними проєкту, середня глобальна температура на Землі зросла 

приблизно на 0,8 °C з 1880 року. Дві третини потепління припадає на період з 1975 

року зі швидкістю приблизно 0,15–0,20 °C на десятиліття. Масив даних, отриманих у 

такий спосіб, допомагає аналізувати і візуалізувати зміни як у глобальному масштабі, 

так і в регіональному, за весь період спостережень і за певні роки або місяці. Їх зручно 

використовувати для популяризації екологічних знань серед населення. 
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Хід роботи 

1. Ознайомтеся з базами картографічних матеріалів NASA Earth Observations (NEO), 

представлених на сайті https://neo.gsfc.nasa.gov/ Для прикладу у роботі наводиться 

мапа глобальної динаміки аномальних температур наземного покриву протягом 

2021 року. Однак за запропонованим алгоритмом можна аналізувати будь-який 

інший набір даних у подібному форматі. 

 
 

2. Завантажте набір зі сайту NASA Earth Observations (NEO) https://neo.gsfc.nasa.gov/  

Для цього рухайте повзунок із назвами місяців року, щоби відкрити відповідне 

зображення і зберігайте його собі в окрему папку на жорсткий диск, нумеруючи файли 

від 1 до 12. Не варто брати дані за поточний рік, краще за попередні, коли наявна повна 

інформація за всі 12 місяців. 

https://neo.gsfc.nasa.gov/
https://neo.gsfc.nasa.gov/
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Щоб скласти стек зображень, усі вони мають бути однакової ширини, 

висоти та бітової глибини. 

3. Для того, щоб завантажити всі зображення у ImageJ, оберіть опцію File > Import > 
Image Sequence... 

 
У вікні імпорту послідовності зображень скористайтеся кнопкою Browse, щоб 

вказати місце розташування папки зі серією знімків: 

 

Важливо, щоби файли були правильно пронумеровані, стек формується у 

послідовності, починаючи з 1 з кроком у один файл. 

4. Якщо у попередньому пункті все виконано правильно, результатом має стати вікно 

з нижнім повзунком для гортання файлів. У інформаційному рядку вказано номер 

активного рисунка, його назва, розміри і колірний простір: 
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5. Прогортайте зображення повзунком, спостерігайте за змінами на карті. 

6. Збережіть створений стек як багатошарове зображення у форматі *.tif, 
скориставшись функцією File > Save As > Tiff… 

 
7. Необхідність гортати зрізи у складі стека вручну за допомогою повзунка створює 

певні незручності у користувача. Можна налаштувати автозміну слайдів за 

допомогою послідовності опцій: Image > Stacks > Animation > Start Animation 

 
8. За замовчуванням швидкість зміни слайдів становить 7 слайдів за секунду. Такий 

режим незручний для перегляду і фіксування змін на карті. Для уповільнення 

переключення між зрізами стека скористайтеся функцією Image > Stacks > 
Animation > Animation Options.... 

 



 134 

9. У вікні налаштування анімації оберіть швидкість переключання 2 слайди за секунду  

 
Поекспериментуйте з комфортною для вас швидкістю зміни карт. Можливо, це 

буде 1 або 4 слайди за секунду. 

10. Збережіть анімоване зображення у форматі *.gif, скориставшись функцією File > 
Save As > Gif… 

Подібні анімовані зображення можна демонструвати під час захисту 

дипломної роботи, при виступі на студентській конференції або під час 

семінарських занять із різних дисциплін. 

11. Закрийте всі вікна зі зображеннями. 

12. Стеки за необхідності можна редагувати, зокрема вилучати окремі слайди та 

додавати нові. Завантажте з сайту NASA Earth Observations (NEO) ще три 

зображення з обраної тематики за наступний рік. Важливо не переривати 

послідовність зміни місяців у анімації. Пронумеруйте файли у хронологічному 

порядку для коректного відображення анімації. 

13. Відкрийте стек, збережений раніше у форматі *.tif. У відкритому вікні перемістіть 

повзунок на останній, дванадцятий слайд. 

14. Щоби додати нові слайди до стека оберіть опцію Image > Stacks > Add Slice. 

Результатом такої операції буде порожній тринадцятий слайд: 

 
15. Не закриваючи поточного вікна, відкрийте у новому вікні зображення, яке хочете 

додати до стека (карту за січень наступного року) будь-яким зручним способом. 
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16. Перейдіть до вікна стека, клацнувши на ньому лівою кнопкою миші. Додайте до 

порожнього слайду шар із обраним рисунком. Для цього викличте опцію меню 

Image > Overlay >Add Image. У вікні додавання рисунку оберіть відповідний файл і 

натисніть кнопку OK. 

 
У вікні стека з’явиться тринадцятий зріз: 

 
17. Аналогічно додайте до файлу решту два зображення: за лютий і березень. 

Максимальна можлива кількість зрізів у стеку – 1000. 

18. Збережіть змінений файл у форматі *.tif під іншою назвою, щоб у папці були 

одночасно і вихідний файл зі 12 слайдами, і новий на 15 слайдів. 

19. Налаштуйте анімацію для оновленого стека, який містить 15 слайдів, керуючись 

інструкціями з пунктів 7–9. Збережіть файл у форматі *.gif. 
20. У випадку помилкового розміщення слайду у складі стеку його можна вилучити, 

скориставшись опцією: Image > Stacks > Delete Slice. 
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21. Закрийте всі зайві вікна, зміни можна не зберігати. 

22. Створіть новий стек із трьох зображень. 

23. Для того, щоби додати до стека написи, попередньо налаштуйте властивості 

шрифту через відповідну кнопку на панелі інструментів. Доцільно обрати 

контрастний до фону колір: 

 
24. Переконайтеся, що стек із трьома зображеннями активний. Оберіть функцію Image 

> Stacks > Label… У вікні налаштувань написів оберіть текстовий формат. 

Активізуйте опції Use text tool font для того, щоби використати попередньо 

налаштований формат тексту і Prewiew для того, щоб мати змогу попередньо 

переглянути результат і, за необхідності, змінити розмір шрифту та місце 

розташування напису на слайді. Як напис використайте рік спостережень. Коли 

налаштування будуть завершені, натисніть кнопку ОК. Напис буде застосовано до 

всіх слайдів у складі стека. Збережіть зміни : 

 
25. Аналогічно застосуйте написи до стека з дванадцятьма слайдами. 

26. Активізуйте функцію Image > Stacks > Tools > Combine… У вікні налаштувань 

оберіть спочатку ваш великий (річний) стек, а потім малий (квартальний): 
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На рисунку знизу представлений результат такої комбінації двох стеків. Таке 

представлення зручне для попарного порівняння знімків, отриманих у різні роки в один 

і той самий місяць. У нашому прикладі порівняльний аспект доступний лише для 

перших трьох місяців, оскільки другий стек містив лише три зображення. Якщо його 

доповнити даними за решту 9 місяців, можна отримати інформативні результати 

порівняння за два роки. Збережіть зміни в окремому файлі з розширенням *.tif. 

 

 
27. Ще один формат візуального представлення зображень у стеку – колаж. Для його 

генерування передбачена функція Image > Stacks > Make Montage... У вікні 

налаштувань можна обрати кількість колонок і рядів у матриці зображень.  

  
Опція Label slices підписує кожен кадр назвою файла, під якою його було додано до 

стека. За умови її активізації можна використати попередні налаштування шрифту, 

відмітивши Use foreground color. Розмір шрифту вводиться вручну у вікні налаштувань 

монтажу. Показник Increment дає змогу налаштувати крок із яким зображення у складі 

стека додаватимуться до колажу. Можна обрати кожен другий або кожен третій слайд. 
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28. Збережіть колаж як файл із розширенням *.jpg. 

29. За потреби, стек можна зберегти як набір окремих зображень: Image > Stacks > Stack 
to Images. 

 

Додаткові можливості 

Наведені операції можна застосовувати не лише до часових рядів, але й до 

просторових. У медичній практиці стеки використовують для збереження, аналізу, 

компонування і графічного представлення результатів сучасних методів діагностики: 

комп’ютерної і магнітно-резонансної томографії, ультразвукової діагностики, 

ангіографії тощо. Мультиспектральні стеки стають у пригоді при обчисленні 

вегетаційних індексів та інших показників, отриманих за допомогою ГІС. Набір 

інструментів ImageJ для роботи зі стеками значно ширший, ніж ми розглянули. 

Додаткову інформацію шукайте на спеціалізованих інформаційних ресурсах. 
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Тема 12. Планування експерименту з урахуванням вимог 
ImageJ до зображень 

Останнє практичне завдання курсу передбачає самостійне планування і виконання 

екологічного дослідження із застосуванням набутих навичок роботи з програмним 

комплексом ImageJ. Це однаковою мірою творчий та інтелектуальний процес. Тому ви 

не знайдете тут конкретних покрокових роз’яснень, а лише загальні рекомендації щодо 

організації робочого процесу. 

Етап вибору наукової проблематики 

Будь-яке дослідження розпочинається з вибору актуальної наукової проблеми, яка 

потребує розв’язання. Це може бути як важливе фундаментальне питання (наприклад, 

як протидіяти скороченню біорізноманіття?), так і прикладне завдання локального 

масштабу (наприклад, як знизити негативний вплив на довкілля окремої автозаправної 

станції?). Багато дослідників-початківців стикаються з труднощами саме на цьому 

етапі, який передує початку планування експерименту, адже невирішених екологічних 

проблем надзвичайно багато, а практичного досвіду поки що мало. 

Щоби визначити для себе коло пріоритетних інтересів, а також для обрання 

робочої наукової гіпотези, варто ознайомитися зі сучасними оглядовими науковими 

працями. Для найпершого знайомства вдалим вибором буде стаття Identification of 

100 fundamental ecological questions, опублікована в журналі Journal of Ecology. 

Спробуйте знайти самостійно подібні теоретичні праці українською. Для підвищення 

результативності пошуку, користуйтеся спеціалізованими науковими ресурсами 

(Гугл Академія, Mendeley, Semantic Scholar тощо) і репозитаріями (НРАТ, ARCher, 
BASE, PubMed тощо). Спочатку потрібно визначитися з головним напрямком 

майбутнього дослідження, а потім поступово звужуйте його до конкретної теми. Під 

час вибору тематики стануть у пригоді статті прикладного характеру і збірники тез 

доповідей із обраного напрямку. Результативним буває і пошук ідей на тематичних 

наукових форумах. Наприклад, платформа ResearchGate – це не лише ресурс, де 

науковці обмінюються повнотекстовими версіями своїх наукових праць, але й 

простір для обміну досвідом, пошуку однодумців, консультацій у вузьких фахівців, 

знаних дослідників з усього світу. 

Як можна звузити напрямок дослідження до конкретної теми? 
Сконцентруйтеся на конкретному вузькому аспекті досліджуваної проблематики. 

Для прикладу, питання скорочення біологічного різноманіття унаслідок кліматичних 

змін можна розглядати на конкретному прикладі всихання смерекових лісів. 

Приділіть увагу окремому компонентові з великого асортименту можливих 

варіантів. Зокрема, широка тема негативного впливу нафтопродуктів на життєдіяльність 

гідробіонтів може бути звужена до аналізу токсичності гасу (конкретний продукт) із 

використанням дафнії магна (конкретний організм) як біотестера. 

Результативний спосіб звуження фокусу дослідження – прив’язка до певного 

місця. Скажімо, замість оцінки поширення амброзії полинолистої по Україні оберіть 

інвентаризацію цього інвазійного виду на території вашого населеного пункту. 

Визначте обмежені часові рамки дослідження. Чим коротший період, тим вужчий 

фокус. Наприклад, аналізуючи активність бджоловідвідування соняшника, доцільно 

сконцентруватися на годинах найактивнішого нектаровиділення: з 10.00 до 14.00. 
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Спробуйте знайти зв’язок між певними явищами або процесами. Приклади таких 

зв’язків: причина – наслідок, спільне – відмінне, особина – група, сучасність – 

ретроспектива тощо. 

Для отримання ще вужчої теми дослідження можна комбінувати наведені методи. 

Однак не варто занадто захоплюватися спрощенням: поєднання кількох стратегій 

ризикує створити протилежну проблему – ваша тема стане занадто вузькою, а отже, 

нецікавою для наукової спільноти. 

Вибір теми дослідження потрібно здійснювати з урахуванням ваших реальних 

можливостей: 1) актуальності тематики для вашої місцевості; 2) наявності необхідних 

матеріалів, реактивів і приладів; 3) тривалості експерименту; 4) складності підготовки 

і виконання; 5) наявності у виконавця необхідних знань і навичок. 

Перш ніж приступити до планування дослідження із застосуванням 

ImageJ, важливо усвідомити, що багато екологічних експериментів 

неможливо здійснити на основі аналізу цифрових зображень. 

Якщо, незважаючи на надані рекомендації, вам не вдалося чітко сформулювати 

тему майбутнього дослідження, зверніть увагу на наукову тематику кафедри, 

порадьтеся з однокурсниками, аспірантами, викладачами. 

Дизайн експерименту 

Планування експерименту – надзвичайно важливий етап, який впливає водночас 

на успішність його втілення та на об’єктивність і наукову цінність отриманих 

результатів. У англомовній науковій літературі для цього процесу і його кінцевого 

продукту вживається термін Experimental design. Розробка детального плану 

майбутнього дослідження – це ефективний метод оптимізації експериментальних 

умов, який дає змогу максимізувати кількість корисної інформації, отриманої за 

допомогою мінімальної кількості операцій. Існує тісний зв’язок між дизайном 

експерименту, способом збору даних і статистичним підходом, який 

використовуватиметься для їхнього аналізу. 

Визначають кілька типів дизайну дослідження: описовий, експериментальний, 

кореляційний, оглядовий та метааналітичний. Тільки перші три передбачають 

можливість роботи з цифровими зображеннями, решта базується на роботі з текстовою 

інформацією. 

Описовий тип дизайну дослідження застосовується переважно при плануванні 

натуралістичних спостережень і використовується для отримання інформації про 

поточний стан об’єктів або явищ і опису змін у часі. Матеріалами дослідження у цьому 

разі можуть слугувати дані, записані за допомогою фото- і відеопасток, вебкамер, 

БПЛА, супутникових сенсорів. Під час організації спостережень важливо підібрати 

вдалий ракурс і періодичність зйомки, забезпечити безперебійне живлення апарата. 

Корисною буде вбудована функція маркування часу, дати і місця зйомки. При 

спостереженні за тваринами варто продумати маскування пристрою. В окремих 

випадках можна скористатися вже наявними матеріалами, доступними у відкритих 

базах даних із дотриманням вимог академічної доброчесності. 

Експериментальний тип дизайну дослідження застосовується для більшості 

лабораторних випробувань. Його перевага полягає у можливості дослідника 

контролювати всі фактори, які можуть вплинути на результат експерименту, 
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створювати необхідні умови, задавати тривалість і формат результатів. Такий підхід 

потребує ретельнішої підготовки, включаючи виготовлення або замовлення реактивів, 

відбір зразків і пробопідготовку, забезпечення оптимальних фізичних умов у 

лабораторії, налаштування режиму зйомки. Можливо, знадобиться зйомка з різних 

ракурсів, застосування світлофільтрів, різних режимів збільшення тощо. 

Польові експерименти також здебільшого мають експериментальний тип дизайну. 

На відміну від лабораторних досліджень, вони характеризуються більшою тривалістю 

і меншим впливом на фізичні умови середовища. Візуальні зміни рослинного покриву 

фіксуються переважно за допомогою цифрових фотокамер і БПЛА. 

Класичний дизайн лабораторного або польового експерименту передбачає 

порівняння результатів, отриманих у експериментальному та контрольному варіантах 

досліду. Незалежну змінну вводять в експериментальну групу, а не в контрольну, і в 

обох групах вимірюють одну і ту ж залежну змінну. Такий підхід забезпечує найвищий 

рівень доказовості для окремих досліджень. 

Кореляційний тип дизайну дослідження використовується у разі, якщо 

передбачається наявність взаємозв’язку між аналізованими показниками. Кореляційні 

дослідження здебільшого зосереджені на вивченні змінних показників у природних 

умовах, їх ідентифікації та встановленні зв’язків між ними. Така дослідницька модель 

в екології досить розповсюджена, особливо, якщо кінцева мета полягає у прогнозі 

майбутніх подій на основі поточних знань. Наприклад, глобальне потепління очікувано 

корелює з викидами парникових газів. На практиці неможливо провести керований 

експеримент, який би контролював глобальні викиди з плином часу, але через 

спостереження, аналіз, програмне моделювання можна показати позитивну кореляцію, 

яка підтвердить теоретичне припущення. При цьому варто пам’ятати, що наявність 

кореляції не свідчить про причинно-наслідковий зв’язок. 

Кореляційне дослідження може проводитися як самостійне або в комбінації з 

попередніми двома дослідницькими моделями. У багатьох випадках воно допомагає 

ідентифікувати всі можливі змінні до того, як з ними можна буде щось зробити. 

Важливе місце тут належить статистичним методам опрацювання даних, зокрема, 

кореляційному і регресійному аналізу. 

Замість збору оригінальних матеріалів ви можете використовувати цифрові дані, 

які були зібрані з іншою метою, наприклад космознімки, фото- і відеозаписи 

спостережень за організмами у природному середовищі, знімки результатів 

лабораторних і польових експериментів. У цьому й полягає зручність застосування 

цифрових зображень як матеріалу дослідження. Вони не псуються, не втрачають із 

часом властивості, компактно зберігаються і можуть бути повторно використані 

скільки завгодно разів у численних дослідженнях, які мають найрізноманітніші цілі. 

Використання вторинних даних недороге й економить час. 

Етап підготовки експерименту 

Найпростіший спосіб – взяти за основу для власного дослідження готовий шаблон 

і адаптувати його для реалізації своїх наукових цілей. Наприклад, під час виконання 

практичних завдань Теми 3 ви навчилися визначати площу об’єктів різної форми. 

Можна скористатися запропонованим алгоритмом для визначення ступеня заростання 

ряскою невеликої стоячої водойми. Для цього знадобляться якісні аерознімки, зроблені 

за допомогою БПЛА. Космознімки високої роздільної здатності допоможуть досить 

точно визначити площу незаконної рубки лісу або еродованої поверхні землі. На основі 
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цифрових знімків, відзнятих на камеру смартфона з накладанням прозорої 

вимірювальної сітки, можна визначити проєктивне покриття лишайників для 

ліхеноіндикаційних досліджень. Серія мікрознімків, отриманих за допомогою 

лазерного сканувального конфокального мікроскопа, послугує інформативним 

матеріалом для дослідження швидкості заростання пластикового субстрату біоплівкою 

та швидкості його біодеградації за впливу мікроорганізмів. Отже, один алгоритм 

придатний для дослідження об’єктів живої та неживої природи, явищ і процесів у 

масштабах від мікробіому до біосфери. 

Поле вашої планованої діяльності не повинне обмежуватися інструментами і 

способами, представленими у цьому посібнику. Ви можете адаптувати будь-який 

самостійно знайдений готовий алгоритм дослідження або розробити власний 

унікальний. Деякі ідеї для натхнення запропоновані у додатку до цієї теми. Пам’ятайте 

про те, що всі знайдені вами готові рішення мають своїх авторів і є їхньою 

інтелектуальною власністю, яка захищається законом. Тому використовуючи їх для 

генерації власних креативних ідей, не забувайте вказувати літературні або 

інформаційні джерела, які дали вам творчий поштовх. 

Мета підсумкового заняття з дисципліни: розробити і реалізувати дизайн 

власного експерименту. Абсолютне повторення знайденого готового шаблону 

із використанням власноруч зроблених цифрових знімків не розцінюється як ваш 

інтелектуальний продукт, тому не буде позитивно оцінений. 

В описовому дизайні експерименту підготовчий етап полягатиме у виборі об’єкта 

спостереження, визначенні оптимального часу зйомки із урахуванням освітлення, 

виборі ракурсу для отримання інформативних знімків, підборі кількості сеансів зйомки 

для одержання статистично значущої вибірки. У разі, якщо ви плануєте працювати зі 

вторинними даними, підготовчий етап передбачає визначення характеристик вибірки 

цифрових зображень, пошук репрезентативних баз даних, перевірку наявності 

авторського дозволу на використання матеріалів. 

У експериментальному дизайні підготовчий етап має дві фази: підготовка до 

самого експерименту і підготовка до зйомки. У фазі підготовки до експерименту 

планується кількість варіантів досліду, число повторів, визначаються умови 

проведення досліду, готуються реактиви, лабораторний посуд і прилади, біологічні 

об’єкти. У фазі підготовки до зйомки вибирається камера, насадки, світлофільтри, 

штативи, визначаються оптимальні налаштування апаратури, тип і кут освітлення, 

колір і формат підкладки, шкала для вимірювання тощо. 

У кореляційному дизайні підготовка може дублювати один із попередніх варіантів 

або поєднувати їх. Оскільки саме ця дослідницька модель передбачає обов’язкове 

використання математичного апарата, підготовчий етап матиме додаткову фазу 

підбору показових методів статистичної обробки результатів, програмного 

забезпечення для обрахунків і візуалізації результатів у вигляді графіків, діаграм та 

інших видів ілюстрацій. 

Незалежно від обраних тематики і дизайну експерименту, у кінцевому результаті 

необхідно отримати якісні цифрові зображення для аналізу. Тому на етапі планування 

впевніться у справності апаратури (цифрової камери, БПЛА, цифрового мікроскопа 

тощо) та аксесуарів (штативу, освітлювальних елементів, блоку живлення, кабелів 
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USB). Перевірте наявність у пристрої карти пам’яті. Повністю зарядіть усі пристрої. 

Підготуйте змінні акумулятори, резервне портативне джерело живлення (павербанк, 

зарядна станція тощо). 

Досвідчені фахівці у царині наукової фотографії рекомендують скласти 

попередній список усіх кадрів, які необхідно відзняти під час експерименту. Не 

зосереджуйтеся тільки на тих зображеннях, які послугують матеріалами для аналізу. 

Включіть до переліку також фотографії процесу підготовки, проміжних етапів 

дослідження, виконавців проєкту і процесу роботи. З одного боку, такі кадри стануть 

переконливим свідченням вашої участі у проєкті, з іншого – можуть знадобитися для 

ілюстрування звіту, допоможуть продемонструвати ключові моменти проведеного 

дослідження. Нижче для прикладу такого документування експерименту наведено 

колаж з сюжетами, які демонструють різні етапи дослідження фізико-хімічних 

властивостей зразків поліфлорного меду. 

 

Обов’язково переконайтеся, що всі етапи планованого експерименту, 

включаючи підготовку, збір матеріалів, зйомку, роботу з цифровими 

зображеннями, опрацювання результатів і оформлення роботи займе не 

більше 2–4 тижнів. 

Етап збору матеріалів 

Залежно від особливостей планованого дослідження цифрові знімки можуть 

використовуватися як головне джерело інформації або лише як допоміжний 

інструментарій. У першому випадку матеріалами слугують самі цифрові 

зображення (наприклад космознімки). У другому як матеріал дослідження у різних 
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фазах послідовно використовуються біологічні об’єкти чи об’єкти неживої природи 

і цифрові зображення. 

При підготовці фізичних матеріалів (об’єктів живої та неживої природи) до 

фотографування важливо розуміти відмінність між художньо-естетичними і науково-

інформативними зображеннями. Необхідно зберігати об’єктивність передачі 

інформації. Заборонено використовувати будь-які декоративні фільтри при 

фотографуванні на камеру смартфона. При зйомці у натурних умовах заборонено 

штучно створювати ефектну композицію, додаючи або вилучаючи окремі елементи 

довкілля.  

Непрофесійно виконаний знімок може містити спотворену інформацію про об’єкт. 

У екологічних дослідженнях здебільшого застосовується вибірковий підхід, за 

якого аналізується не увесь великий масив елементів, а його репрезентативна 

вибіркова сукупність. При формуванні вибірки потрібно враховувати структуру 

генеральної сукупності. Наприклад, аналізуючи ураження дерев омелою, хибно 

фотографувати лише найбільш уражені екземпляри. Інший приклад неправильного 

підходу до відображення результатів експерименту: зйомка контрольних екземплярів 

рослин із такого ракурсу, щоб вони видавалися здоровішими (вищими, яскравіше 

забарвленими, розгалуженішими). Вибіркове представлення зображень, які 

розкривають лише одну сторону реальної ситуації, прирівнюється до зловмисного 

маніпулювання первинними даними. 

Упередженість – набагато більша проблема в науці, ніж про це прийнято говорити. 

Інколи спотворення результатів не усвідомлюється виконавцем проєкту і не має 

навмисного наміру. Щоби уникнути помилки, дослідник повинен критично 

проаналізувати зроблені знімки і обрати лише ті, котрі можуть дати об’єктивну 

відповідь на запитання дослідження, а не ті, які найкраще ілюструють висунуту 

гіпотезу. Зробіть значно більше кадрів кожного об’єкта з кожного ракурсу, ніж 

потребує експеримент. Це дасть змогу обрати найвдаліші зображення при формуванні 

об’єктивної та інформативної вибірки даних.  

Підбір фотоматеріалів для наукового дослідження потребує точності та деталізації. 

Цифрові зображення, які порівнюватимуться одне з одним, мають бути отримані в 

ідентичних умовах, і будь-яка обробка зображень після отримання також має бути 

ідентичною. Два різні прилади з однаковими налаштуваннями не завжди забезпечують 

ідентичність зображень. 

Потурбуйтеся про систематизацію і надійність збереження отриманих зображень. 

Не зберігайте знімки на пристрої, за допомогою якого їх зроблено. Перенесіть їх на 

жорсткий диск комп’ютера і продублюйте у хмарному сховищі і /або на портативний 

пристрій (флеш-карта, диск SSD тощо). Для зберігання цифрових знімків 

рекомендований формат файлу TIFF. Уникайте використання стиснення з втратами. 

Будьте обережні з використанням JPEG, оскільки кожен раз, коли файл зберігається в 

цьому форматі, виконується алгоритм стиснення. З кожною ітерацією збереження 

файлу артефакти JPEG (елементи з шумами, накладанням кольорів, муаром, 

розмиттям) поєднуються один з одним, ще більше погіршуючи якість зображення.  

Бажано давати зображенням репрезентативні назви та супроводжувати їх 

метаданими. Якщо ви не вмієте працювати з метаданими, створіть у табличному 
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редакторі файл, який міститиме перелік назв файлів, дату і час отримання кожного з 

них, місце зйомки, прізвище оператора, інформацію про просторовий, часовий або 

спектральний масштаб, параметри збору даних. Опційно залежно від характеру 

створеної бази вказуються латинські назви відзнятих об’єктів, варіант досліду, 

порядковий номер екземпляра та інша важлива додаткова інформація, яка допоможе 

надалі в опрацюванні первинних даних. 

Поширений спосіб використання фотографій у дослідженнях – аналіз 

загальнодоступних зображень (вторинних даних). Перш ніж розпочати роботу з 

такими знімками, переконайтеся у їхній придатності для наукового аналізу. 

Найпростіший спосіб перевірки наукової цінності бази даних – увести назву бази або 

сайту, на якому вона міститься, в один із наукових пошуковиків, наведених у переліку 

інформаційних ресурсів наприкінці посібника. Якщо результати пошуку видадуть 

перелік наукових праць, виконаних із використанням обраного набору зображень, 

можете сміливо розпочинати роботу. Приклад такого запиту наведено нижче: 

 

 
Якщо кілька пошуковиків наукових текстів не видають жодних результатів за 

вашим запитом, переконайтеся, що назву введено коректно. У разі невдачі спробуйте 

знайти альтернативне джерело цифрових зображень на обрану тематику. Зазвичай 

доступ до тематичних наборів даних надають урядові організації, відомі міжнародні 

організації та об’єднання (наприклад, ВООЗ, ФАО, Європейська екологічна агенція), 

всесвітньо відомі наукові інститути. Окрім наукових баз даних, репозиторіїв та архівів, 

потрібна вам інформація може міститися на навчальних ресурсах. У пригоді можуть 

стати й добірки, складені користувачами форумів, науковими блогерами, науково-

популярними ресурсами.  

Етап аналізу цифрових зображень 

Коли ви починаєте маніпулювати цифровим знімком, дуже важливо завжди 

використовувати копію оригінального зображення. У процесі більшості маніпуляцій у 
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ImageJ користувачеві пропонується перезаписати оригінальний файл обробленим 

зображенням. Навичка такого перезапису у будь-якого користувача ПК практично 

доведена до автоматизму попереднім досвідом роботи у графічних, текстових, 

табличних редакторах. Щоби уникнути небажаного збереження змін в оригінальному 

зображенні, найкраще відкрити файл і негайно зберегти копію зображення, закрити 

вихідний файл і відкрити копію зображення. 

Користувачам потрібно уважно ставитися до постобробки зображень. 

Фільтрування зображень може викликати артефакти, які несподівано впливають на 

вимірювання інтенсивності та розміру. Вимірювання інтенсивності необхідно 

виконувати на рівномірно оброблених даних зображення, а дані мають бути 

відкалібровані за відомим стандартом. Хоча обертання та/або зміна розміру 

зображення може знадобитися у процесі аналізу, цю інтерполяцію даних варто 

виконувати лише один раз на зображенні, щоб уникнути поєднання артефактів. 

Під час обробки цифрового зображення надзвичайно корисним буде 

документування всіх кроків маніпуляцій, виконаних із зображенням, а також 

програмного забезпечення та номера версії, які використовуються для виконання 

маніпуляцій. Надання адекватної інформації про виконані маніпуляції із зображенням 

– це захист від звинувачень у шахрайстві. 

Кінцевий продукт потрібно порівняти з оригінальним зображенням, щоб 

переконатися, що будь-які маніпуляції були виконані належно та не спотворюють дані. 

Плагіни, які можуть стати у пригоді 

В організації власного експерименту можете скористатися інструментами, які 

опанували у процесі виконання програмних завдань курсу, або проявити дослідницьку 

ініціативу і самостійно дослідити можливості нових плагінів. Для вашої зручності 

нижче наведено огляд деяких плагінів, придатних для екологічних досліджень. Усі 

наведені зображення запозичено зі сайтів розробників. 

AnimalTracker – універсальний плагін для дослідження рухової активності тварин. 

Складається з трьох незалежних модулів, які можна використовувати окремо і у 

комплексі. На відміну від більшості інших плагінів, працює не з фотознімками, а з 

відеоматеріалами. Модуль Tracker обробляє вхідне відео, ідентифікуючи та маркуючи 

об’єкти, а також присвоюючи їм координати. Модуль Tracking Analyzer служить для 

визначення та отримання параметрів, необхідних для 

оцінки поведінки тварин. За допомогою його 

інструментів можна визначати стандартні показники 

руху: відстань, час, швидкість і деякі специфічні, 

наприклад, кут у водному лабіринті Морріса. Вихідні 

значення обробляються за допомогою таблиці 

результатів з можливістю подальшого групування 

значень. Модуль Zone Designer надає розширені 

можливості для вільного визначення окремих зон або зон перекриття в межах поля 

спостереження за допомогою геометричних примітивних об’єктів. 

https://animaltracker.elte.hu/ 

CultivarJ – плагін, розроблений для фенотипування сільськогосподарських рослин. 

Містить інструменти для вимірювання морфометричних характеристик коробочок і 

насіння льону, стручків гороху та квасолі, коренеплодів (цукровий буряк, морква) та 

цибулі. Незважаючи на досить вузький спектр культур, запропонований 

https://animaltracker.elte.hu/
https://animaltracker.elte.hu/
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розробниками, алгоритм можна 

адаптувати для оцінки 

популяційного різноманіття інших 

сільськогосподарських та дикорос-

лих рослин із подібними 

морфологічними ознаками. Окрім 

того, меню плагіна містить 

підрозділ General Analysis для 

вимірювання загальних величин 

інших культур, зокрема довжину, 

ширину та площу, а також похідну зовнішнього контуру. Це дає змогу оцінювати 

відмінності між сортами та однорідність і стабільність конкретного сорту. 

https://www.wur.nl/en/show/CultivarJ-An-ImageJ-plugin-for-plant-variety-testing.htm 

Egg Tools – невеликий вузькоспеціалізований плагін, який містить інструменти для 

вимірювання геометричних параметрів яєць, зокрема кривизну, об’єм і площу 

поверхні. Вхідними матеріалами слугують 

цифрові знімки яєць птахів або земноводних. 

Математичний апарат плагіна містить формули, 

котрі описують форму яйця на основі кількох 

опорних точок, які встановлюються у ручному 

режимі. Оскільки передбачене автоматизоване 

обведення контурів яйця, можна швидко й 

зручно опрацьовувати великі вибірки. Плагін 

зручний для популяційних досліджень 

внутрішньовидової мінливості геометрії яйця. 

Автор також відмічає корисність розроблених інструментів при прогнозуванні обсягів 

виведення пташенят та інших досліджень у птахівництві. 

https://www.jolyon.co.uk/myresearch/image-analysis/egg-shape-modelling/ 

FijiWings – це вузькоспеціалізований плагін для напівавтоматичного аналізу 

особливостей жилкування крил комах і визначення кількості та щільності трихом на їх 

поверхні. Інструменти плагіна 

допомагають визначити площу як усього 

крила, так і його окремих сегментів. 

Кінцеві результати алгоритму підрахунку 

трихом можна подати у вигляді 

градієнтної карти щільності. Матеріали 

для такого аналізу відзнімають за 

допомогою цифрової фотонасадки на бінокулярний мікроскоп. А отримані результати 

будуть цінними, насамперед, для біотестування за допомогою плодової мушки 

Drosophila melanogaster. https://sourceforge.net/projects/fijiwings/ 

FracLac – плагін, який пропонує широкий вибір інструментів для фрактального 

аналізу. В екології фрактальний 

аналіз застосовується для 

дослідження складних законо-

мірностей і явищ різної 

природи, таких як ріст дерев, 

формування русел річок, 

https://www.wur.nl/en/show/CultivarJ-An-ImageJ-plugin-for-plant-variety-testing.htm
https://www.jolyon.co.uk/myresearch/image-analysis/egg-shape-modelling/
https://sourceforge.net/projects/fijiwings/
https://www.researchgate.net/publication/320427943/figure/fig2/AS:550386696192000@1508233822741/FracLac-for-ImageJ-to-quantify-cell-complexity-and-shape-a-Illustration-of-FracLac-box_W640.jpg
https://www.jolyon.co.uk/wp-content/uploads/2015/03/EggVsEllipse-840x1024.png
https://www.wur.nl/upload_mm/9/5/4/72b01e45-9638-428a-b500-8567923e62d2_CultivarJ_bcda0933_670x342.jpg
https://imagej.net/media/plugins/fijiwings.png
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прогресування лісових пожеж, коливання температури, динаміка чисельності особин у 

популяції тощо. Фактично будь-який об’єкт, який має структуру з численних 

самоподібних фрагментів можна досліджувати із застосуванням фрактальних методів. 

Навіть ті об’єкти, явища і процеси, які, на перший погляд, не мають вигляду фракталів, 

можуть успішно вивчатися засобами фрактального аналізу. Наприклад, на основі 

даних ДЗЗ із використанням фрактальних методів здійснюється ідентифікація 

природних об’єктів та аналіз їхнього екологічного стану. Плагін сканує зображення у 

межах заданого ROI, визначаючи фрактальну розмірність зображення або його 

фрагментів методом бокс-алгоритму. 

https://imagej.nih.gov/ij/plugins/fraclac/FLHelp/StartUpScreen.htm 

HyphaTracker – плагін автоматизованого 

відстежування розростання гіф мікроскопічних 

цвілевих грибів. Допомагає обробляти часові серії 

цифрових зображень, отриманих із мікроскопа. З 

часових рядів зображень вилучаютьтся регіони 

інтересів (ROI), які аналізуються за показниками 

розмірів, площі та темпів росту. Інструментарій 

плагіна містить п’ять процедур, призначених для 

послідовного використання від фіксації моменту 

конідіального проростання. Кожна гіфа ідентифікується автоматично, з урахуванням її 

походження, що уможливлює подальшу класифікацію. 

https://www.quantitative-plant.org/software/hyphatracker 

LarvaeArea – плагін для аналізу стану бджолиного розплоду. Автори також 

пропонують застосовувати розроблений алгоритм до дослідження інших параметрів 

вулика, зокрема запечатані медові 

стільники і запаси пилку, які можна 

використати для оцінки виробництва 

розплоду, аналізу статусу, вікової 

структури колонії та раціону. Матеріалами 

дослідження при використанні плагіна 

слугують високоякісні знімки стільників, 

зроблені на цифрову фотокамеру. 

http://lbm.ab.a.u-tokyo.ac.jp/~iwata/software/larvae/ 

Leaf Infection Tools – набір інструментів для дослідження ступеня ураження 

листової пластинки рослин. Фактично це не плагін, а окрема панель інструментів, яка 

інтегрується в оболонку ImageJ. 

Застосовується для багатоканальних 

зображень, використовуючи зелений і 

червоний канали. Таблиця результатів, 

отримана після виконання налаштувань, 

містить результати вимірювання площі та 

периметра листка, зеленого сигналу, 

червоного сигналу та перекриття зеленого й 

червоного сигналів, а також коефіцієнт 

Пірсона як міру кореляції між зеленим і червоним сигналами. Плагін розроблявся для 

аналізу вірусного ураження листя, однак придатний для дослідження інших видів 

ушкоджень рослин. https://biii.eu/leaf-infection-tools 

https://imagej.nih.gov/ij/plugins/fraclac/FLHelp/StartUpScreen.htm
https://www.quantitative-plant.org/software/hyphatracker
http://lbm.ab.a.u-tokyo.ac.jp/~iwata/software/larvae/
https://biii.eu/leaf-infection-tools
https://dev.mri.cnrs.fr/attachments/download/406/control-image.png
https://www.tandfonline.com/doi/abs/10.3896/IBRA.1.50.2.10?journalCode=tjar20
https://biii.eu/sites/default/files/styles/large/public/2018-02/Capture.PNG?itok=x97XrEan
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MosaicTool – плагін, розроблений для використання у 

рослинництві з метою оцінки стану посівів. Як вхідний матеріал 

застосовуються багатоспектральні цифрові знімки, зроблені за 

допомогою БПЛА. Фенотипування сільськогосподарських культур 

за даними спектрального відбиття дають змогу робити 

опосередковані висновки про фізіологічні параметри масивів 

монокультур, зокрема життєздатність, реакцію на температурний 

режим, фотосинтетичну активність і ефективність, формування 

стресових пігментів тощо. Має широкі перспективи використання не 

лише у сільському господарстві, але й у галузі екофізіології. 

https://gitlab.com/sckefauver/MosaicTool 

PAT-GEOM – плагін, розроблений для аналізу візерунків на тілі тварин. Містить 

інструменти для визначення семи параметрів: форми, розміру, орієнтації, контрасту, 

розподілу, спрямованості розподілу та рандомності. Окрім інструментів вимірювання, 

містить математичний апарат для статистичних обчислень та візуалізації результатів. 

Автори пропонують використо-

вувати розробку не лише для 

досліджень популяційного полі-

морфізму, але й для потреб 

ландшафтної екології (наприклад, 

кількісне визначення неоднорід-

ності наземного покриву), ботаніки 

(зокрема, для аналізу форми 

листових пластинок) і цитології 

(наприклад, вимірювання розмірів 

оклюзійного тіла у хворих 

клітинах). http://ianzwchan.com/my-

research/pat-geom/ 

WormSizer – спеціалізований плагін для дослідження морфології червів. 

Автоматизовано визначає розміри та об’єм тіла. Матеріалами дослідження можуть 

слугувати знімки, зроблені за допомогою 

цифрової фотокамери або отримані з бінокуляра 

чи мікроскопа. Важлива вимога – очищення 

червів від часточок ґрунту та інших частинок, які 

можуть спотворити результати вимірювань. 

Алгоритм плагіна перетворює дані, отримані з 

двовимірного зображення, на формат 

тривимірної поверхні. У екологічних 

дослідженнях може використовуватися при аналізі зональної організації ґрунтових 

еконіш, біоіндикації стану ґрунтового покриву, вивченні видового складу регіональної 

ґрунтової мезофауни. https://github.com/bradtmoore/wormsizer 

Перш ніж обрати певний плагін з цього переліку (або будь-який інший), 

переконайтеся, чи сумісна його версія з вашою версією ImageJ. Ознайомтеся з 

супровідною інформацією, щоби впевнитися, що ви маєте змогу отримати зображення 

у необхідній якості з необхідного пристрою. Особливо уважно дотримуйтеся вимог до 

багатоканальних зображень. Потренуйтеся на зображеннях, знайдених у вільному 

https://gitlab.com/sckefauver/MosaicTool
http://ianzwchan.com/my-research/pat-geom/
http://ianzwchan.com/my-research/pat-geom/
https://github.com/bradtmoore/wormsizer
http://ianzwchan.com/wp-content/uploads/2016/12/SevenPropertiesMeasured-768x712.png
https://gitlab.com/sckefauver/MosaicTool
https://www.researchgate.net/profile/James-Jordan-12/publication/235757902/figure/fig1/AS:299749249961985@1448477198387/WormSizer-an-open-source-application-for-detecting-nematode-size-and-shape-A-The_W640.jpg
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доступі. І лише коли матимете певний досвід роботи з плагіном і уявлення про вимоги 

до зображень, розпочинайте планувати власний експеримент. 

Етап оформлення результатів експерименту 

Інструменти ImageJ використовуються не лише у процесі виконання 

експерименту, але й для оформлення результатів наукових робіт. Фотографії, а також 

скріншоти етапів обробки цифрових знімків – інформативні ілюстрації для звіту, 

наукової статті, стендової доповіді або презентації до виступу на конференції. При 

висвітленні результатів складного експерименту фотознімки можуть полегшити 

сприйняття інформації, зробивши її доступною для ширшої аудиторії. Створення 

зрозумілих і водночас візуально привабливих ілюстрацій сприяє популяризації 

наукових результатів. На відміну від етапу аналізу даних, на цьому етапі допускається 

поліпшення візуальної складової для кращого сприйняття людським оком. Водночас 

зберігається заборона на маніпуляції, які можуть вплинути на інтерпретацію 

результатів дослідження. 

Протягом курсу ви засвоїли багато корисних навичок роботи зі зображеннями. 

Зокрема, навчилися редагувати яскравість і контрастність, масштабувати, анотувати, 

додавати структурні елементи, генерувати виділення простих і складних конфігурацій. 

Якщо бажаєте розширити свій інструментарій, зверніть увагу на спеціальні плагіни, 

розроблені для належного оформлення наукових ілюстрацій. 

FigureJ – плагін, розроблений з метою швидкого і зручного генерування рисунків 

для наукових статей із наборів цифрових зображень. Підтримує більшість сучасних 

форматів наукових даних, які застосовуються для роботи у ImageJ. Вбудований макет 

має стриманий науковий стиль, але водночас доволі гнучкий для користувацького 

налаштування. Інструменти плагіна надають можливість геометричної трансформації 

зображення, його масштабування та обертання, анотування, додавання стандартних 

елементів: масштабних шкал і сіток, прев’ю, градацій.  

Алгоритм процесу автори демонструють у вигляді логічної схеми: 

 

 
Результат трансформації можна зберегти у вигляді файлу проєкту, доступному для 

подальшого редагування. Оскільки він звертається безпосередньо до цифрових даних 

конкретних зображень, їх можливі зміни автоматично відображатимуться в 

оновленому колажі. За бажанням до колажу можна додавати графіки, діаграми, таблиці 

https://imagej.net/media/plugins/figurej-poster.png
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даних або інші засоби візуалізації, створені за допомогою стороннього програмного 

забезпечення, наприклад R. Готова ілюстрація експортується у стандартні формати 

зображень із текстовим описом історії кожної панелі колажу. 

https://imagejdocu.list.lu/plugin/utilities/figurej/start 

QuickFigures – ще один плагін, який містить набір інструментів для створення і 

редагування академічних ілюстрацій. На відміну від попереднього, його зручно 

використовувати при роботі зі стеками і серіями цифрових знімків. Компонування їх у 

вигляді колажів використовується при демонстрації інших мікроскопічних зображень, 

електронних мікрофотографій, космознімків, знімків, отриманих з БПЛА тощо. 

Складання та редагування таких колажів із дотриманням рівномірного інтервалу, 

узгодження шрифту і розташування тексту, налаштування точних шкал може бути 

доволі виснажливою роботою, яка до того ж займає багато часу. Плагін QuickFigures 

забезпечує автоматизацію пакетного застосування однотипових дій для великого 

обсягу ілюстративного матеріалу. 

QuickFigures містить безліч об’єктів, вікон, меню та компонентів. Кожен елемент 

у QuickFigures є редагованим об’єктом, який можна активізувати, переміщувати, 

масштабувати, обертати, приховувати, видаляти, вирівнювати, редагувати або 

дублювати. Усе різноманіття ключових процесів, доступних користувачеві, умовно 

можна звести до п’яти груп операцій: 1) відстеження просторового масштабу та 

одиниць зображення; 2) складання каналів у об’єднане зображення і, навпаки, 

розкладання багатоканальних зображень; 3) масштабування й обертання; 4) 

відстеження колірних каналів, встановлення їхнього порядку і супроводження 

відповідними метаданими (назви каналів/час експозиції тощо); 5) 

серіалізація/збереження багатоканальних зображень ImageJ. 

Аналогічно до FigureJ плагін підтримує функції імпорту файлів у різних 

біоформатах і експорту готового колажу у найрозповсюдженіших форматах. Засіб 

імпорту автоматично зчитує важливі метадані щодо просторового масштабу 

(необхідного для встановлення шкал) та інформації про канали (назви/кольори). 

https://github.com/grishkam/QuickFigures 

Зображення нижче за авторством Gregory Mazo (2021) демонструє колажі, 

згенеровані за допомогою двох розглянутих плагінів: 

 
При оформленні результатів експерименту уникайте надлишковості в 

ілюструванні. Якщо в цьому немає реальної потреби, не дублюйте кадри, зроблені з 

різних ракурсів і з різної відстані. Кожному етапу проведеного дослідження приділяйте 

достатньо уваги. Помилково ілюструвати лише безпосередньо етап аналізу зображень 

засобами ImageJ, залишивши поза увагою етапи збору і підготовки матеріалів. 

Водночас пам’ятайте, що головний критерій оцінювання – не обсяг матеріалу, а 

інформативність, відповідність обраних методів поставленим завданням, акуратність 

виконання експерименту, логічність зроблених висновків. 

  

https://imagejdocu.list.lu/plugin/utilities/figurej/start
https://github.com/grishkam/QuickFigures
https://journals.plos.org/plosone/article/figure/image?size=large&id=10.1371/journal.pone.0240280.g005
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Інформаційні ресурси 

1. Курс на платформі дистанційного навчання (тільки для судентів ЧНУ): 

https://moodle.chnu.edu.ua/course/view.php?id=2521 

2. Браузерна версія програми ImageJ: https://ij.imjoy.io/ 

Ресурси для користувачів ImageJ 

3. Бібліотека плагінів до програмного пакета ImageJ: 

https://imagej.nih.gov/ij/plugins/index.html 

4. ImageJ User Guide: http://imagej.nih.gov/ij/docs/guide 

5. ImageJ Wiki: https://imagej.net/ 

6. Learn ImageJ: https://sites.google.com/site/learnimagej/ 

7. Путівник мовою програмування ImageJ Macro: 

https://imagej.nih.gov/ij/docs/macro_reference_guide.pdf 

8. Онлайн-посібник Альберта Кардони з написання скриптів для FIJI:  https://syn.mrc-

lmb.cam.ac.uk/acardona/fiji-tutorial/ 

9. Курс лекцій з біоіміджингу Роберта Хааса: https://git.mpi-

cbg.de/rhaase/lecture_applied_bioimage_analysis_2020 

10. Відеозаписи лекцій Роберта Хааса: 

https://www.youtube.com/playlist?list=PL5ESQNfM5lc7SAMstEu082ivW4BDMvd0U 

11. Відеоблог фахівця з обробки і оцінки зображень Крейга Дейлі: 

https://www.youtube.com/@CraigDaly 

12. Покрокові інструкції для роботи з ImageJ: https://imagejdocu.list.lu/howto/start 

13. Форум користувачів ImageJ: https://forum.image.sc/ 

14. Creed S. FIJI Basics Workshop Notes: https://monashmicroimaging.github.io/gitbook-fiji-basics/ 

15. Короткий відеоекскурс для початківців ImageJ 101 For Every PhD with Image Data!: 

https://www.youtube.com/watch?v=wmAF9yFphhk 

16. Відеогід користувача ImageJ від початківця до професійного користувача ImageJ: 

https://www.youtube.com/playlist?list=PLkGKyuSIzfzobHBGYnwVCtWPFX9QxZ57f 

17. Відеокурс для початківців: 

https://www.youtube.com/watch?v=LlbM7msEbkk&list=PL14z9KdnuaMQOgro1iZ7k5e7twJL

wQrTf 

18. Огляд можливостей інструментів ImageJ в гідробіологічних дослідженнях: 

https://www.youtube.com/watch?v=FpzYCPknfJg 

https://moodle.chnu.edu.ua/course/view.php?id=2521
https://ij.imjoy.io/
https://imagej.nih.gov/ij/plugins/index.html
http://imagej.nih.gov/ij/docs/guide
https://imagej.net/
https://sites.google.com/site/learnimagej/
https://imagej.nih.gov/ij/docs/macro_reference_guide.pdf
https://syn.mrc-lmb.cam.ac.uk/acardona/fiji-tutorial/
https://syn.mrc-lmb.cam.ac.uk/acardona/fiji-tutorial/
https://git.mpi-cbg.de/rhaase/lecture_applied_bioimage_analysis_2020
https://git.mpi-cbg.de/rhaase/lecture_applied_bioimage_analysis_2020
https://www.youtube.com/playlist?list=PL5ESQNfM5lc7SAMstEu082ivW4BDMvd0U
https://www.youtube.com/@CraigDaly
https://imagejdocu.list.lu/howto/start
https://forum.image.sc/
https://monashmicroimaging.github.io/gitbook-fiji-basics/
https://www.youtube.com/watch?v=wmAF9yFphhk
https://www.youtube.com/playlist?list=PLkGKyuSIzfzobHBGYnwVCtWPFX9QxZ57f
https://www.youtube.com/watch?v=LlbM7msEbkk&list=PL14z9KdnuaMQOgro1iZ7k5e7twJLwQrTf
https://www.youtube.com/watch?v=LlbM7msEbkk&list=PL14z9KdnuaMQOgro1iZ7k5e7twJLwQrTf
https://www.youtube.com/watch?v=FpzYCPknfJg
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Ресурси для пошуку наукових текстів 

19. Спеціалізований пошуковик наукових праць Гугл Академія: https://scholar.google.com.ua/

20. Науковий пошуковий сервіс Mendeley: https://www.mendeley.com/search/

21. Науковий пошуковий сервіс Semantic Scholar: https://www.semanticscholar.org/

22. Український Національний репозиторій академічних текстів НРАТ:

https://nrat.ukrintei.ua/ua/

23. ARCher – інституційний репозиторій відкритого доступу представників

Чернівецького національного університету імені Юрія Федьковича:

https://archer.chnu.edu.ua/

24. Репозиторій академічних текстів BASE (Bielefeld Academic Search Engine):

https://www.base-search.net/

25. Платформа ResearchGate для спілкування дослідників і обміну науковими працями:

https://www.researchgate.net/

26. Електронна база даних медичних і біологічних публікацій PubMed:

https://pubmed.ncbi.nlm.nih.gov/

Бази даних і картографічних матеріалів 

27. Карти NASA Earth Observations (NEO): https://neo.gsfc.nasa.gov/

28. Карти наземного покриву Європейського космічного агентства ESA WorldCover:

https://esa-worldcover.org/en

29. Топографічні дані Open Topography: https://opentopography.org/

30. Карти Natural Earth: https://www.naturalearthdata.com/

31. База цифрових фотознімків високої роздільної здатності: https://www.flickr.com/

32. База цитологічних зображень CRIC Searchable Image Database:

http://database.cric.com.br/

33. База мікроскопічних зображень рослинного пилку POLLENATLAS:

https://www.pollenwarndienst.at/

34. Репозиторій наборів наукових зображень The Image Data Resource (IDR):

https://idr.openmicroscopy.org/

35. База наукових зображень з різних галузей CSIRO Science Image

https://www.scienceimage.csiro.au/

36. База зображень Wikimedia Commons: https://commons.wikimedia.org/wiki/Main_Page

https://scholar.google.com.ua/
https://www.mendeley.com/search/
https://www.semanticscholar.org/
https://nrat.ukrintei.ua/ua/
https://archer.chnu.edu.ua/
https://www.base-search.net/
https://www.researchgate.net/
https://pubmed.ncbi.nlm.nih.gov/
https://neo.gsfc.nasa.gov/
https://esa-worldcover.org/en
https://opentopography.org/
https://www.naturalearthdata.com/
https://www.flickr.com/
http://database.cric.com.br/
https://www.pollenwarndienst.at/
https://idr.openmicroscopy.org/
https://www.scienceimage.csiro.au/
https://commons.wikimedia.org/wiki/Main_Page
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37. Репозиторій наукових зображень бібліотеки Мічиганського університету:

https://guides.lib.umich.edu/c.php?g=282888&p=1885043

Загальні рекомендації з роботи зі цифровими зображеннями 

38. Відеокурс з основ обробки цифрових зображень:

https://www.youtube.com/watch?v=rSGMXktIsYI&list=PL2mBI0yFsKk-

p73KQ4iPdsi10hQC4Zd-0&index=1

39. Навчальний канал з біоіміджингу: https://www.youtube.com/@iBiologyTechniques

40. Основи роботи з метаданими до зображення:

https://www.youtube.com/watch?v=GBrq8gCqzv0

41. Як цитувати зображення, знайдене в Інтернеті:

https://www.youtube.com/watch?v=epwdt2h1cDU

Поради з організації і виконання наукових проєктів 

42. Поради з організації академічних наукових робіт:

https://web.archive.org/web/20210127111333/https://library.sacredheart.edu/c.php?g=2980

3&p=185902 

43. Improve your research with these free digital tools (2021):

https://www.research4life.org/blog/improve-your-research-free-digital-tools/

https://guides.lib.umich.edu/c.php?g=282888&p=1885043
https://www.youtube.com/watch?v=rSGMXktIsYI&list=PL2mBI0yFsKk-p73KQ4iPdsi10hQC4Zd-0&index=1
https://www.youtube.com/watch?v=rSGMXktIsYI&list=PL2mBI0yFsKk-p73KQ4iPdsi10hQC4Zd-0&index=1
https://www.youtube.com/@iBiologyTechniques
https://www.youtube.com/watch?v=GBrq8gCqzv0
https://www.youtube.com/watch?v=epwdt2h1cDU
https://web.archive.org/web/20210127111333/https:/library.sacredheart.edu/c.php?g=29803&p=185902
https://web.archive.org/web/20210127111333/https:/library.sacredheart.edu/c.php?g=29803&p=185902
https://www.research4life.org/blog/improve-your-research-free-digital-tools/
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